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1 About this manual 

 

Preliminary note ........................................................................................................................................ 6 
Copyright .................................................................................................................................................. 6 
What do the symbols and formats mean? ................................................................................................ 7 
How is this documentation structured? .................................................................................................... 8 
History of the manual ................................................................................................................................ 8 

202 
 

>  

1.1 Preliminary note 
21948 

The programming manual describes the software for the efector octavis diagnostic electronics.  

It includes information about the installation, the user interface, the configuration and the visualisation 
of the data. 
 

>  

1.2 Copyright 
6088 

© All rights reserved by ifm electronic gmbh. No part of this manual may be reproduced and used 
without the consent of ifm electronic gmbh. 

All product names, pictures, companies or other brands used on our pages are the property of the respective rights owners: 
 • AS-i is the property of the AS-International Association, (→ www.as-interface.net) 
 • CAN is the property of the CiA (CAN in Automation e.V.), Germany (→ www.can-cia.org) 
 • CODESYS™ is the property of the 3S – Smart Software Solutions GmbH, Germany (→ www.codesys.com) 
 • DeviceNet™ is the property of the ODVA™ (Open DeviceNet Vendor Association), USA (→ www.odva.org) 
 • EtherNet/IP® is the property of the →ODVA™  
 • EtherCAT® is a registered trade mark and patented technology, licensed by Beckhoff Automation GmbH, Germany 
 • IO-Link® (→ www.io-link.com) is the property of the →PROFIBUS Nutzerorganisation e.V., Germany  
 • ISOBUS is the property of the AEF – Agricultural Industry Electronics Foundation e.V., Deutschland  
     (→ www.aef-online.org)  
 • Microsoft® is the property of the Microsoft Corporation, USA (→ www.microsoft.com) 
 • PROFIBUS® is the property of the PROFIBUS Nutzerorganisation e.V., Germany (→ www.profibus.com) 
 • PROFINET® is the property of the →PROFIBUS Nutzerorganisation e.V., Germany  
 • Windows® is the property of the →Microsoft Corporation, USA 
 

http://www.as-interface.net/
http://www.can-cia.org/
http://www.codesys.com/
http://www.odva.org/
http://www.io-link.com/
http://www.aef-online.org/
http://www.microsoft.com/
http://www.profibus.com/
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>  

1.3 What do the symbols and formats mean? 
203 

The following symbols or pictograms illustrate the notes in our instructions: 
 

 WARNING 

Death or serious irreversible injuries may result. 
 

 CAUTION 

Slight reversible injuries may result. 
 

NOTICE 

Property damage is to be expected or may result. 
 

 

Important note 
Non-compliance can result in malfunction or interference 

 

Information 
Supplementary note 

► ... Request for action 

> ... Reaction, result 

→ ... "see" 

abc Cross-reference 

123 
0x123 
0b010 

Decimal number 
Hexadecimal number 
Binary number 

[...] Designation of pushbuttons, buttons or indications 
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>  

1.4 How is this documentation structured? 
204 

1508 

This documentation is a combination of different types of manuals. It is for beginners and also a 
reference for advanced users. This document is addressed to the programmers of the applications. 

How to use this manual:  

 Refer to the table of contents to select a specific subject. 

 Using the index you can also quickly find a term you are looking for. 

 At the beginning of a chapter we will give you a brief overview of its contents. 

 Abbreviations and technical terms → Appendix. 

In case of malfunctions or uncertainties please contact the manufacturer at: 
Contact → ifm weltweit • ifm worldwide • ifm à l’échelle internationale (→ p. 213)  

We want to become even better! Each separate section has an identification number in the top right 
corner. If you want to inform us about any inconsistencies, indicate this number with the title and the 
language of this documentation. Thank you very much for your support! 

We reserve the right to make alterations which can result in a change of contents of the 
documentation. You can find the current version on ifm's website: 
→ ifm weltweit • ifm worldwide • ifm à l’échelle internationale (→ p. 213)  

 
 

>  

1.5 History of the manual 
21947 

What has been changed in this manual? An overview: 

Date Theme Change 

2016-05-26 Release V1.10 • Sensor VNB001 added 
• Sensor VNB211 added 

2016-12-28 Release V1.20 • transfer to CMS 
• evaluation unit VES150 added 

 

>  
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2 Safety instructions 

 

Functions and features ............................................................................................................................. 9 
21950 

Please read the operating instructions of the diagnostic electronics and of the vibration sensor before 
using the software. The installation and connection of the diagnostic electronics and of the vibration 
sensor must comply with the applicable national and international standards. 

Ensure that the VES004 software is suitable for your application without any restrictions. 

If the instructions or the technical data are not adhered to, personal injury and/or damage to property 
can occur. 

Operation of the software which is not in accordance with the intended use, incomplete installation or 
incorrect handling can seriously affect the safety of operators and machinery. 

Responsibility lies with the person installing the software. 
 

>  

2.1 Functions and features 
21951 

The efector octavis software serves to configure and display data of the VSE diagnostic electronics. 
The rolling element bearings and objects to be monitored are defined using the software and then 
transferred as a parameter set to the VSE diagnostic electronics. 
 

>  
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3 Installation 

 

System requirements ..............................................................................................................................10 
Install the VES004 software ...................................................................................................................10 
Install the USB driver ..............................................................................................................................10 
Start the parameter setting software ......................................................................................................11 

21953 
 

>  

3.1 System requirements 
21955 

The PC must meet the following requirements for installation. 

 Hardware 

 Min. dual-core processor or higher, min. 2 GHz clock frequency 

 Min. 2 GB RAM 

 Min. 5 GB freely available hard disc memory 

 Ethernet network card for 10Base-T/100Base-TX, TCP/IP protocol 

 Software 

 Operating system Microsoft Windows XP SP3, Vista SP2, Windows 7 SP1 or Windows 8 

 Windows Server 2008 SP2, Windows Server 2008 R2 SP1, Windows Server 2012 

The latest version of the software can be downloaded from 
→ www.ifm.com > [Download] > [Service] 
 

>  

3.2 Install the VES004 software 
21957 

To install the VES004 software: 
  

   To install the VES004 software no administrator rights are necessary. 
  

► Unpack the downloaded ZIP file on a local data carrier 
 

>  

3.3 Install the USB driver 
21959 

 For the connection of type VNB sensors to the parameter setting software a USB adapter cable 
(e.g. E30136) is necessary.  

 For VNB sensors on the USB interface of the PC an own driver is necessary. 
  

  To install the USB driver administrator rights are necessary. 

  

The USB driver is part of the VES004 software package: 
directory = Driver\VNBxxx\ifm\ 

> After connecting the sensor to a USB port of the PC the Windows driver installation starts. 

► Indicate the above-mentioned directory to the installation program. 

> The driver is installed. 
 

http://www.ifm.com/
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>  

3.4 Start the parameter setting software 
21963 

The software VES004 is directly runable in the unpackted installation folder. 
To start the VES004 software: 

1. Open the installation folder 

2. Double-click on "VES004.exe" 
 

>  
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4 User interface 

 

Menu bar.................................................................................................................................................12 
Tool bar...................................................................................................................................................13 
Tree view ................................................................................................................................................13 
Detailed view ..........................................................................................................................................15 
Context menu .........................................................................................................................................16 

21965 

The chapter "User interface" describes the graphical user interface of the software. 
The user interface is divided into several areas: 

 

Legend: 
(1) Menu bar;   → chapter Menu bar (→ p. 12) 
(2) Tool bar;   → chapter Tool bar (→ p. 13) 
(3) Tree view;   → chapter Tree view (→ p. 13) 
(4) Detailed view;   → chapter Detailed view (→ p. 15) 
  

Additionally, a context menu can be used within the user interface. The context menu simplifies the 
use of the software.  
→ chapter Context menu (→ p. 16) 
→ chapter Context menu functions (→ p. 195) 
 

>  

4.1 Menu bar 
21968 

The menu bar contains the most important functions of the software grouped together in menus. 
Functions that are not available for a selected object are greyed out. 
Example: 

 

The menus are described in the following chapters, starting with the [Project] menu  
→ chapter [Project] menu (→ p. 24) 
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User interface Tool bar 

>  

4.2 Tool bar 
21972 

The tool bar contains frequently used functions as symbols.  
In the following cases the symbols are shown greyed: 
 • if they are not available for the selected element 
 • if they are not available in the current situation. 

Example: 

 
 

>  

4.3 Tree view 
21976 

The tree view contains the devices, parameters, settings, etc. belonging to a project (→ screenshot 
below). The elements are displayed in groups. You can select an element and open it in the detailed 
view by double clicking on it (→ chapter Detailed view (→ p. 15)). 

 

The top line of the tree view shows the name of the project (→ [Projekt 1] in the above screenshot). 

In the screenshot above, the devices used were designated with their article number plus a 
consecutive number (assigned by the program), e.g. [VNB001_04]. The grouped display shows at a 
glance which settings and parameters belong to which device. 

The [Parameters] can be used multiple times: Several devices can use one parameter set. The 
parameters are listed repeatedly in the lower section of the tree view. 
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User interface Tree view 

 

  There are several methods to select the elements in the tree view: 

 Selection in the tree view 

 Context menu 
→ chapter Context menu (→ p. 16) 
→ chapter Context menu functions (→ p. 195) 

 [Object] menu 
→ chapter [Object] menu (→ p. 45) 

  

Devices, data, groups and data groups can be moved in the project tree via  "drag & drop" . 
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>  

4.4 Detailed view 
21980 

The detailed view occupies the largest part of the user interface. The detailed view shows the settings 
and information of the selected element. The settings can be edited in the detailed view.  

22123 

  The settings and parameters changed in the parameter setting software must be written to the 
device before use. 

► Write settings and parameters to the device via [Device] menu > [Write to Device] (→ p. 33). 
 

  

 

As soon as an element is selected in the tree view (i.e. marked by a mouse click), its detailed view will 
be displayed (in the above screenshot: for the element [Address]). 

The user interface can display several detailed views at the same time. All detailed views are 
accessible via separate tabs. The tabs are displayed above the detailed view ([Motor A] in the above 
example). 

► To close a tab in the detailed view: 
 • Click on the "x" (at the right edge of the tab)  
Or 
 • [STRG]+[F4] 

► To open a further tab in the detailed view: 
In the tree view: 
 • Double-click on the required settings  
Or 
 • Right-click on the required settings > [Open] 
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User interface Context menu 

>  

4.5 Context menu 
21984 

Most elements have a context menu ① from which functions can be selected. 

 

The context menu offers functions that are related to the selected element. For example, a new 
parameter can be created via the context menu of a parameter (1) . 

To open the context menu, click onto the respective element with the 2nd (right) mouse button. 
→ chapter Context menu functions (→ p. 195) 
 

>  
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5 Connection (diagnostic electronics) 

 

Network setting IP address range ..........................................................................................................17 
Factory setting parameters .....................................................................................................................17 
Verify and set the IP address of the PC .................................................................................................18 
Connect to the device .............................................................................................................................19 

21988 

The chapter [Connection] describes how to create a connection between VES004 and a diagnostic 
electronics via Ethernet. 
 

>  

5.1 Network setting IP address range 
21990 

The IP address range of device and PC must match according to the subnet mask. 

Network station Address Address, network address Address, station address 

Subnet mask 255.255.255.0 255.255.255. 0 

Consequence for IP address    must be equal must be different 

VSE diagnostic electronics e. g. 192.168.0.1 192.168.0 e. g. 1 

PC e. g. 192.168.0.10 192.168.0 e. g. 10 
 

>  

5.2 Factory setting parameters 
21992 

VSE diagnostic electronics - Parameters Factory setting 

Dynamic Host Configuration Protocol (DHCP) off 

IP-address / Port 192.168.0.1 : 3321 

Subnet-mask 255.255.255.0 
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>  

5.3 Verify and set the IP address of the PC 
21994 

  

  
Changes in the network settings of the PC require extended user rights. 
In case of need, contact your system administrator. 

  

► Activate the Windows menu [Internet Protocol Properties Version 4 (TCP/IPv4]: 
e.g. via [Start] > [System panel] > [Network and Sharing Center] > [Change adapter settings] > 
[Local Area Connection] > (right-click) > [Properties] 
(→ figure to the left) 

► Button [Properties] 

► Select the menu item [Use the following IP address] 

► Verify and set the IP address, if necessary (here e.g. 192.168.0.10) 

► Enter the subnet mask (255.255.255.0) 

► Leave default gateway blank 
(→ figure to the right) 

► Confirm the settings with [OK] 
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Connection (diagnostic electronics) Connect to the device 

>  

5.4 Connect to the device 

 

Create a new project ..............................................................................................................................19 
Open an existing project .........................................................................................................................19 
Create a new device (VSE) ....................................................................................................................20 

21998 

Start the VES004 software on the PC 

To establish a connection with a diagnostic unit you must first create a new project or open an existing 
one (→ below). On delivery no project is set up. 
 

>  

5.4.1 Create a new project 
22000 

► Choose either: 
[Project] menu > [New...]  
Or: 

Left-click on the symbol [ ] (create new project) 
Or: 
[Strg]+[N] 

► Enter a name for the project 

► Confirm with [OK] 

> The new project is created and opened. 

Alternatively: 
 

>  

5.4.2 Open an existing project 
22003 

► Choose either: 
[Project] menu > [Open...]  
Or: 

Left-click on the symbol [ ] (open project) 
Or: 
[Strg]+[O] 

► Select the desired project from the list 

► Confirm with [OK] 

> The selected project is opened 
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Connection (diagnostic electronics) Connect to the device 

>  

5.4.3 Create a new device (VSE) 
22006 

In the open project: 

► Choose either: 
[Device] menu > [New] > [Vibration Monitor]  
Or: 
In the tree view: right-click in the empty field 
Select [New] > [Vibration Monitor]  

► Select the VSE diagnostic electronics that is used 

> The selected device appears in the tree view as [VSEnnn_#] 

► After clicking on [Settings] below [VSEnnn_#]: 

> The tab [VSEnnn_#] opens in the detailed view 

> Under the headline [Address] the tab [Configuration] appears with the connection details of the 
device: 

 

► Enter the connection details of the diagnostic electronics in the section [TCP/IP Address]. Factory 
setting: 
IP address: 192.168.0.1 
Port: 3321 

► Choose either: 
[Device] menu > [Connect] 
Or: 
In the tree view, right-click on [VSEnnn_#] > left-click on [Connect] 
Or: 

Left-click on the symbol [ ] (connect the device) 

> The software is connected to the diagnostic electronics 

  

The element [Address] contains the following switching functions: 

Symbol Description Menu sequence (alternatively) 

 
scan the network for connected devices [Device] > [Scan Network] 

 connect the PC to the diagnostic electronics [Device] > [Connect] 

 disconnect the PC from the diagnostic electronics [Device] > [Disconnect] 
 

>  
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6 Connection (vibration monitor) 

 

Install the USB driver ..............................................................................................................................21 
Connect to the device .............................................................................................................................22 

22012 

The chapter [Connection] describes how to create a connection between VES004 and a VNB vibration 
monitor via USB. 
 

>  

6.1 Install the USB driver 
22014 
21959 

 For the connection of type VNB sensors to the parameter setting software a USB adapter cable 
(e.g. E30136) is necessary.  

 For VNB sensors on the USB interface of the PC an own driver is necessary. 
  

  To install the USB driver administrator rights are necessary. 

  

The USB driver is part of the VES004 software package: 
directory = Driver\VNBxxx\ifm\ 

> After connecting the sensor to a USB port of the PC the Windows driver installation starts. 

► Indicate the above-mentioned directory to the installation program. 

> The driver is installed. 
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>  

6.2 Connect to the device 

 

Create a new project ..............................................................................................................................22 
Open an existing project .........................................................................................................................22 
Create a new device (VNB) ....................................................................................................................22 

22019 

► Start the VES004 software on the PC 

To establish a connection with a sensor you must first create a new project or open an existing one (→ 
below). On delivery no project is set up. 
 

>  

6.2.1 Create a new project 
22021 

► Choose either: 
[Project] menu > [New...]  
Or: 

Left-click on the symbol [ ] (create new project) 
Or: 
[CTRL]+[N] 

► Enter a name for the project 

► Confirm with [OK] 

> The new project is created and opened. 

Alternatively: 
 

>  

6.2.2 Open an existing project 
22023 

► Choose either: 
[Project] menu > [Open...]  
Or: 

Left-click on the symbol [ ] (open project) 
Or: 
[Strg]+[O] 

► Select the desired project from the list 

► Confirm with [OK] 

> The selected project is opened  
 

>  

6.2.3 Create a new device (VNB) 
22031 

In the open project: 

► Choose either: 
[Device] menu > [New] > [Vibration Monitor]  
Or: 
In the tree view: right-click in the empty field 
Select [New] > [Vibration Monitor]  

► Select the VNB vibration monitor used 

> The selected device appears in the tree view as [VNBnnn_#] 

► After clicking on [Settings] below [VNBnnn_#]: 

> The tab [VNBnnn_#] opens in the detailed view 
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> Under the headline [Address] the tab [Configuration] appears with the connection details of the 
device: 

 

> In the section [Connection] the serial number of the device last detected appears. 

In case of a newly created vibration monitor this field is still empty.  
In this case: 

► Left-click on the symbol [ ](scan the USB ports for connected devices) to search and identify the 
vibration monitor. 

► Choose either: 
In the window [Found Devices], add the desired device to the project with a double-click. 
Or: 
In the window [Found Devices], select the desired device with a left-click. 

Add the selected device to the project with a left-click on the symbol [ ] (update the project with 
the selected device). 

> The read serial number of the device appears in the field [Serial number]. 

  

► Choose either: 
[Device] menu > [Connect] 
Or: 
In the tree view, right-click on [Device] > Left-click on [Connect] 
Or: 

Left-click on the symbol [ ] (connect the device) 

> The software is connected to the vibration monitor 

> The field [Serial number] can no longer be changed and is greyed out. 
  

The element [Address] contains the following switching functions: 

Symbol Description Menu sequence (alternatively) 

 
scan the USB ports for connected devices [Device] > [Scan Network] 

 connect the PC to the vibration sensor [Device] > [Connect] 

 disconnect the PC from the vibration monitor [Device] > [Disconnect] 
 

>  
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7 Menus 

 

[Project] menu ........................................................................................................................................24 
[Device] menu .........................................................................................................................................30 
[Parameter] menu ...................................................................................................................................43 
[Object] menu .........................................................................................................................................45 
[View] menu ............................................................................................................................................48 
[Window] menu .......................................................................................................................................52 
[Help] menu ............................................................................................................................................54 

22036 

This chapter describes the menus. The menus can be reached via the menu bar (→ p. 12).  

  

  The menu items within the menus are context sensitive. Some menu items may be deactivated 
and greyed out depending on the selected element. 

 
>  

7.1 [Project] menu 

 

[Project] menu > [New...] ........................................................................................................................25 
[Project] menu > [Open...] ......................................................................................................................26 
[Project] menu > [Recent Projects] .........................................................................................................26 
[Project] menu > [Close] .........................................................................................................................27 
[Project] menu > [Save] ..........................................................................................................................27 
[Project] menu > [Save as...] ..................................................................................................................27 
[Project] menu > [Delete] ........................................................................................................................28 
[Project] menu > [Stop monitoring] .........................................................................................................28 
[Project] menu > [Start monitoring] .........................................................................................................29 
[Project] menu > [Save...] .......................................................................................................................29 
[Project] menu > [Restore...] ...................................................................................................................29 
[Project] menu > [Quit] ............................................................................................................................29 

22038 

This chapter describes the functions contained in 
the [Project] menu. 

A project contains all connected devices, 
corresponding parameters and settings. 

The [Project] menu can be reached via the menu 
bar (→ p. 12).  

 

  

  Only one project can be open at a time. Save the opened project before creating a new project or 
opening another project. 
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>  

7.1.1 [Project] menu > [New...] 
22040 

Create a new project or 
Overwrite an existing project. 

► Choose either: 
[Project] menu > [New...]  
Or: 

Left-click on the symbol [ ] (create new project) 
Or: 
[CTRL]+[N] 

 

(a) Create a new project: 

► Enter a new project name 
Confirm with [OK] 

> The new empty project is created and opened 

   

(b) Overwrite an existing project: 

► Select a project name from the list 

► Acknowledge the confirmation prompt with [OK] 

> A new empty project is created and opened under the selected name 
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>  

7.1.2 [Project] menu > [Open...] 
22042 

Open a previously created project. 

 

Open a project: 

► Either: 
[Project] menu > [Open...]   
or: 

Left-click on the symbol [ ] (open project) 
or: 
[CTRL]+[O] 

► Select a project name from the list 

► Confirm with [Ok] 

> The selected project is opened 
23570 

 

The program automatically stores the projects as well as the corresponding parameters and 
data in the following directory: 
C:\Users\Public\Documents\VES004  

 
>  

7.1.3 [Project] menu > [Recent Projects] 
22045 

Lists the recently opened projects in reverse chronological order 

Open a recent project: 

► [Project] menu > [Recent Projects] > [Project name]  

► Confirm with [OK] 

> The selected project is opened 
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>  

7.1.4 [Project] menu > [Close] 
22047 

Close the opened project.  

(a) To close the project and save the changes: 

► [Project] menu > [Close]  

> In case of unsaved project changes a confirmation prompt appears. 

► Click [Yes]. 

  

(b) To close the project without saving the changes: 

► [Project] menu > [Close] 

> In case of unsaved project changes a confirmation prompt appears. 

► Click [No]. 
 

>  

7.1.5 [Project] menu > [Save] 
22048 

Save the opened project. 

► Either: 
[Project] menu > [Save] 
or: 

Left-click on the symbol [ ] (save project)  
or: 
[CTRL]+[S] 

> The project is saved under the current name. 
23570 

 

The program automatically stores the projects as well as the corresponding parameters and 
data in the following directory: 
C:\Users\Public\Documents\VES004  

 
>  

7.1.6 [Project] menu > [Save as...] 
22050 

Save the opened project under a new name. 
The memory location can not be changed. 

► [Project] menu > [Save as...]  

► Enter a new project name 

► Confirm with [OK] 

> The project is saved under the new name. 

> The project with the old name is kept with the setting last saved. 
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>  

7.1.7 [Project] menu > [Delete] 
22051 

Delete the opened project 

  

  The function [ ] "Delete project" also deletes all parameter sets, data and documents contained 
in the project. 

  

► [Project] menu > [Delete]  

   

(a) To delete the opened project: 

► Acknowledge the confirmation prompt with [Yes] 

> The current project and all related parameters, data and documents will be deleted 

   

(b) To not delete the opened project: 

► Answer the confirmation prompt with [No] 

> The current project and all corresponding parameters, data and documents will not be deleted. 
 

>  

7.1.8 [Project] menu > [Stop monitoring] 
22886 

Preset: Process data should be displayed in the program. 
Requirement: 

 VES software is connected to the device via [ ] 

 Configuration was transferred to the device via [ ] 

Data is received 

Stops the current monitoring measurement; new measurement values are no longer displayed. 
→ chapter Monitoring (→ p. 178)  

Requirement: 

 Monitoring in progress 

► Choose either: 
Select menu [Project] > [Stop monitoring] 
or: 

Left-click on the symbol [ ] (Stop project data monitoring) 
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>  

7.1.9 [Project] menu > [Start monitoring] 
22865 

Requirement: 

 VES software is connected to the device via [ ] 

 Configuration was transferred to the device via [ ] 

 Data is received 

Restarts the current monitoring. The new measurement values are displayed in the selected graph 
again. 
→ chapter Monitoring (→ p. 178)  

Requirement: 

 Monitoring stopped 

► Choose either: 
Select menu [Project] > [Start monitoring] 
or: 

Left-click on the symbol [ ] (Start project data monitoring) 
 

>  

7.1.10 [Project] menu > [Save...] 
22054 

Create a backup copy of the opened project. Name and memory location are freely selectable. 

► [Project] menu > [Save...]  

► Define the name of the backup and the memory location in the dialogue window 

► Acknowledge with [Save]. 
 

>  

7.1.11 [Project] menu > [Restore...] 
22055 

Restore the backup copy of a project 

► [Project] menu > [Restore...]  

► Select the name of the backup and the memory location in the dialogue window 

► Confirm with [Open] 

► Select a project name for the project list  
(The project name which was valid when the backup was created is indicated)  

 

>  

7.1.12 [Project] menu > [Quit] 
22056 

Close the project and quit the application 

  

  Before exit the application: save any changes to the project! 

  

► Choose either: 
[Project] menu > [Close]  
Or: 
[Alt]+[F4] 

> In case of unsaved project changes a confirmation prompt appears. 

► Confirm saving. 

> The current project is saved and closed, and the program is quit.  
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>  

7.2 [Device] menu 

 

[Device] menu > [New] ...........................................................................................................................31 
[Device] menu > [Connect] .....................................................................................................................32 
[Device] menu > [Disconnect] .................................................................................................................32 
[Device] menu > [Login...]  (VSE only) ..................................................................................................32 
[Device] menu > [Logout]  (VSE only) ...................................................................................................32 
[Device] menu > [Write to Device] ..........................................................................................................33 
[Device] menu > [Read from Device] ......................................................................................................33 
[Device] menu > [Compare with Device...] .............................................................................................33 
[Device] menu > [Scan Network...] .........................................................................................................33 
[Device] menu > [Parameter] ..................................................................................................................34 
[Device] menu > [Settings] .....................................................................................................................36 
[Device] menu > [Actions] .......................................................................................................................38 
[Device] menu > [Reset]  (VSE only).....................................................................................................40 
[Device] menu > [Online Data] ...............................................................................................................42 

22057 

This chapter describes the functions contained in 
the [Device] menu. 

The [Device] menu allows you to connect 
diagnostic systems and vibration sensors with the 
PC and set all device-specific functions.  

The [Device] menu is active when a device is 
selected in the tree view (→ p. 13). 

The [Device] menu can be reached via the menu 
bar (→ p. 12). 
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>  

7.2.1 [Device] menu > [New] 
22059 

The function [ ] "New device" creates a first new device in the opened project.  

The created devices appear in the tree view. In the tree view, the settings, parameters and data of the 
device are displayed in groups (→ figure). 

 
 

>  

[Device] menu > [New] > [Vibrationsmonitor] 
22870 

The program supports the following devices: 
 • vibration monitor 

and, connected to it: 
 • diagnostic electronics VSE002 
 • diagnostic electronics VSE100 
 • diagnostic electronics VSE150  (PROFINET IO) 
 • vibration sensor VNB001 
 • vibration sensor VNB211 
  

  The set device type cannot be changed at a later date. 

 
>  

[Device] menu > [New] > [Group] 
22871 

It can be useful to group different devices in a group. 

Example: 

 
 

>  

[Device] menu > [New] > [Data group] 
22872 

It can be useful to group different data in a data group. 
 



 

 

32 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Menus [Device] menu 

>  

7.2.2 [Device] menu > [Connect] 
22063 

Prerequisite: 
 • in the tree view, the device (or the group of devices) is selected 
 • the device (or at least one device of the group) is connected 
 • the connection settings of PC and device correspond to the requirements 

> After successful connection the program and the device exchange data. 
 

>  

7.2.3 [Device] menu > [Disconnect] 
22064 

Prerequisite: 
 • in the tree view, the device (or the group of devices) is selected  
 • the device (or at least one device of the group) is connected to the program 

The function [ ] "Disconnect" disconnects the selected device (or all devices of the selected group). 

> After successful disconnection there is no more data exchange between the program and the 
device. 

 

>  

7.2.4 [Device] menu > [Login...]  (VSE only) 
22065 

  This applies only to VSEnnn: 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Login..." changes the security level. The access rights of the user can be restricted 
through the security levels. 
→ chapter VSE > ... > [Security] > Tab [Access Rights] (→ p. 65)  

The access rights on the corresponding security level can be adapted 
→ chapter VSE > [VSEnnn_#] > Detail [Device Settings] > [Security] (→ p. 63) 
  

  To change the security level a password may be required depending on the configuration. By 
default, no password is set. The passwords of the security levels can be adapted  
(→ chapter VSE > ... > [Security] > Tab [Passwords] (→ p. 64)). 

 
>  

7.2.5 [Device] menu > [Logout]  (VSE only) 
22066 

  This applies only to VSEnnn: 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

> The function [ ] "Logout" changes to security level 0. The function is only available if one of the 
security levels between 1...4 is active. 
→ Kapitel VSE > [VSEnnn_#] > Detail [Device Settings] > [Security] (→ p. 63)  
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>  

7.2.6 [Device] menu > [Write to Device] 
22067 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Write to Device" writes settings and parameters to the device. 
22123 

  The settings and parameters changed in the parameter setting software must be written to the 
device before use. 

► Write settings and parameters to the device via [Device] menu > [Write to Device] (→ p. 33). 
 

 

>  

7.2.7 [Device] menu > [Read from Device] 
22069 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Read from Device" reads settings and parameters from the device. 
 

>  

7.2.8 [Device] menu > [Compare with Device...] 
22070 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Compare with Device..." compares the locally stored parameter set with the one of 
the device. Differences between the parameter sets will be indicated. 
 

>  

7.2.9 [Device] menu > [Scan Network...] 
22071 

Prerequisite: 

 in the tree view, the device is selected 

The function [ ] "Scan Network..." scans the local network for connected devices. The found devices 
are listed in a dialogue window in the tab [Found Devices], from where they can be added to the 

project via the symbol [ ]. 

  This applies only to VSEnnn: 
In the tab [Search Networks], further networks can be searched via the IP address and the IP address 
of the current network can be changed. 
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>  

7.2.10 [Device] menu > [Parameter] 

 

[Device] menu > [Parameter] > [Open] ...................................................................................................34 
[Device] menu > [Parameter] > [New] ....................................................................................................34 
[Device] menu > [Parameter] > [Assign] .................................................................................................35 
[Device] menu > [Parameter] > [Write to Device] ...................................................................................35 
[Device] menu > [Parameter] > [Read from Device] ..............................................................................35 
[Device] menu > [Parameter] > [Compare with Device] .........................................................................35 

22115 

Prerequisite: 

 in the tree view, the device is selected 

The submenu [Parameter] contains all functions required for parameter management. 

 

 

>  

[Device] menu > [Parameter] > [Open] 
22119 

Prerequisite: 

 in the tree view, the device is selected 

The function [ ] "Open parameter" opens the parameters of the selected device. 
The parameters appear in the detailed view under a tab. 
>  

[Device] menu > [Parameter] > [New] 
22120 

Prerequisite: 

 in the tree view, the device is selected 

The function [ ] "New parameter" creates a new parameter set. 
The program assigns this parameter set to the selected device.  
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>  

[Device] menu > [Parameter] > [Assign] 
22121 

Prerequisite: 

 in the tree view, the device is selected 

The function [ ] "Assign parameter" assigns the selected parameter set to a device. 
 

>  

[Device] menu > [Parameter] > [Write to Device] 
22122 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Write to Device" writes settings and parameters to the device. 
22123 

  The settings and parameters changed in the parameter setting software must be written to the 
device before use. 

► Write settings and parameters to the device via [Device] menu > [Write to Device] (→ p. 33). 
 

 

>  

[Device] menu > [Parameter] > [Read from Device] 
22124 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Read from Device" reads settings and parameters from the device. 
 

>  

[Device] menu > [Parameter] > [Compare with Device] 
22125 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Compare with Device..." compares the locally stored parameter set with the one of 
the device. Differences between the parameter sets will be indicated. 
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>  

7.2.11 [Device] menu > [Settings] 

 

[Device] menu > [Settings] > [Open] ......................................................................................................36 
[Device] menu > [Settings] > [Write IP Settings to Device]  (VSE only) ................................................36 
[Device] menu > [Settings] > [Write Access Rights to Device] ...............................................................37 
[Device] menu > [Settings] > [Read Access Rights from Device] ..........................................................37 

22126 

The submenu [Settings] covers all functions for the settings management. 

 

 

>  

[Device] menu > [Settings] > [Open] 
22128 

Prerequisite: 

 in the tree view, the device is selected 

The function [ ] "Open Settings" opens the settings of the selected device.  
The settings are displayed in the detailed view under a tab. 
 

>  

[Device] menu > [Settings] > [Write IP Settings to Device]  (VSE only) 
22129 

  This applies only to VSEnnn: 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Write IP Settings to Device" writes the current network settings to the device. 
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>  

[Device] menu > [Settings] > [Write Access Rights to Device] 
22130 

Prerequisite:  

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

 The user is logged in to the device via [ ] with a security level that is higher than the level that is 
to be changed 

The function [ ] "Write Access Rights to Device" writes the configured access rights to the device. 
 

>  

[Device] menu > [Settings] > [Read Access Rights from Device] 
22131 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

 The user is logged in to the device via [ ] with a security level that is higher than the level that is 
to be changed 

The function [ ] "Read Access Rights from Device" reads the access rights from the device. 
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>  

7.2.12 [Device] menu > [Actions] 

 

[Device] menu > [Actions] > [Write Firmware to Device]  (VSE only) ...................................................38 
[Device] menu > [Actions] > [Reboot]  (VSE only) ................................................................................39 
[Device] menu > [Actions] > [Self-test] ...................................................................................................39 
[Device] menu > [Actions] > [Teach-in] ..................................................................................................39 

22132 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The submenu [Actions] comprises administrative functions of the device. 

 

 

>  

[Device] menu > [Actions] > [Write Firmware to Device]  (VSE only) 
22134 

  This applies only to VSEnnn: 
  

  Beforehand, save parameters, settings and history! 
Otherwise the data will be lost during the update of the firmware. 

  

The function [ ] "Write Firmware to Device" writes a new firmware to the diagnostic electronics.  
The firmware file is selected from a file window. 
  

  ► Always secure the voltage supply and connections between the PC and the diagnostic 
electronics while the firmware is being written to the device. 

> Otherwise the diagnostic electronics may be damaged and may have to be returned to the 
manufacturer. 
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[Device] menu > [Actions] > [Reboot]  (VSE only) 
22135 

  This applies only to VSEnnn: 

The function [ ] "Reboot" reboots the diagnostic electronics. 
 

>  

[Device] menu > [Actions] > [Self-test] 
22136 

Applies only to type MEMS (VSA) sensors! 
For IEPE sensors only wire-break test! 

The function [ ] "Self-test" carries out a self-test of the sensors connected to the dynamic inputs. 
 

>  

[Device] menu > [Actions] > [Teach-in] 
22137 

The function [ ] "Teach-in" measures the characteristic values of connected sensors and determines 
the teach values of the configured objects. 
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>  

7.2.13 [Device] menu > [Reset]  (VSE only) 

 

[Device] menu > [Reset] > [Counter] ......................................................................................................40 
[Device] menu > [Reset] > [History] ........................................................................................................40 
[Device] menu > [Reset] > [Parameter] ..................................................................................................41 
[Device] menu > [Reset] > [Security] ......................................................................................................41 
[Device] menu > [Reset] > [Factory Settings] .........................................................................................41 

22138 

  This applies only to VSEnnn: 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The submenu [ ] "Reset" comprises several functions for resetting various device configurations. 

 

 

>  

[Device] menu > [Reset] > [Counter] 
22140 

The function [ ] "Reset Counter" resets the counters configured in the device to "0". 
 

>  

[Device] menu > [Reset] > [History] 
22141 

The function [ ] "Reset History" resets the internal history of the device. In addition, the device time 
is reset to the PC system time. 
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>  

[Device] menu > [Reset] > [Parameter] 
22142 

The function [ ] "Reset Parameter" deletes the parameter set stored on the device. 
 

>  

[Device] menu > [Reset] > [Security] 
22143 

The function [ ] "Reset Security" resets the internal access rights of the device. 
  

  Resetting the internal access rights requires at least security level 1. 

 
>  

[Device] menu > [Reset] > [Factory Settings] 
22144 

The function [ ] "Factory Settings" restores the factory setting of the device. 
  

  Restoring to the factory settings requires security level 4. 

The function [Factory Settings] does not reset the IP settings. 
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>  

7.2.14 [Device] menu > [Online Data] 
22145 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The submenu [Online Data] comprises the monitoring of all measured data of the device. Depending 
on the device type different monitoring data can be accessed (→ chapter Monitoring types): 

 

  This applies only to VSEnnn: 
e.g. raw signal (time signal), processed data (e.g. frequency spectra or object values) 
→ figure above. 

  This applies only to VNBnnn: 
data, I/O, history 
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>  

7.3 [Parameter] menu 

 

[Parameter] menu > [New] .....................................................................................................................43 
[Parameter] menu > [Device] ..................................................................................................................43 
[Parameter] menu > [Write to Device] ....................................................................................................44 
[Parameter] menu > [Read from Device] ................................................................................................44 

22147 

This chapter describes the functions contained in the [Parameter] menu.  

In the [Parameter] menu, parameters are created or written to/read from the device. 
The [Parameter] menu can be reached via the menu bar (→ p. 12).  

 

 

>  

7.3.1 [Parameter] menu > [New] 
22149 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [Device_#], 
     [Parameter_#] 

The function [ ] [New Parameter] creates a new parameter set. 
 

>  

7.3.2 [Parameter] menu > [Device] 
22150 

Prerequisite: 

 in the tree view, the parameter set [Parameter_#)] is selected 

The submenu [Device] > [Assign] assigns the selected set of parameters to a device. 
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>  

7.3.3 [Parameter] menu > [Write to Device] 
22153 

Prerequisite: 

 in the tree view, the parameter set [Parameter_#)] is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Write Parameters to Device" writes settings and parameters to the device. 
22123 

  The settings and parameters changed in the parameter setting software must be written to the 
device before use. 

► Write settings and parameters to the device via [Device] menu > [Write to Device] (→ p. 33). 
 

 

>  

7.3.4 [Parameter] menu > [Read from Device] 
22154 

Prerequisite: 

 in the tree view, the device is selected 

 VES software is connected to the device via [ ] 

The function [ ] "Read Parameters from Device" reads settings and parameters from the device to 
the parameter setting software. 
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>  

7.4 [Object] menu 

 

What are objects? ...................................................................................................................................45 
[Object] menu > [New] ............................................................................................................................45 
[Object] menu > [Open] ..........................................................................................................................46 
[Object] menu > [Import] .........................................................................................................................46 
[Object] menu > [Export] .........................................................................................................................46 
[Object] menu > [Rename] .....................................................................................................................47 
[Object] menu > [Delete] .........................................................................................................................47 

22155 

This chapter describes the functions contained in the [Object] menu.  

The [Object] menu allows you to create and manage objects. 
The [Object] menu can be reached via the menu bar (→ p. 12).  

 

 

>  

7.4.1 What are objects? 
22157 

Objects are data and parameters that are to be displayed in the detailed view. 

If selected in the tree view: ... what objects? 

(nothing) 
Group 

Group or data group 

VNBnnn_# 
VSEnnn_# 

Device settings + parameters 

Settings Device settings 

Parameter_# Common configuration 

Data Data group (in the tree view) 
 

>  

7.4.2 [Object] menu > [New] 
22158 

Prerequisite: 

 in the tree view, the [Data] of the device is selected 

The function [ ] [New Object] creates a new datagroup in the tree view. 

  

Prerequisite: 

 in the tree view, a group is selected 

The function [ ] [New Object] creates a new object in the tree view alternatively 
 • a new group 
 • a new datagroup 
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>  

7.4.3 [Object] menu > [Open] 
22159 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [Settings], 
     [Parameter_#] 

The function [ ] [Open Object] opens an existing object in the detailed view. 
 

>  

7.4.4 [Object] menu > [Import] 
22160 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [VNBnnn_#], 
     [VSEnnn_#], 
     [Parameter_#], 
     [Data] 

The function [ ] "Import Object" imports objects from a file into the active project in the tree view: 

Device file: *.idev 

Parameters file: *.ipar 

Data file:: *.idat 
 

>  

7.4.5 [Object] menu > [Export] 
22161 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [VNBnnn_#], 
     [VSEnnn_#], 
     [Parameter_#], 
     [Data] 

The function [ ] "Export Object" exports objects from the tree view into a file: 

Device file: *.idev 

Settings file: *.iset 

Parameters file: *.ipar 
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>  

7.4.6 [Object] menu > [Rename] 
22162 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [VNBnnn_#], 
     [VSEnnn_#], 
     [Parameter_#] 

► To rename an object:  
Choose either:  
Function [ ] "Rename Object" 
Or: 
Key [F2] 

> The name of this object is selected for editing 

► Change the object name 

► Confirm the change with [ENTER] 
Or: 
Cancel the change with [ESC] 

 

>  

7.4.7 [Object] menu > [Delete] 
22163 

Prerequisite: 

 in the tree view, one of the following options is selected: 
     [VNBnnn_#], 
     [VSEnnn_#], 
     [Parameter_#] 

  

  Assigned objects cannot be deleted. 

  

► To delete the selected object: 
Choose either: 

Function [ ] "Delete Object" 
Or:  
Key [DEL] 

> The confirmation prompt appears 

► After [Yes]: the selected object is deleted from the tree structure 
After [No] or key [ESC]: the object is not deleted 
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>  

7.5 [View] menu 

 

[View] menu > [Language] ......................................................................................................................48 
[View] menu > [Settings] .........................................................................................................................49 

22164 

This chapter describes the functions contained in the [View] menu.  

In the [View] menu you can manage the language and unit settings. 
The [View] menu can be reached via the menu bar (→ p. 12). 

 

 

>  

7.5.1 [View] menu > [Language] 
22166 

The submenu [Language] allows you to switch the language of the user interface. 

> After switching the language all menu items are displayed in the selected language. 

> The query appears whether the preset object names are to be displayed in the selected language 
as well. 

> If [Yes]: all preset object names are displayed in the selected language. 

  The previously manually changed object names remain unchanged. 
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>  

7.5.2 [View] menu > [Settings] 

 

[View] menu > [Settings] > Tab [Common settings] ...............................................................................49 
[View] menu > [Settings] > Tab [Display units] .......................................................................................49 
[View] menu > [Settings] > Tab [Diagnostic electronics VSExxx] ..........................................................50 
[View] menu > [Settings] > Tab [Project data monitoring] ......................................................................50 
[View] menu > [Settings] > Tab [Diagnostics].........................................................................................50 
[View] menu > [Settings] > Tab [Data export].........................................................................................51 

22167 

The function [ ] "Settings" contains the following setting options: 
 

>  

[View] menu > [Settings] > Tab [Common settings] 
22881 

  

Section Dialogue element Display Switching function 

Common settings Automatically open 
the last opened 
project 

checkbox activate / deactivate 

Colour scheme 
Colour scheme 

selected colour scheme: 
• light 
• dark 

selectable from list 

Data display settings Activate storage of 
the data display 
settings 

checkbox activate / deactivate 

  Reset all data display 
settings to the 
corresponding 
standard value 

selected setting: 
• all display settings 
• only online monitoring 
• only data recordings 

selectable from list 

  

Switching functions: 

 Reset data display to the standard settings 
 

>  

[View] menu > [Settings] > Tab [Display units] 
22882 

Engineering units displayed for... 
 • distance | speed | acceleration 
 • frequency | rotational speed 
  

Section Dialogue element Display Switching function 

Engineering units Metric 1 mm | mm/s | mg Option field 

  Metric 2 mm | mm/s | m/s² Option field 

  Imperial 1 mil | in/s | mg Option field 

  Imperial 2 mil | in/s | m/s² Option field 

Frequency and rotational speed Hertz Hz | rpm Option field 

  Revolutions per 
minute 

cpm | cpm Option field 
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>  

[View] menu > [Settings] > Tab [Diagnostic electronics VSExxx] 
22883 

  

Section Dialogue element Display Switching function 

Signal weightings Activate signal 
weighting 

checkbox activate / deactivate 

Ethernet protocol for data 
monitoring 

• TCP (standard) 
selected setting 

Select an option 

  • UDP Select an option 
  

As a rule, communication via UDP is faster than TCP. 
UDP should be preferred in case of slow networks. 

UDP is usually automatically blocked by Firewalls. 
In this case, have the communication be configured by the network administrator! 

After switching the Ethernet protocol: 

Manually disconnect the device (via ), then reestablish the connection (via ). 
>  

[View] menu > [Settings] > Tab [Project data monitoring] 
22884 

  

Section Dialogue element Display Switching function 

Default behaviour 
Default 

selected setting: 
• on 
• off 

selectable from list 

Monitoring data • objects 
• counters 
• alarms 
• inputs 

checkbox activate / deactivate 

 

>  

[View] menu > [Settings] > Tab [Diagnostics] 
22885 

Parameters for recording the self-diagnostics of the software. 
  

Section Dialogue element Display Switching function 

Trace levels Error messages checkbox activate / deactivate 

  Warning messages checkbox activate / deactivate 

  Information 
messages 

checkbox activate / deactivate 

  Debug information checkbox activate / deactivate 

Trace to file Max. file size configured value increase / reduce value 

  Max. number of 
backup files 

configured value increase / reduce value 

  Storage folder configured path --- 
  

 

Note on [Debug information]: 
This function may lead to unreliable communication between the devices on slow PCs. 
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>  

[View] menu > [Settings] > Tab [Data export] 
22886 

  

Section Dialogue element Display Switching function 

Decimal count (all formats) Decimal count configured value increase / reduce value 

Float number format (CSV, 
XML) Decimal point 

selected setting: 
• dot 
• comma 

selectable from list 

  

Digit grouping 

selected setting: 
• none 
• comma 
• apostrophe 

selectable from list 

Flags and time stamps (CSV, 
XML) 

Human-readable 
flags 

checkbox activate / deactivate 

  Human-readable time 
stamps 

checkbox activate / deactivate 

  Date and time format selected setting selectable from list 

Column separator  
(for CSV files) 

Separator 

selected setting: 
• semicolon 
• comma 
• tabulator 

selectable from list 

  

REMARKS 

Element Value Description 

Flag and time stamp: deactivated value is displayed in a form optimised for computer-aided evaluation 

  activated value is displayed in a form readable for humans 
(several versions available) 

 



 

 

52 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Menus [Window] menu 

>  

7.6 [Window] menu 

 

[Window] menu > [Tile] ...........................................................................................................................52 
[Window] menu > [Overlap] ....................................................................................................................52 
[Window] menu > [View] .........................................................................................................................52 
[Window] menu > [Close] .......................................................................................................................53 
[Window] menu > [Close All] ..................................................................................................................53 
[Window] menu > [Window] ....................................................................................................................53 

22168 

This chapter describes the functions contained in the [Window] menu.  

The [Window] menu allows you to change the layout and arrangement of the windows and tabs for the 
detailed view. 
The [Window] menu can be reached via the menu bar (→ p. 12). 

 

 

>  

7.6.1 [Window] menu > [Tile] 
22170 

Prerequisite: 

 setting: [Window] > [View] > [Several Windows] 

The function [ ] "Tile Windows" arranges opened windows side by side in the detailed view. 
 

>  

7.6.2 [Window] menu > [Overlap] 
22171 

Prerequisite: 

 setting: [Window] > [View] > [Several Windows] 

The function [ ] "Overlap Windows" arranges opened windows in the detailed view so that they 
overlap. 
 

>  

7.6.3 [Window] menu > [View] 
22172 

The submenu [View] allows you to set the detailed view. Choose either: 

 [Several Windows]  
= for each selected object an own window 
 • all selected windows in the detailed view are visible at the same time 
 • if several windows: either side by side or overlapping 

 [Tabs]  
= tabs for all selected objects 
 • only the content of the active tab is visible 
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>  

7.6.4 [Window] menu > [Close] 
22173 

Close the active window or the active tab in the detailed view: 

► Choose either: 

Function [ ] "Close Window" 
Or: 
Key [CTRL] + [F4] 

 

>  

7.6.5 [Window] menu > [Close All] 
22174 

Close all windows and tabs in the detailed view: 

► Choose either: 

Function [ ] "Close All Windows" 
Or: 
Key [CTRL]+[ALT]+[F4] 

 

>  

7.6.6 [Window] menu > [Window] 
22175 

The submenu [Window] lists all objects of the detailed view.  

► Activate the desired objects. 

> The active object appears as a window or a tab in the foreground. 
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>  

7.7 [Help] menu 

 

[Help] menu > [ifm Online] ......................................................................................................................54 
[Help] menu > [efector octavis Online] ...................................................................................................54 
[Help] menu > [About VES004] ..............................................................................................................54 

22176 

This chapter describes the functions contained in the [Help] menu.  

 

 

>  

7.7.1 [Help] menu > [ifm Online] 
22178 

Opens the start page on the ifm website → www.ifm.com  
 

>  

7.7.2 [Help] menu > [efector octavis Online] 
22179 

Opens the page for [Vibration monitoring systems] on the ifm website. 

The page starts with the language set on the PC. 
This is not affected by the language set in the VES004 software. 
 

>  

7.7.3 [Help] menu > [About VES004] 
22180 

Shows in a separate window the following data: 

 VES004 
• software release, e.g. V1.10.04.6209 
• ifm's internet address 
• email address of the ifm support 

 Qt 
The program works with the QT software library. 
Here you can find notes and licence information on Qt. 

 OpenSSL 
The program works with the OpenSSL program. 
Here you can find notes and license information on OpenSSL. 

 

>  

http://www.ifm.com/
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8 Configure VSEnnn 

 

VSE > Device [VSEnnn_#] > [Settings] ..................................................................................................55 
VSE > Device [VSEnnn_#] > [Parameter_#] ..........................................................................................67 

22181 

For the type VSE diagnostic electronics, the following elements are available. 

Add a new device to a project: → chapter [Device] menu > [New...] (→ p. 31)  
 

>  

8.1 VSE > Device [VSEnnn_#] > [Settings] 

 

VSE > [VSEnnn_#] > Detail [Device Settings]........................................................................................56 
22183 

This chapter describes the functions contained in the device [VSEnnn_#]. The device [VSEnnn_#] can 
be reached via the tree view (→ p. 13). 
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>  

8.1.1 VSE > [VSEnnn_#] > Detail [Device Settings] 

 

VSE > [VSEnnn_#] > Detail [Device Settings] > [Device] ......................................................................57 
VSE > [VSEnnn_#] > Detail [Device Settings] > [Address] ....................................................................58 
VSE > [VSEnnn_#] > Detail [Device settings] > [Fieldbus] ....................................................................59 
VSE > [VSEnnn_#] > Detail [Device Settings] > [Actions] .....................................................................61 
VSE > [VSEnnn_#] > Detail [Device Settings] > [Security] ....................................................................63 
VSE > [VSEnnn_#] > Detail [Device settings] > [Test] ...........................................................................66 

22191 

The detail [Device Settings] contains information and settings of the diagnostic electronics. 

► Display the device settings:  
in the tree view [VSEnnn_#] > [Settings] (double-click) 

The detailed view contains the following information: 
 • Type (article number) 
 • Hardware version 
 • Serial number 
 • MAC address 
 • Firmware version 
 • Parameter set used 

In the detailed view you can enter a name for the device. The name will be shown in the tree view. 

In the detailed view, the detail [Device Settings] contains the following elements: 
 • Device 
 • Address 

 •   This applies only to VSE15n: Fieldbus (name of the concrete fieldbus) 
 • Actions 
 • Security 
 • Test 
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>  

VSE > [VSEnnn_#] > Detail [Device Settings] > [Device] 
22192 

The element [Device] contains the following sections: 
 

>  

VSE > ... > [Device] > Tab [Configuration] 
22193 

This section holds information about the diagnostic electronics and the current connection status. You 
can also update the firmware and assign a different parameter set.  

To avoid the parameter set name being shown incorrectly, the character chart can be changed (only 
for VES002, VSE100 if project import from VES003). 

Section Dialogue element Display Switching function 

Diagnostic electronics Type Article number 

--- 

Version Hardware version 

Connection Status: busy / connected / not 
connected 

Serial number Hardware serial number 

MAC address IP hardware address 

System mode Status: monitoring / set-up / not 
connected 

Write firmware to device Firmware version Current firmware version  

Language / character chart Character chart   inly for VES002, VSE100 if 
project import from VES003 

Select from list box 

  

Switching functions: 

 Write firmware to device 
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>  

VSE > [VSEnnn_#] > Detail [Device Settings] > [Address] 
22196 

The element [Address] contains the following sections: 
 

>  

VSE > ... > [Address] > Tab [configuration] 
22197 

This section holds information about the diagnostic electronics and the current connection status. The 
TCP/IP address contains the information of the current connection of the software to the device. The 
TCP/IP settings are the network settings currently stored in the VSE. 

Section Dialogue element Display Switching function 

TCP/IP address Adress Current IP address 
Preset = 192.168.0.1 

, ,  Port 
Current port 
Preset = 3321 

TCP/IP settings Option field Choose either: 
• static IP address or 
• obtain IP address via DHCP 

 

TCP/IP adress Current IP address 
Preset = 192.168.0.1 

Host name Name of the host 

TCP/IP port Current port 
Preset = 3321 

Subnet mask Current subnet mask 
Preset = 255.255.255.0 

Gateway Current IP address of the gateway 

MAC adress Hardware adress 
  

Switching functions: 

 scan the network for connected devices 

 connect the device 

 disconnect the device 

 transfer the TCP/IP settings to the device 
  

Note: 

 Static IP address: 
The TCP/IP address and the other network-specific parameters (port, subnet mask and gateway) 
are permanently stored in the device.  
The TCP/IP address together with the port must be unique within the network! Otherwise, the 
participants cannot communicate with each other in the network. 

 Dynamic Host Configuration Protocol, dynamic IP address DHCP 
If the IP address is to be handled dynamically by a DHCP server, only the name (host name) and 
TCP/IP port need to be specified in the diagnostic electronics. The DHCP server must also be 
configured! This configuration does not allow direct communication (point-to-point) with a 
PC/notebook. 
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>  

VSE > [VSEnnn_#] > Detail [Device settings] > [Fieldbus] 

 

VSE > ... > Detail [Geräteeinstellungen] > [PROFINET IO] ...................................................................59 
22874 

In this context, [Fieldbus] represents the concrete fieldbus type of the selected device. 
The element [Fieldbus] contains the following sections: 
 

>  

VSE > ... > Detail [Geräteeinstellungen] > [PROFINET IO] 
22874 

  This applies only to VSE150: 
 

>  

VSE > ... > [PROFINET IO] > Tab [Configuration] 
22876 

In this section, PROFINET information about the diagnostics electronics are indicated (valid in the 
PROFINET network). 

Section Dialogue element Display Switching function 

PROFINET IO configuration Device Name Choose either:  
• configured value 
• value read by the device 

free text 
(usually provided by the host 
PLC) 

IP address Choose either: 
• configured value 
• value read by the device 

(usually provided by the host 
PLC) 

Subnet mask Choose either: 
• configured value 
• value read by the device 

(usually provided by the host 
PLC) 

Gateway Choose either: 
• configured value 
• value read by the device 

(usually provided by the host 
PLC) 

MAC address value read by the device --- 
  

Switching functions: 

 Write PROFINET IO configuration to the device 

 Read PROFINET IO configuration from the device  
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>  

VSE > ... > [PROFINET IO] > Tab [Information] 
22877 

In this section, information about the current connection status is indicated (valid in the PROFINET 
network). 

Section Dialogue element Display Switching function 

Information Status connected / initialised | ready (not 
connected) 
value read by the device 

--- 

MAC address value read by the device --- 

MAC adress IE1 value read by the device --- 

MAC address IE2 value read by the device --- 

MAC address value read by the device --- 

Communication diagnostics Current queue load Bus load (0...32) 
value read by the device 

--- 

Queue overflow 
counter 

value read by the device --- 
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>  

VSE > [VSEnnn_#] > Detail [Device Settings] > [Actions] 

 

VSE > ... > [Actions] > Tab [Manipulate Device] ....................................................................................61 
VSE > ... > [Actions] > Tab [Variant Switching] ......................................................................................61 
VSE > ... > [Actions] > Tab [Reset Device] ............................................................................................62 

22201 

Prerequisite: 

 VES software is connected to the device via [ ] 

The element [Actions] contains the following sections: 
 

>  

VSE > ... > [Actions] > Tab [Manipulate Device] 
22202 

  

Section Dialogue element   Switching function 

Reboot ---  

Reboot the device.The device is disconnected.  
After the reboot the software tries to re-establish the 
connection. 

Execute self-test ---  
Type VSA: Execute self-test of the dynamic inputs 

Type IEPE: Wire-break detection 

Carry out teach-in ---  
Start the teach-in for the selected objects of the parameter set 
(only possible for objects with activated auto-teach option) 

 

>  

VSE > ... > [Actions] > Tab [Variant Switching] 
22206 

You can use variants if you want to monitor certain objects only in defined machine states and where 
this cannot be solved via triggers.  
→ chapter VSE > [Parameter_#] > Detail [Variants] (→ p. 107). 
  

Section Dialogue element Display Switching function 

Manual activation Active variant Active variant Selection of the active variant 

Activated objects ID   --- 

Name   --- 

Type   --- 

Input   --- 
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>  

VSE > ... > [Actions] > Tab [Reset Device] 
22207 

Here you can delete diverse parameters or reset to default values. 

Section Dialogue element   Switching function 

Reset the counter --- 
 

Set all counter values to '0' 

Reset history --- 
 

Reset the history of the device 

Synchronise the real-time clock of the device with the time of 
the operating system. 

Reset parameters --- 
 

Reset all parameters to the default values 

Reset security settings --- 
 

To do so, at least security level 1 is required!  

Reset all security settings to the default values 

Restore factory settings --- 
 

To do so, security level 4 is required!  

Restore all factory settings 
The connection settings (TCP/IP address, port, subnet mask, 
gateway) are exempt from this.  
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>  

VSE > [VSEnnn_#] > Detail [Device Settings] > [Security] 

 

VSE > ... > [Security] > Tab [Passwords] ...............................................................................................64 
VSE > ... > [Security] > Tab [Access Rights] ..........................................................................................65 

22213 

Requirements to change the security parameters: 

 VES software is connected to the device via [ ] 

 user is logged in via [ ] 

► Change password: 

log in to the device via [ ] with at least the security level which is to be changed. 

► Change access rights: 

log in to the device via [ ] with a higher security level than that which is to be changed. 

The element [Security] contains the following sections: 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Settings] 

>  

VSE > ... > [Security] > Tab [Passwords] 
22216 

Under the tab [Passwords] a 5-level password concept can be set up:  
Levels 1...4 can be password-protected. 
Level 0 cannot be protected and can always connect to the diagnostic electronics.  

You can restrict the user rights (available functions) for levels 0 to 3 under the tab [Access Rights]. 
Level 4 always has all permissions. 

To enable the password protection: 

1. First assign a password for level 4 and save it with [ ]. 

2. Only then assign a password for each lower level, one after the other, and save them with [ ]. If 
you do not wish to further restrict the access rights of the lower levels, you do not need to assign a 
password to the lower levels. 

► Change password: 

log in to the device via [ ] with at least the security level which is to be changed. 

To be able to write the security settings to the device, the user must be logged in with security level 4. 

Section Dialogue element Display Switching function 

Passwords 

Password: security 
level 4 

New: 
enter new password 

 
Confirmation:  
repeat password 

... ... ... 

Password: security 
level 

New: 
enter new password 

 
Confirmation:  
repeat password 

Connect / log in 

Current status: 

Not connected 

Security level # (not logged in] 

Security level # 

, ,  

,  
 

Switching functions: 

 save new password 

 connect the device 

 disconnect the device 

 log in to the device, to do so select security level 

 disconnect the device 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Settings] 

>  

VSE > ... > [Security] > Tab [Access Rights] 
22218 

For OPC servers, only the following rights can be changed: 
 • write parameters 
 • carry out teach-in 
 • change IP settings 
 • restart device 
 • reset counter 

For level 4, access rights can principally not be changed. 

► Change access rights: 

log in to the device via [ ] with a higher security level than that which is to be changed. 

For levels 3...0 the following applies: 

 if an access right changes from [allowed] to [not allowed] (= ), the access rights for all lower 
levels changes to [not allowed] and cannot be changed there any more (= ) 

 if an access right changes from [not allowed] to [allowed]  (= ), the access right in the next 
lower level changes to [not allowed], but can be changed (= ) 
for all lower levels the access rights remains [not allowed] and cannot be changed  (= ) 

Section Dialogue element Display Switching function 

Access Rights Read parameters: 

current access rights for 
• OPC server 
• level 4 
• level 3 
• level 2 
• level 1 
• level 0 

 (grey) = allowed,  
                    cannot be 
changed 
 

 (green) = allowed,  
                    can be changed 

  

 (red) = not allowed,  
                    can be changed 
 

 (grey) = not allowed,  
                    cannot be 
changed 

Write parameters: 

Carry out teach-in: 

Read data: 

Read spectrum: 

Read history: 

Delete history: 

Adapt dyn. inputs: 

Read external inputs: 

Test (OUT/LED): 

Change variants: 

Change IP settings: 

Reboot the device: 

Reset the counters 

Connect / log in 

Current status:: 

not connected 

security level # (not logged in] 

security level # 

, ,  

, ,  

,  
  

Switching functions: 

 write access rights to device 

 read access rights from device 

 connect the device 

 disconnect the device 

 log in to the device, to do so select security level 

 disconnect the device 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Settings] 

>  

VSE > [VSEnnn_#] > Detail [Device settings] > [Test] 
22225 

Prerequisite: 

 VES software is connected to the device via [ ] 

Used to test the outputs and LEDs of the diagnostic electronics. 

> If [Test Outputs] or [Test LEDs] is selected, a confirmation prompt appears whether the device is 
to be switched to the test mode. 

> After selecting [Yes], the test mode for outputs and LEDs is activated. 

  

To terminate the test mode: 

► Deactivate [Test Outputs] AND 

► Deactivate [Test LEDs] 

> A confirmation message appears 

> After selecting [OK], the test mode is terminated and the device returns to the monitoring mode. 

The element [ ] "Device Test" contains the following sections: 
 

>  

VSE > ... > [Test] > Tab [Outputs] 
22226 

Only the functions available in the connected device are offered for testing. Measurements that are 
active during testing will be ignored. 

Section Dialogue element Display Switching function 

Outputs OUT 1 digital: 0 / 1 
analogue: 0...22 mA 

specify manually either digital 
status or analogue output value 

OUT 2 0 / 1 specify manually the digital 
status 

Digital I/Os 
(VES100 only) 

I/O # 0 / 1 specify manually the digital 
status 

 

>  

VSE > ... > [Test] > Tab [LEDs] 
22227 

  

Section Dialogue element Display Switching function 

LEDs 

Sensor # 

green 
yellow 
red 
OUT 

specify manually the digital 
status 

System 

green 
yellow 
red 
OUT 

specify manually the digital 
status 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

8.2 VSE > Device [VSEnnn_#] > [Parameter_#] 

 

VSE > [Parameter_#] > Detail [Common Configuration] ........................................................................68 
VSE > [Parameter_#] > Detail [Inputs] ...................................................................................................73 
VSE > [Parameter_#] > Detail [Trigger] ..................................................................................................86 
VSE > [Parameter_#] > Detail [Objects] .................................................................................................90 
VSE > [Parameter_#] > Detail [Variants] ..............................................................................................107 
VSE > [Parameter_#] > Detail [Counter] ..............................................................................................114 
VSE > [Parameter_#] > Detail [History] ................................................................................................118 
VSE > [Parameter_#] > Detail [Alarms] ................................................................................................122 
VSE > [Parameter_#] > Detail [PROFINET IO] ....................................................................................131 

22228 

This chapter describes the functions contained in the object [Parameter_#]. 

The object [Parameter_#] is assigned to the object [VSEnnn_#]. 
The object [Parameter_#] can be accessed via the tree view (→ p. 13). 

In the detailed view, information and settings of the diagnostic electronics are displayed in the tab 
[Parameter_#]. 

► Display the parameter set:in the tree view, double-click on the desired parameter set: 
[Parameter_#] 

The following information is displayed in the detailed view under the [Parameter_#] tab: 
  • Common configuration 
  • Inputs 
  • Triggers 
  • Objects 
  • Variants 
  • Counters 
  • History 
  • Alarms 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

8.2.1 VSE > [Parameter_#] > Detail [Common Configuration] 

 

VSE > ... > Detail [Common Configuration] > [Supported Devices] .......................................................68 
VSE > ... > Detail [Common Configuration] > [Documentation] .............................................................69 
VSE > ... > Detail [Common Configuration] > [Device Information] .......................................................70 
VSE > ... > Detail [Common Configuration] > [Assigned Devices] .........................................................72 

22230 

The detail [Common Configuration] contains information and documentation of the device and the 
parameter set: 

Section Dialogue element Display Switching function 

Information Created: date of creation --- 

Changed: date of the last modification --- 

Parameter set Name: current name, e.g.:"Parameter_01" overwrite the preset name 
  

In the detailed view you can enter another name for the parameter set. The name will be shown in the 
tree view. 

In the detailed view the detail [Common Configuration] contains the following elements: 
 • Supported devices 
 • Documentation 
 • Device information 
 • Assigned devices 
 

>  

VSE > ... > Detail [Common Configuration] > [Supported Devices] 
22231 

On the basis of the parameters and functions used in the parameter set, the requirements on the 
device (firmware version) are determined. The device type of the octavis diagnostic electronics was 
already selected when creating the parameter set. 

The element [Supported Devices] contains the following sections: 
>  

VSE > ... > [Supported Devices] > Tab [Configuration] 
22232 

  

Section Dialogue element Display Switching function 

Supported device types Device type:: e.g. "efector octavis diagnostic 
electronics VSE002" 

--- 

Supported firmware versions Min. required: version number --- 

Max. supported: version number --- 
  

The [Supported Device Types] indicate for which type of diagnostic electronics (VSE002 or VSE100) 
the parameter set was created. 

The entries for the supported firmware versions are determined automatically based on the parameter 
set. On the basis of the objects created and functions used, the minimum required and maximum 
supported firmware version is determined and displayed. 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Common Configuration] > [Documentation] 
22233 

The documentation is used to describe the application. The entries are also saved in the diagnostic 
electronics.  
If several devices share the same parameter set, it is advisable to not use any application-specific 
information. 

The element [Documentation] contains the following sections: 
 

>  

VSE > ... > [Documentation] > Tab [Application] 
22234 

In this section the application can be described. The information refers to the company and the 
machine/installation on which the diagnostic unit is installed. The fields are free-text fields. 

Section Dialogue element Display Switching function 

Application Company: free text --- 

Address: free text --- 

City: free text --- 

Location: free text --- 

Machine: free text --- 
 

>  

VSE > ... > [Documentation] > Tab [Description] 
22235 

The description contains a creation date and the date of the last parameter change. The author of the 
parameter set and a free text description can be added. 

Section Dialogue element Display Switching function 

Description Created by: free text max. 100 characters 

Date of creation: date of creation date later / earlier 

Last change: date of the last modification automatic 

Description free text max. 100 characters 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Common Configuration] > [Device Information] 

 

VSE > ... > [Device Information] > Tab [Outputs] ...................................................................................70 
VSE > ... > [Device Information] > Tab [Digital I/Os] ..............................................................................70 
VSE > ... > [Device Information] > Tab [Trigger Dependencies] ............................................................71 
VSE > ... > [Device Information] > Tab [Object Dependencies] .............................................................72 

22236 

The element [Device Information] contains a summary or overview of the configuration of the inputs 
and outputs of the diagnostic electronics. Here you will also find an overview of the dependencies 
between the triggers and objects defined in the parameter set. 

The element [Device Information] contains the following sections: 
 

>  

VSE > ... > [Device Information] > Tab [Outputs] 
22237 

Displays the outputs of the diagnostic electronics with an overview of the most important configured 
parameters. 

Section Dialogue element Display Switching function 

Outputs OUT 1 use, information 

 
OUT 2 use, information 

  

Switching functions: 

 configure the selected object 
 

>  

VSE > ... > [Device Information] > Tab [Digital I/Os] 
22239 

  This applies only to VSE100: 

Displays the digital I/Os of the diagnostic electronics VSE100 with an overview of the most important 
configured parameters.  

Section Dialogue element Display Switching function 

Digital I/Os I/O 1 use, information 

 

I/O 2 use, information 

I/O 3 use, information 

I/O 4 use, information 

I/O 5 use, information 

I/O 6 use, information 

I/O 7 use, information 

I/O 8 use, information 
  

Switching functions: 

 configure the selected object 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > [Device Information] > Tab [Trigger Dependencies] 
22240 

 

Displays the dependencies of the available triggers as well as their dependence on the configured 
objects. 

Section Dialogue element Display Switching function 

Trigger dependencies Name name of the trigger 

 

Type parameter type 

Use use of the parameters 

Source name of the object 
  

Switching functions: 

 configure the selected object 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > [Device Information] > Tab [Object Dependencies] 
22242 

 

Displays the dependencies of the available objects as well as their dependence on the configured 
triggers. 

Section Dialogue element Display Switching function 

Object dependencies Name name of the object 

 

Type parameter type 

Use use of the parameters 

Source name of the trigger 
  

Switching functions: 

 configure the selected object 

 

>  

VSE > ... > Detail [Common Configuration] > [Assigned Devices] 
22244 

Several devices can share one parameter set. This means that you only need to maintain one 
parameter set if you have several identical machines and installations. A changed parameter set can 
be written to several devices at the same time. 

The element [Assigned Devices] contains the following sections: 
 

>  

VSE > ... > [Assigned Devices] > Tab [Devices] 
22245 

Displays all devices assigned to the parameter set. 

Section Dialogue element Display Switching function 

Assigned devices No. consecutive number in the list 

--- 

Name configured name of the device 

Type article number of the device 

Firmware read firmware version 

TCP/IP address configured TCP/IP address and port 

MAC address read MAC address of the device 

Serial n. read serial number of the device 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

8.2.2 VSE > [Parameter_#] > Detail [Inputs] 

 

VSE > ... > Detail [Inputs] > [Dynamic Inputs (AC)] ................................................................................74 
VSE > ... > Detail [Inputs] > [Analogue Inputs (DC)] ..............................................................................79 
VSE > ... > Detail [Inputs] > [External Inputs] .........................................................................................84 

22246 

In addition to the analogue and sensor inputs, the element [Inputs] also contains the virtual inputs 
(external inputs) that use the Ethernet interface as a signal source. The sensor inputs are referred to 
as [Dynamic Inputs], because they allow analysis of the dynamic component (AC) of the signal in the 
time and frequency domain. 
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The detailed view contains the following information about the parameter set: 

Section Dialogue element Display Switching function 

Dynamic inputs (AC) ID lconsecutive number of the sensor 
on the diagnostic electronics 

--- 

Name configured name of the sensor 

Type sensor type 

Scaling configured scaling of the sensor 

Filter configured filter setting of the sensor 

Analogue inputs (DC) ID consecutive number of the analogue 
input on the diagnostic electronics 

--- 

Name configured name of the input 

Type signal type of the sensor 

Reference signal value range 

Value value range of the signals 

External inputs ID consecutive number of the external 
input on the diagnostic electronics 

--- Name configured name of the input 

Initial value Initialisation value 

Unit configured unit 
  

► This view shows only an overview. 
To configure the parameters: double-click in the desired line! 
(→ following pages) 

 

>  

VSE > ... > Detail [Inputs] > [Dynamic Inputs (AC)] 
22248 

The dynamic inputs of the diagnostic electronics are used to monitor connected signals with regard to 
their dynamic components in the time and frequency domain. A common example for the evaluation of 
a dynamic signal on the diagnostic electronics is vibration monitoring. 

From hardware version "AI" (version "V0.6.0") in combination with firmware version 0.10.x, the 
dynamic inputs also allow monitoring of the signal exclusively with regard to the DC component. 

The different sensor types differ in the following aspects: 
 • monitoring of dynamic (AC) signals 
 • monitoring of static (DC) signals 
 • measuring principle. 

The overview shows the following information and functions: 

Section Dialogue element Display Switching function 

--- ID consecutive number of the sensor 
on the diagnostic electronics 

, ,  

 

Name configured name of the sensor 

Type sensor type 

Scaling configured scaling of the sensors 

Filter configured filter setting of the sensor 
  

Switching functions: 

 activate dynamic input 

 deactivate dynamic input 

 configure the selected object 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Inputs] > [Dynamic Inputs (AC)] > [Sensor #] 

 

VSE > ... > [Dynamic Inputs (AC)] > [Sensor #] > Tab [Configuration] ..................................................76 
VSE > ... > [Dynamic Inputs (AC)] > [Sensor #] > Tab [Self-test]...........................................................78 

22251 

Up to 4 dynamic inputs can be defined. Each dynamic input that has been defined appears as a 
separate element in the tree view with the default name [Sensor #]. 

 

  

  Before a dynamic input can be used it must be activated. 

► Dynamic inputs are activated with the [ ] button. 

  

The element [Sensor #] contains the following sections: 
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>  

VSE > ... > [Dynamic Inputs (AC)] > [Sensor #] > Tab [Configuration] 
22255 

  

Section Dialogue element Display Switching function 

Identification Name configured name for the sensor --- 

Type sensor type selected from list selection list 
  

The display in the configuration section depends on the selected sensor type. 
Please refer to the data sheet for the scaling and the unit of the sensor.  

Type Note Scaling / Sensitivity Unit 

VSA001/2/4/5/6 fixed specification 25 g 

VSA003 fixed specification 17,5 g 

VSA101 fixed specification 3,3 g 

VSA201 fixed specification 250 g 

VSP01A/VSP02A/VSP001 --- 100 mV/g 

IEPE 
up to hardware version "AI" of the diagnostic 
electronics only permitted as "Sensor 1" 

freely selectable 
mV/g  
V/g  
mV/(m/s²) 

IEPEx10 
from hardware version "AI" of the diagnostic 
electronics no longer supported 

freely selectable 
mV/g  
V/g  
mV/(m/s²) 

DC current signal 

• supported from hardware version "AI" of the 
diagnostic electronics and firmware 
version 0.10.0 
• specification: Filter =  unfiltered 

freely selectable freely selectable 

AC current signal --- 
freely selectablei 
according to formula 

freely selectable 

  

The filter is especially noteworthy for monitoring in the time domain according to ISO 10816 (= object 
type "v-RMS (time domain)").  

For these objects, the filter needs to be configured based on the rotational speed: 

Rotational speed Filter Note 

120...600 min-1 2 Hz highpass --- 

> 600 min-1 10 Hz highpass supported from hardware version "AI" of the diagnostic electronics 
and firmware version 0.6.0 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

If sensor type = DC current signal 
22584 

  

Section Dialogue element Display Switching function 

Configuration Filter unfiltered --- 

  Unit rpm free text 

  Scaling according to data sheet / formula increase / reduce value 

  Offset according to data sheet / formula increase / reduce value 

Lower reference point Current 4.00 mA --- 

  Value 0.00 rpm increase / reduce value 

Upper reference point Current 20.00 mA --- 

  Value 10000.00 rpm increase / reduce value 
  

Formula for scaling: 

 

Legend: 
vmin  
vmax  
imin  
imax  

 
smallest measured value 
largest measured value 
smallest current signal 
largest current signal 

  

Formula for offset: 

 

Legend: 
vmin  
vmax  
imin  
imax  

 
smallest measured value 
largest measured value 
smallest current signal 
largest current signal 

 

>  

Example scaling + offset 
23819 

External temperature sensor with the following values: 
 • current signal of 4…20 mA  
 • measuring range of -20...100  °C  
The scaling and offset to be entered are calculated as follows: 

Scaling = 

 

Offset = 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

If sensor type = other sensor (AC current signal) 
22585 

  

Section Dialogue element Display Switching function 

Configuration Filter • unfiltered 
• highpass 2 Hz 
• highpass 10 Hz 

selection list 

  Unit   free text 

  Scaling according to formula 

→ sensor type DC current signal 

increase / reduce value 

 

>  

Example scaling 
22586 

External sensor with the following values: 
 • current signal of 4…20 mA  
 • measuring range 0…2.5 bar  
Using a resistance (250 Ω) connected in parallel you will receive an input current for the dynamic input 
of the diagnostic electronics of 2...10 mA. 
The scaling to be entered is calculated as follows: 

Scaling = 

 
 

>  

VSE > ... > [Dynamic Inputs (AC)] > [Sensor #] > Tab [Self-test] 
22258 

For sensors of type VSAnnn a periodic self-test can be activated. The function of the measuring cell is 
actively tested by the diagnostic electronics. An interval can be defined (1 minute minimum) at which 
the diagnostic electronics is to carry out the test automatically. 
  

  The interval is always valid for all sensors. 
The interval cannot be set separately for each sensor. 

  

Define the self-test for VSP and IEPE sensors: possible from firmware version 0.11.0. 
These sensors do not allow active testing of the measuring cells. It is only verified that the wiring is 
intact (detect wire-break). 

A negative self-test is indicated by a flashing LED of the corresponding sensor on the housing of the 
diagnostic electronics. In addition, the result can be provided as an alarm and signalled at an output. 

Section Dialogue element Display Switching function 

Periodic self-test Time interval 0 h   0 min increase / reduce value 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Inputs] > [Analogue Inputs (DC)] 
22259 

The analogue inputs of the diagnostic electronics are used to read and monitor process values. The 
two analogue inputs can be used as triggers for monitoring, as a source for counters, or the analogue 
value can be monitored. The signal that is present at the analogue input can be a current or a pulse 
signal. In the case of VSE100 it can also be a voltage signal. 

The analogue inputs are distinguished by their signals (analogue or pulse) and use (triggers, counters 
or objects). 

Up to 2 analogue inputs can be defined. Each analogue input that has been defined appears as a 
separate element in the tree view with the default name [IN #]: 

Section Dialogue element Display Switching function 

--- ID consecutive number of the input on 
the diagnostic electronics 

, ,  

 

Name configured name of the input 

Type signal type of the input 

Reference signal value range according to 
input type 

Value value range of the signal according 
to input type 

  

Switching functions: 

 activate selected analogue input 

 deactivate selected analogue input 

 configure the selected object 
 



 

 

80 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Inputs] > [Analogue Inputs (DC)] > [IN #] 
22260 

 

  

  Before an analogue input can be used it must be activated. 

► Analogue inputs are activated with the [ ] button. 

  

The element [IN #] contains the following sections: 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > [Analogue outputs (DC)] > [IN #] > Section [Identification] 
22587 

  

Section Dialogue element Display Switching function 

Identification Name configured name for the input --- 

Type input type from the list (→ below) selection list 
  

The section [Identification] of the analogue inputs serves to describe the sensor connected to the 
diagnostic electronics. The name should clearly identify the sensor. Typically, this would be a name 
that describes the signal (e.g. motor speed). The type is used to select the signal type (→ analogue 
input types) of the connected sensor.  

Depending on the type that is selected, further information needs to be entered in the section 
[Configuration]. The display in the section [Configuration] depends on the selected input type. 

Default settings: 

Input type Reference Value 

Analogue - Current 4...20 mA 0...10000 rpm 

Analogue - Voltage  
(visible only for VSE100) 

0...10 V 0...10000 rpm 

Counter - Totaliser 1 min, 0 s --- 

Digital - Pulse 1 pulse / revolution rpm 

Digital - PWM 10...90 % 0...10000 rpm 

Digital - VE113A 10...90 % 0...100 % Rot 

Digital - Level --- 0 rpm / 10000 rpm 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > [Analogue Inputs (DC)] > [IN #] > Section [Configuration] 
22262 

The section [Configuration] contains the scaling and engineering unit of the signal. 

For the engineering unit the following applies: 

► See in the data sheet of the connected sensor 
Or: 
Identify the signal, e.g. "min-1" for rotational speed. 

The other parameters scale the signal. 

The displayed parameters and data depend on ... 
 • the configured input type 
 • the configured unit 

Section Dialogue element Display Switching function 

Unit Unit configured unit, e.g. rpm free text 

Lower reference point Current 4.00 mA increase / reduce value 

Voltage 0.00 V increase / reduce value 

PWM 10 % increase / reduce value 

Value 0.00 rpm increase / reduce value 

Upper reference point Current 20.00 mA increase / reduce value 

Voltage 10.00 V increase / reduce value 

PWM 90 % increase / reduce value 

Value 10000.00 rpm increase / reduce value 

Interval Counting interval 1 min 0 s 0 ms increase / reduce value 

Pulses Pulses per revolution 1 increase / reduce value 

Low level Low level 0.00 rpm increase / reduce value 

High levell High levell 10000.00 rpm increase / reduce value 
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Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

Configured input types 
22588 

 Analogue - Current 
Analogue - Voltage 
Digital - PWM 
Digital - VE113A: 
With these types the signal is set up using 2 reference points. If required, the resulting straight line 
can be extrapolated to the maximum measuring range of the analogue input. 

 x1 x2

Value (x1)

Value (x2)

U
n

it

Analogue input

Analogue in
put s

ignal

 

 Counter - Totaliser 
The interval must only be indicated here if used for monitoring of pulses per time interval. 
If used for pulse counting, the interval is not relevant.  

 Digital - Pulse: 
For this type, the number of pulses the signal delivers per revolution must be indicated. 

  

  If a rotational speed signal of more than one pulse per revolution is provided: 
The pulses must be equidistant to each other to determine the correct rotational speed! 

  

 Digital - Level: 
If this type is selected, values are assigned to the 2 digital states (low/OFF and high/ON). The 
value corresponding to the input state is processed further in the trigger or object (lower/upper 
limit monitor). 

  



 

 

84 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

VSE > ... > Detail [Inputs] > [External Inputs] 
22264 

External inputs are a virtual extension of the analogue inputs. The value for the external input is 
transmitted digitally via the TCP/IP interface of the diagnostic electronics. This can for example be 
done via the OPC interface (→ ifm OPC server, → chapter Variant switching via OPC (→ p. 113)).  

This allows transmission of process values when they are monitored and stored as objects. External 
inputs can also be used as a source for a trigger, e.g. to provide rotational speeds for 
frequency-selective monitoring in case of a speed-variable operation. 

Each external input that has been created appears as a separate element in the detailed view and in 
the tree view with the default name [External_#]. 

 

► Create an external input: 
In the tree in the detailed view, select [External Inputs] 
Right-click in the empty white area in the detailed view 
Click on [New External Input ...] 

> In the detailed view a new line appears with the preset values. 

Section Dialogue element Display Switching function 

External inputs 
ID 01 

can be assigned to any free ID 
(01...24) 

Name Extern_# 
# changes according to the 
assigned ID 

Initial value 0 rpm 

 
Unit rpm 

  

Switching functions: 

 configure the selected object 

 delete the selected object 
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VSE > ... > [External inputs] > [External_#] > [Configuration] 
22267 

 

The object [External_#] contains the following sections: 

Section Dialogue element Display Switching function 

Identification Name Extern_# --- 
  

Change name: 
► Mark the entry in the tree in the detailed view (via double-click or [F2]) 
► Overwrite the name 
  

Section Dialogue element Display Switching function 

Configuration Unit rpm free text 

Initial value 0.00 rpm increase / reduce value 
  

The unit of the external input corresponds to the unit of the variable sent via the interface (e.g. "min-1") 
if the external input is used as a source for the rotational speed. 

The initial value is used as long as the initial value is not changed via the interface after initialisation 
(reboot) of the diagnostic electronics. 
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8.2.3 VSE > [Parameter_#] > Detail [Trigger] 

 

Trigger types ...........................................................................................................................................87 
Create a trigger .......................................................................................................................................88 
VSE > ... > Detail [Triggers] > [Configuration] ........................................................................................88 

22269 

The triggers are used to control, i.e. start and stop object calculations and counters. Each object can 
have up to 2 different triggers assigned to it. The condition defined in a trigger controls the calculation / 
the counter.  

 

  

Section Dialogue element Display Switching function 

Trigger 
ID 01 

can be assigned to any free ID 
(01...24) 

Name selected trigger type *) 

 

Source according to trigger type 

Type trigger type 

Range / value 
configured trigger range or trigger 
value 

  

*) The name should be informative and indicate the source and the working range.  
     Examples: "CON_1480 rpm" or "Motorspeed_600...1500 rpm" 
  

Switching functions: 

 configure the selected object 

 delete the selected object 
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>  

Trigger types 
22589 

The trigger types differ in their source. The following trigger types are available: 
 

>  

Analogue input trigger 
22590 

 Prerequisite: 
at least one analogue input must be defined 

 Source: 
one of the two analogue inputs of the diagnostic electronics 

 Use of the trigger condition: 
 • frequency-selective monitoring in case of a speed-variable operation  
   (as a rotational speed signal) 
 • runtime counter, analogue 
 • as a reference value 

 

>  

Dynamic input trigger 
22592 

 Prerequisite: 

the type of at least one dynamic input must be defined as type "direct current" ( ) 

 Source: 
one of the dynamic inputs configured as analogue inputs (DC) 

 Use of the trigger condition: 
 • frequency-selective monitoring in case of a speed-variable operation  
   (as a rotational speed signal) 
 • runtime counter, analogue 
 • as a reference value 

 

>  

External input trigger 
22593 

 Prerequisite: 
at least one external input must be defined  

 Source: 
one of the configured external inputs 

 Use of the trigger condition: 
 • frequency-selective monitoring in case of a speed-variable operation  
   (as a rotational speed signal) 
 • runtime counter, analogue 
 • as a reference value 

 

>  

Constant speed trigger 
22594 

 Value of the trigger:  
corresponds to the constant rotational speed of the machine/installation 

 Use of the trigger condition: 
 • frequency-selective monitoring 
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>  

Create a trigger 
22591 

► In the detailed view, mark [Trigger]  
Right-click in the empty, white area of the detailed view 
Click on the desired trigger 

> In the detailed view a new line appears with the preset values. 
 

>  

VSE > ... > Detail [Triggers] > [Configuration] 
22271 

Description using the example "Analogue input trigger" 

 

The configuration element for [Analogue input trigger] contains the following sections: 
 

>  

VSE > ... > Detail [Triggers] > [Configuration]  > Section [Identification] 
22273 

The section [Identification] contains the name and the type of the trigger. 

Section Dialogue element Display Switching function 

Identification Name: analogue free text 

Type: selected trigger type --- 
  

The name can be changed. It is advisable to use a name which clearly identifies the trigger (e.g. 
"motor speed 600...1500 rpm"). 
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>  

VSE > ... > Detail [Triggers] > [Configuration]  > Section [Configuration] 
22274 

The section [Configuration] contains the source, use and condition of the trigger.  

The checkbox [Use as rotational speed signal] defines the operating principle of the trigger: 
 • activated = trigger as rotational speed signal for an object for frequency-selective monitoring 
 • deactivated = as trigger of the reference value 

If used to control a counter "Runtime - analogue" the checkbox is of no importance. 

A constant speed trigger cannot be used as a reference value but only for frequency-selective 
monitoring. 

For triggers of external or analogue inputs, a "working range" is defined in the trigger condition. If the 
measurement value of the selected source is within the working range, the condition is met. To ensure 
good repeatability of the measurements, it is advisable to define a small working range. For constant 
speed triggers, the constant rotational speed of the machine must be entered. 

Section Dialogue element Display Switching function 

Signal Source: selected selectable from list 

Use as rotational 
speed signal 

checkbox activate / deactivate 

Working range From: configured lower value 
(e.g. rotational speed) 

increase / reduce value 

To: configured upper value 
(e.g. rotational speed) 

increase / reduce value 

Constant speed Rotational speed:: configured rotational speed increase / reduce value 
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8.2.4 VSE > [Parameter_#] > Detail [Objects] 

 

VSE > ... > Detail [Objects] > Object types ............................................................................................92 
VSE > ... > Detail [Objects] > Object types > Tabs ................................................................................97 

22279 

Objects are used to calculate and monitor characteristic values. The characteristic values can be 
calculated for the signals of the inputs (dynamic, analogue and/or external inputs). Predefined object 
types are offered to facilitate the configuration of monitoring tasks for the corresponding machine. 

► Create an object: right-click into the empty white area of the detailed view, then continue via the 
context menu: 

  

Or 

► Use one of the buttons to create an object. 
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Switching functions: 

 edit the selected object via the wizard 

 create a new object via the wizard (object type = any, but no rolling element bearing) 

 create a new object via the wizard (object type = rolling element bearing) 

 configure the selected object 

 delete the selected object 
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VSE > ... > Detail [Objects] > Object types 

 

VSE > ... > Object types > [Unbalance] ..................................................................................................92 
VSE > ... > Object types > [Bearing].......................................................................................................93 
VSE > ... > Object types > [a-RMS], [v-RMS], [d-RMS] (frequency range) ............................................93 
VSE > ... > Object types > [Others] ........................................................................................................94 
VSE > ... > Object types > [a-RMS], [v-RMS] (time domain) .................................................................95 
VSE > ... > Object types > [a-Peak (time domain)] ................................................................................96 
VSE > ... > Object types > [Upper Limit Monitor], [Lower Limit Monitor] ................................................96 

22285 

Preconfigured object types for the most frequent monitoring tasks are offered which can be 
parameterised using a wizard: 
 • Unbalance 
 • Rolling element bearing 
 • a-RMS (frequency range) 
 • v-RMS (frequency range) 
 • d-RMS (frequency range) 
 • Others 
 • a-RMS (time domain) 
 • v-RMS (time domain) 
 • a-Peak (time domain) 
 • Upper limit monitor 
 • Lower limit monitor 

RMS = root mean square 
 

>  

VSE > ... > Object types > [Unbalance] 
22286 

  

  Unbalance occurs on all rotating shafts. It results from unevenly distributed mass around the 
shaft. An increased unbalance affects the bearings of the shaft and leads to wear. 

  

[Unbalance] monitors the rotational frequency of the machine 

The frequency-selective monitoring filters out noise signals caused by auxiliary equipment, support or 
feed movements. To calculate the unbalance, the rotational speed of the shaft must be configured as 
a trigger. 

Applications: 
 • Fans 
 • Motors 
 • Spindles (especially during acceleration), etc. 
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>  

VSE > ... > Object types > [Bearing] 
22287 

  

  Rolling element bearings are an important part in machines of any type. In case of progressing 
wear, individual damage frequencies result for each rolling element bearing. The damage 
frequencies of a rolling element bearing depend on the bearing geometry (defined via bearing 
type and manufacturer) and are unique for each bearing. 

  

[Bearing] monitors the damage frequencies of a rolling element bearing 

 

Legend: 

1 = inner race 

2 = cage 

3 = seal 

4 = rolling element 

5 = outer race 

D = pitch circle diameter 

d = rolling element diameter 

  

► Select damage frequencies from the integrated rolling element bearing database 

Or: 

► Request damage frequencies from the manufacturer and enter them manually 

Or: 

► Calculate the damage frequencies by means of the geometry using the rolling element bearing 
calculator and enter them manually 

The damage frequencies must always be calculated and entered as a frequency factor for a shaft 
speed of 1 Hz or 60 min-1. The actual calculation of the damage frequency is done by multiplying the 
frequency factor by the rotational frequency of the shaft determined by the trigger (= rotational speed / 
60). 
 

>  

VSE > ... > Object types > [a-RMS], [v-RMS], [d-RMS] (frequency range) 
22289 

RMS = root mean square 

 • a-RMS (frequency range) calculates the RMS of the acceleration, 
 • v-RMS (frequency range) calculates the RMS of the vibration velocity 
 • d-RMS (frequency range) calculates the RMS of the vibration displacement 
in a user-defined frequency band. 

Applications: 
 • Measurements to ISO10816 and other applicable standards 
 • Loose machine parts 
 • Alignment errors 
 • Motor faults (problems on rotor bars and stator laminations, eccentricity, etc.) 
   

  These object types are calculated in the frequency range and, thus, in sequence in the multiplex 
mode. This may result in a "dead time" during monitoring. 
For permanent monitoring select the object type "v-RMS (time domain)"! 
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>  

VSE > ... > Object types > [Others] 
22290 

  

  There is multitude of machine components which were examined for their specific vibration in 
case of damage. The damage frequencies resulting from the examinations can be configured in 
an object optimised for this task. 

  

frequency-selective monitoring 
object can be freely configured 

In the object the damage frequencies are specified as frequency factor. The actual calculation of the 
damage frequency is done by multiplying the frequency factor by the rotational frequency of the shaft 
determined by the trigger (= rotational speed / 60). 

Applications: 

 

soft foot 
loose fitting 

FFT: 1.0 • fn, 2.0 • fn, 3.0 • fn  

 

meshing, discrete tooth fault 
meshing, too high transverse forces 

FFT and H-FFT: 1.0 • fn  
FFT: number of teeth • fn  

 

slide bearing, unstable lubricating film 
slide bearing, wear 

FFT: 0.42...0.48 • fn  
FFT: 1.0 • fn, 2.0 • fn, 3.0 • fn  

 

pump, eccentric pump impeller 
pump, cavitation 

FFT: number of blades • fn  
FFT: 1.0 • fn, 2.0...n • fn  

 

coupling, misalignment FFT: 2.0 • fn  

  

Legend:  fn = rotational frequency (= rotational speed / 60) of the shaft 
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>  

VSE > ... > Object types > [a-RMS], [v-RMS] (time domain) 
22296 

RMS = root mean square 

 • a-RMS (time domain) monitors the RMS of the acceleration, 
 • v-RMS (time domain) monitors the RMS of the vibration velocity 
in a frequency range adjustable via filters.  

The frequency range is defined via the filter of the dynamic input ( →tab [Configuration]) and the filter 
of the object. 

dt  

Legend:  dt = measurement time, measurement period 

Applications: 
 • Measurements to ISO 10816 and other applicable standards (v-RMS) 
 • Loose machine parts (v-RMS) 
 • Alignment errors (v-RMS) 
 • Chatter vibrations, resonances (a-RMS) 
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>  

VSE > ... > Object types > [a-Peak (time domain)] 
22298 

  

  The filtering of the time signal is done by means of the filter for the dynamic input (→ tab 
[Configuration]) and the object. For most applications, however, only the filter of the object is 
decisive. 

  

[a-peak (time domain)] measures the maximum amplitude on a dynamic input within the set 
measurement time 

Different applications are possible thanks to signal filtering. Due to the very short measurement time 
(adjustable between 0.64 and 1.3 s), this object type is especially suited for machine protection (e.g. in 
crash situations). 

 
dt

 

Legend:  dt = measurement time, measurement period 

Applications: 
 • Spindle crash on machine tools (lowpass)  
 • Cavitation of a pump (highpass) 
 • Metal-on-metal friction, e.g. bearing damage (highpass) 
 

>  

VSE > ... > Object types > [Upper Limit Monitor], [Lower Limit Monitor] 
22300 

[Upper Limit Monitor], [Lower Limit Monitor] monitor analogue signals (DC signals) 

The signal source can be either an analogue or external input. 
  

  From hardware version "AI" (version "V0.6.0") in combination with firmware version 10.x, it is also 
possible to monitor an analogue value at one of the dynamic inputs. 
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>  

VSE > ... > Detail [Objects] > Object types > Tabs 

 

VSE > ... > Detail [Objects] > ... > Tab [Configuration] ...........................................................................97 
VSE > ... > Detail [Objects] > ... > Tab [Subobjects] ..............................................................................98 
VSE > ... > Detail [Objects] > ... > Tab [Frequency Window] .................................................................98 
VSE > ... > Detail [Objects] > ... > Tab [Processing] (frequency range) .................................................99 
VSE > ... > Detail [Objects] > ... > Tab [Processing] (time domain) .....................................................101 
VSE > ... > Detail [Objects] > ... > Tab [Trigger] ...................................................................................102 
VSE > ... > Detail [Objects] > ... > Tab [Limits] .....................................................................................103 
VSE > ... > Detail [Objects] > ... > Tab [Averaging] ..............................................................................104 

22301 

A created object features the following tabs and sections: 
  

  Depending on the type of object, some of the following sections are not visible or greyed out.  

Show the sections greyed out with [ ] (Extended settings). 
 

 
>  

VSE > ... > Detail [Objects] > ... > Tab [Configuration] 
22303 

► In the section [Configuration] select the input for calculating the characteristic value to be 
monitored in the object. 

Section Dialogue element Display Switching function 

Identification 
Name 

preset name 
according to input and object type 

free text 

Type selected object type --- 

Configuration Input configured input selectable from list 

Assigned object Assigned object assigned time domain object selectable from list 
  

Switching functions: 

 show / edit the extended settings in an own window 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Subobjects] 
22304 

belongs to the following objects: 
 • Unbalance 
 • Rolling element bearing 
 • Others 

Subobjects indicate the damage frequencies for frequency-selective monitoring. The damage 
frequency is calculated by multiplying the frequency factor indicated in the subobject by the rotational 
frequency defined by the speed trigger: 

damage frequency [Hz] = frequency factor × (rotational speed [min-1]) / 60 

For monitoring, the measured amplitudes of all subobjects are added up to an object value. 

The frequency window is a tolerance range that compensates for any inaccuracies in the 
determination of the rotational speed or the bearing type. 
Indication of the frequency window: either in per cent of the damage frequency or as an absolute value 
in hertz. 
For the highest possible diagnostic quality: set the frequency window as small as possible!  

Section Dialogue element Display Switching function 

Subobjects 
Name 

inner race, outer race, rolling 
element 

, ,  

,  
Frequency factor configured value 

Frequency window configured value 

Evaluation Peak monitors the maximum peak activate / deactivate 

RMS 
calculates the effective value within 
the indicated frequency range 

activate / deactivate 

  

Switching functions: 

 scan the bearing database 

 show / edit the extended settings in an own window 

 edit the selected suboject 

 add new subobject 

 delete selected subobject 
 

>  

VSE > ... > Detail [Objects] > ... > Tab [Frequency Window] 
22309 

belongs to the following objects: 
 • v-RMS (frequency) 

The tab [Frequency Window] appears in the position of the tab [Subobjects] 

The frequency window describes a monitoring range of the frequency. 
Indication of the frequency window: as an absolute value in hertz 

Section Dialogue element Display Switching function 

Monitoring range From configured value [Hz] increase / reduce value 

To configured value [Hz] increase / reduce value 
  

Switching functions: 

 show / edit the extended settings in an own window 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Processing] (frequency range) 
22310 

belongs to the following objects: 
 • Unbalance 
 • Rolling element bearing 
 • Others 
 • a-RMS (frequency range) 
 • v-RMS (frequency range)  
 • d-RMS (frequency range) 
  

Section Dialogue element Display Switching function 

Analysis method FFT / HFFT method for the frequency analysis activate / deactivate 

Unit Acceleration value in [mg] activate / deactivate 

Vibration velocity value in [mm/s] activate / deactivate 

Vibration 
displacement 

value in [mm] activate / deactivate 

Filter Filter configured value selectable from list 

Resolution Resolution configured value selectable from list 
  

Switching functions: 

 show / edit the extended settings in an own window 
 

>  

Section [Analysis Method] 
22595 

The analysis method indicates in which frequency spectrum the monitoring will be carried out. You can 
choose between... 
 • FFT spectrum (Fast Fourier Transformation) 
 • enveloped spectrum (H-FFT). 
FFT is typically used for harmonic signals (e.g. unbalance) and H-FFT for periodic signals (e.g. rolling 
element bearings.) 

The object types unbalance a-, v- and d-RMS (frequency domain) always monitor the FFT spectrum, 
while the object type rolling element bearing always monitors the H-FFT spectrum. The analysis 
method cannot be changed in these cases. 
 

>  

Section [Unit] 
22596 

The unit determines how the signal is to be evaluated: 
 • as acceleration (a) in [mg], 
 • vibration velocity (v) in [mm/s] or  
 • vibration displacement (d) in [mm]. 

The vibration velocity, and even more the vibration displacement, are only useful units for low 
frequencies. 

For the method of analysis is "H-FFT" (as in the case of the object type rolling element bearing), the 
signal can only be evaluated as acceleration. 

For the types a-,v- and d-RMS (frequency domain), the unit is predetermined by the type. 
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>  

Section [Filter] 
22597 

A filter can be selected for the calculation of the H-FFT spectrum. The basic bandpass setting of 
450…5950 Hz can be used in most applications.  

For the monitoring of slow rotating rolling element bearings (< 120 min-1), a 5000 Hz highpass is 
preferable. 
  

  For gear diagnosis please ensure that the mesh frequency (number of teeth • rotational 
frequency) is not filtered out. 

 

>  

Section [Resolution]: 
22598 

The resolution is the distance between 2 calculated frequencies in the spectrum. It is indirectly 
proportional to the measurement time (measurement time = 1/resolution). The frequency resolution 
also serves to distinguish the damage frequency from any interfering frequencies. 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Processing] (time domain) 
22311 

belongs to the following objects: 
 • a-RMS (time domain) 
 • v-RMS (time domain)  
 • a-Peak (time domain) 
  

Section Dialogue element Display Switching function 

Filter Filter configured value selectable from list 

Input configured value --- 

Measurement time Input: configured value selectable from list 
  

Switching functions: 

 show / edit the extended settings in an own window 
 

>  

Section [Filter] 
22599 

In the time domain, filtering of the signal plays an important role. In addition to the filter selected in the 
object, the filter of the dynamic input which is also active (→ tab [Configuration]) is displayed. 

For objects of type [v-RMS (time domain)], 2 filter combinations according to ISO 10816 are common: 

 2 Hz dynamic input, 975 Hz lowpass in the object: 
machines/installations with a rotational speed between 120…600 min-1  

 10 Hz dynamic input, 975 Hz lowpass in the object: 
machines/installations with a rotational speed greater than 600 min-1  

For type [a-Peak (time domain)] objects, usually only the filter of the object is decisive: 

 no filter: general monitoring 

 975 Hz lowpass: crash monitoring 

 3750 Hz (or higher) highpass: 
metal-on-metal friction, rolling element bearings, cavitation of pumps,... 

>  

Section [Measurement Time] 
22600 

Define the measurement time in accordance with the desired response time. For monitoring without 
averaging and response delay, the measurement time corresponds, in the extreme case, to the alarm 
time in case of damage.  

In case of very short measurement periods (< 40.96 ms), ensure that the response time of the alarm 
output and the input is fast enough for the alarm evaluation (e.g. on a PLC). 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Trigger] 
22312 

   

Section Dialogue element Display Switching function 

Reference value Reference value checkbox activate / deactivate 

Trigger configured reference trigger selectable from list 

Monitoring independent of the state of the trigger activate / deactivate 

Rotational speed Trigger configured trigger selectable from list 

Switch off the rotational speed stability check activate / deactivate 

Transmission ratio Object speed configured value increase / reduce value 

Measured speed measured value --- 
 

Switching functions: 

 show / edit the extended settings in an own window 
 

>  

Section [Rotational Speed] 
22601 

With objects for frequency-selective monitoring, the rotational speed trigger is used to calculate the 
damage frequency. 

Only the following triggers can be used as a speed input: 
 • constant triggers 
 • triggers for which the checkbox [Use as rotational speed signal] is active (→ tab [Configuration]). 

If the speed fluctuates by more than 5% during the measurement of an object, then the measurement 
result is ignored. If there are considerable changes in speed, precise frequency-selective monitoring is 
not possible. If you still wish to use the measurement value, you can prevent it from being discarding 
via the checkbox [Deactivate speed stability check]. If there is a transmission ratio between the speed 
of the trigger and that of the object to be monitored, this must be indicated. 

In the case of objects that are used for monitoring of a frequency range (a-, v-, d-RMS (frequency 
domain)) and objects in the time domain, the speed trigger can only be used for monitoring control. 
Only if the value of the trigger is inside its working range will the monitoring be active. For these 
objects only triggers for which the checkbox [Use as rotational speed] is active (→ tab [Configuration]) 
can be used as speed triggers. 
 

>  

Section [Reference value] 
22602 

The reference value trigger controls the monitoring. It must be enabled via the checkbox [Reference 
value]. Only if the value of the trigger is inside its working range will the monitoring be active. 

Only the following triggers can be used as a speed input: 
 • triggers for which the checkbox [Use as rotational speed] is not active (→ tab [Configuration]). 

The checkbox [Monitoring independent of the trigger state] deactivates the monitoring control. The 
reference value is then purely informative and included in the history recordings or used for signal 
weighting. 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Limits] 
22313 

  

Section Dialogue element Display Switching function 

View • absolute 
• relative 

option field select option 

Base Line (teach value) Base line 
(teach value) 

configured value increase / reduce value 

Auto teach checkbox activate / deactivate 

Rotational speed configured value increase / reduce value 

Reference value configured value increase / reduce value 

Limits Damage alarm configured value increase / reduce value 

Warning alarm configured value increase / reduce value 
  

Switching functions: 

 show / edit the extended settings in an own window 
 

>  

Section [View] 
22603 

belongs to the following objects: 
 • Others 
 • All objects > [Extended settings]. 

The limits are decisive for the alarm function:  

 for view = absolute:  
the teach value is set to "1" 
the values for the 2 alarm thresholds (warning alarm, damage alarm) are absolute values in the 
engineering unit selected for the object 

 for view = relative:  
the limit values / alarm thresholds are a multiple of the teach value 

For all other object types the following applies: View = absolute 
 

>  

Section [Base Line] (teach value) 
22604 

belongs to the following objects: 
 • Others 
 • All objects > [Extended settings]. 

In case of a relative view, the base line (teach value) represents the value of the object in the "good" 
condition. The base line is the basis for a later output of a warning or damage alarm. 

Activate the checkbox [Auto teach] if the base line is to be determined through a manually started 
measurement by the diagnostic electronics. However, we recommend to configure the base line (teach 
value) only 3 weeks after setup of the diagnostic electronics based on the data that has been collected 
in the history memory. 

The speed and reference values are only relevant in case of signal weighting. The use of signal 
weightings should be avoided by means of small operating ranges of the triggers (→ tab 
[Configuration]), if possible. 
 

>  

Section [Limits] 
22605 

The limits are decisive for the alarm function. 

In the normal case (view = absolute) the following applies: the values for the 2 alarm thresholds 
(warning alarm, damage alarm) are absolute values in the engineering unit selected for the object 
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>  

VSE > ... > Detail [Objects] > ... > Tab [Averaging] 
22134 

  

Section Dialogue element Display Switching function 

Averaging Averaging configured value selectable from list 

Trigger becomes 
active 

checkbox activate / deactivate 

Variant Switching checkbox activate / deactivate 

Response delay Response delay configured value increase / reduce value 
  

Switching functions: 

 show / edit the extended settings in an own window 
 

>  

Section [Averaging] 
22606 

Short-time events in the measurement signal such as brief shocks can be suppressed by averaging 
the signal. The averaging is indicated as a weighting factor of the measurement value. 

For objects in the time domain or monitoring of frequency ranges (a-, v-, d-RMS (frequency domain)) 
we recommend to set the averaging value to 1/1 in order to monitor the actual value of the 
measurement. 

The checkboxes [Trigger becomes active] and [Variant Switching] determine how the averaging is to 
be continued in these cases. If one of the checkboxes is activated, the last object value is set to "0" for 
the calculation of the new value in order to start a new calculation. The option [Variant Switching] 
includes all system mode changes of the diagnostic electronics (write parameters, spectrum 
monitoring, self-test). 
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Example averaging 
22607 

Last object value = 3.8 mm/s, measurement value = 7.1 mm/s, averaging = 1/8 

The new object value is:  

Object value = last object value • (1-averaging) + measurement value • averaging  
Object value = 3.8 mm/s • (1-1/8) + 7.1 mm/s • 1/8  
Object value = 4.2 mm/s 

The following diagram shows how the object value approaches a constant measured value. The 
averaging value determines how fast the two values approach. 
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>  

Section [Response delay] 
22608 

The response delay ensures the reliability of the diagnostics by functioning like a counter. The alarm 
state only changes after the object value has exceeded or fallen below the limit x times (x = value of 
the response delay) in succession. The value of the response delay is indicated in measurement 
cycles of the object. The response delay thus has a great impact on the response time of the alarm. 

The following diagram shows the alarm state of the warning alarm at a response delay of 2: 
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For example, during crash monitoring of a spindle, the response delay must be set to "1" to obtain the 
fastest possible crash alarm. 
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>  

8.2.5 VSE > [Parameter_#] > Detail [Variants] 

 

VSE > [Parameter_#] > Detail [Variants] > Operating principle ...........................................................107 
VSE > ... > Detail [Variants] > Tab [Configuration] ...............................................................................108 
VSE > ... > Detail [Variants] > Tab [Activation] (only VSE100) ............................................................109 

22317 

You can use variants if you want to monitor certain objects only in defined machine states and where 
this cannot be solved via triggers. Under certain circumstances, this can considerably improve the 
diagnostic quality. 

An example of such an application is the monitoring of rolling element bearings on a machine tool. 
During the machining of the workpieces, different kinds of vibrations can occur in the machine, which 
can lead to a false diagnosis of a rolling element bearing.  

For this reason, a specific state on the machine should be defined (spindle position, spindle speed, 
tool) for the monitoring of rolling element bearings – the reference run. The reference run allows 
monitoring of the rolling element bearings at regular intervals.  

In this case, rolling element bearing monitoring would be an own variant differing from common 
monitoring during normal operation. 
 

>  

VSE > [Parameter_#] > Detail [Variants] > Operating principle 
22318 

The objects defined in the parameter set can be assigned to any desired number of variants. 
Switching of the active variant in the diagnostic electronics is then done as follows: 
 • manually, 
 • via the ifm OPC server (→ chapter Variant switching via OPC (→ p. 113)) or 
 • for VSE100 via the digital I/Os 
Only the objects active in the current variant are calculated and evaluated. 
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>  

VSE > ... > Detail [Variants] > Tab [Configuration] 
22319 

Objects are assigned to the variants. The objects can be freely activated/deactivated in the different 
variants.  

► Activate / deactivate all objects for variant #: mouse click on the variant # 

► Activate / deactivate an object for all variants: mouse click on the corresponding object 

The method of activation used can limit the number of possible variants (→ tab [Activation] or variant 
switching without the digital I/Os of the VSE100 diagnostic electronics). 
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>  

VSE > ... > Detail [Variants] > Tab [Activation] (only VSE100) 

 

Active variant determined by the state of one I/O ................................................................................109 
Active variant determined by the state of several I/Os (as a dual value) .............................................112 
Manual variant switching via the VES004 software .............................................................................112 
Variant switching via OPC ....................................................................................................................113 

22320 

  This applies only to VSE100: 

Here, only configure the method of activation of a variant if the activation is to be carried out via digital 
signals directly on the diagnostic electronics.  

If the activation of a variant is done manually or via the ifm OPC server (→ chapter Variant switching via 
OPC (→ p. 113)), no further configuration is necessary. 

If the activation of the variants is done via the digital I/Os of the diagnostic electronics, two different 
methods are available: 
 • active variant determined by the state of one I/O 
 • active variant determined by the state of several I/Os (as a dual value) 
  

Section Dialogue element Switching function 

Activation mode • Active variant determined by the state of one I/O 

select option   • Active variant determined by the state of several I/Os (as a 
dual value) 

Activation 
Digital I/O 

  IO # (not used) 
  IO # variant input 

checkbox 
activate / deactivate 

  High Variant # selectable from list 

  Low Variant # selectable from list 

  
ST Self test 

checkbox 
activate / deactivate 

 

>  

Active variant determined by the state of one I/O 
22321 

With this method of activation, a particular variant is assigned to a state of an I/O of the diagnostic 
electronics. When the I/O is in the defined state, the variant is active. 

If you want to switch between more than 2 variants, several I/Os are necessary. In this case the 
following applies: 

 The state "1 (High)" of the I/Os with the highest number determines the active variant. 

 If all I/Os are "0 (Low)", it is also the variant assigned to the I/O with the highest number that is 
active. 

Accordingly, with this method, a maximum of 9 different variants can be activated using the 8 I/Os of 
the VSE100. 
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>  

Example 1: 
22322 

Configuration for the activation of variants. 

Digital I/O High Low ST 

  I/O 1 Variant 1 Variant 0   

  I/O 2 Variant 2 ---   

  I/O 3 --- ---   

  I/O 4 --- ---   

  I/O 5 Variant 3 ---   

  I/O 6 (not used) --- ---   

  I/O 7 (not used) --- ---   

  I/O 8 (not used) --- ---   
  

In this example all of the 4 selected variants can be switched. The following table shows which I/O 
states will activate which variants. 

Active variant I/O 1 I/O 2 I/O 5 

Variant 0 0 (Low) 0 (Low) 0 (Low) 

Variant 1 1 (High) 0 (Low) 0 (Low) 

Variant 2 not relevant 1 (High) 0 (Low) 

Variant 3 not relevant not relevant 1 (High) 
  

 If all I/Os are "0 (Low)", then variant 0 will be active. No I/O with a higher number has a different 
variant selected for the state "0 (Low)". 

 If at least one I/O is "1 (High)", then the active variant will be determined by the I/O with the 
highest number. The state of the I/Os with a lower number is not relevant. 
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>  

Example 2: 
22323 

Configuration for the activation of variants: 

Digital I/O High Low ST 

  I/O 1 Variant 1 Variant 0   

  I/O 2 Variant 3 Variant 2   

  I/O 3 (not used) --- ---   

  I/O 4 (not used) --- ---   

  I/O 5 (not used)) --- ---   

  I/O 6 (not used) --- ---   

  I/O 7 (not used) --- ---   

  I/O 8 (not used) --- ---   
  

In this example only 3 of the selected variants can be switched. The following table shows which I/O 
states will activate which variants. 

Aktive Variante I/O 1 I/O 2 

Variant 0 cannot be activated 

Variant 1 1 (High) 0 (Low) 

Variant 2 0 (Low) 0 (Low) 

Variant 3 not relevant 1 (High) 
   

 If both I/Os are "0 (Low)", then the variant configured at the input with the higher number (in this 
case I/O 2) will be active. 

 If I/O 2 is "1 (High)", then the variant 3 configured for this case will be active irrespective of the 
state of I/O 1. 
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>  

Active variant determined by the state of several I/Os (as a dual value) 
22324 

With this method of variant activation, an I/O of the VSE100 diagnostic electronics is assigned to a 
certain value. The selectable values are predefined according to a binary coding. If the state of the I/O 
is "0 (OFF)", it will always have the value "0". If the state of the I/O is "1 (ON)", it will have a 
corresponding value assigned to it. The sum of all values determines the active variant. 
 

>  

Example 
22325 

  

Bit no. 2 1 0 Active variant 

Bit value 4 (=22) 2 (=21) 1 (=20)   

Used input I/O 4 I/O 3 I/O 1   

State of input 0 0 0 Variant 0 

State of input 0 0 1 Variant 1 

State of input 0 1 0 Variant 2 

State of input 0 1 1 Variant 3 

⁞ 

State of input 1 1 0 Variant 6 

State of input 1 1 1 Variant 7 
 

>  

Manual variant switching via the VES004 software 
22326 

Prerequisite: 
 • This requires a connection to the diagnostic electronics.  
 • The I/Os of the VSE100 must not be used for the change of variant. 

The current variant can be changed in the device settings of the diagnostic electronics under [Actions] 
in the tab [Variant Switching]. 

The assignment of objects to variants can be changed on the parameter page [Variants] > 
Tab [Configuration] as needed. By default, all objects are always active in all variants. 
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Variant switching via OPC 
22327 

Prerequisite: 

 The I/Os of the VSE100 must not be used for the change of variant. 

The current variant is an OPC item with write and read permission on the ifm OPC server.  
The path (item ID) for the current variant is:  

ifm.VSE.<NameOfDevice>.DeviceInformation.ActualVariant 

"NameOfDevice" corresponds to the name of the connection in the configurator of the ifm OPC server. 
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VSE > [Parameter_#] > Detail [Counter] > Overview ...........................................................................114 
VSE > ... > Detail [Counters] > Tab [Configuration] .............................................................................115 
VSE > ... > Detail [Counters] > Tab [Alarming] .....................................................................................116 
VSE > ... > Detail [Counters] > Tab [Reset]  (VSE100 only) ...............................................................116 
VSE > ... > Detail [Counters] > [Object state] .......................................................................................116 
VSE > ... > Detail [Counters] > [Runtime] .............................................................................................117 
VSE > ... > Detail [Counters] > [Totaliser] ............................................................................................117 

22328 

The octavis VSE unit has 32 internal counters (from firmware 0.6.x). Depending on the event to start 
the counter we differentiate the following counter types: 
 • Object state 
 • Runtime, analogue 
 • Runtime, digital (visible only for VSE100) 
 • Runtime VSE 
 • Totaliser 
 

>  

VSE > [Parameter_#] > Detail [Counter] > Overview 
22329 

The counters overview page shows the counters configured in the parameter set and their most 
important parameters. 

 

► Right-click into the white area of the detailed view to create a counter. 

Switching functions: 

 go to the configurati→ p. of the selected counter 

 delete the selected counter 
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>  

VSE > ... > Detail [Counters] > Tab [Configuration] 
22335 

 

Section [Identification]: 
 • The name of the counter object cannot be changed.  
 • The counter type results when the counter is created; it cannot be changed. 

Section [Configuration]: 
 • Indicate source or event to activate the counter. 
 • Depending on the selected counter type only the following sources are allowed: 

Counter type Object Event 

Object state any state that will initiate the counter 

Runtime, analogue trigger refers to an analogue or external input --- 

Runtime, digital  
(visible only for VSE100) 

an I/O which is still free state that will initiate the counter 

Runtime, VSE The counter starts automatically as soon as the diagnostic unit has been switched on. 

Totaliser an analogue input defined as [Counter – 
Totaliser] 

--- 

  

Section Dialogue element Display Switching function 

Identification Name name of the counter object --- 

  Type counter type --- 

Configuration Object assigned object selectable from list 

  State state of the object or the input selectable from list 

  I/O configured digital input selectable from list 

  Trigger trigger of the assigned object selectable from list 

  Source configured input selectable from list 
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>  

VSE > ... > Detail [Counters] > Tab [Alarming] 
22338 

 • Define a limit for the counter. 
 • Counters cannot be used directly in the creation of an alarm. 
 • Alarms are summarized in "alarm groups". 
 • The alarm group can be selected as a source later in the alarm configuration. 

Section Dialogue element Display Switching function 

Alarming 
Limit 

Either: 
• number of pulses or 
• duration in seconds 

increase / reduce value 

Alarm group configured alarm group selectable from list 
 

>  

VSE > ... > Detail [Counters] > Tab [Reset]  (VSE100 only) 
22339 

  This applies only to VSE100: 

Indicate the digital input I/O # that will reset the counter to the value "0". 
I/Os that are already used otherwise (variant switching, counter input) are not available for this (greyed 
out in the list). 

Section Dialogue element Display Switching function 

Reset the counter I/O 1 use of the input activate / deactivate 

  ... ... ... 

  I/O 8 use of the input activate / deactivate 
 

>  

VSE > ... > Detail [Counters] > [Object state] 
22340 

State counters count the length of time an object has been in a defined state. Any object can be 
chosen as a source. The selectable states are: 

 Active: An object can only be deactivated through the use of variants. 

 Valid: In the following cases, the measuring result of an object is invalid: 
 • when the object is inactive, 
 • when the speed fluctuation is too high 
 • when the speed or reference value is outside the working range 
 • when the base line (teach value) is invalid. 

 Warning alarm: An object is in the warning alarm mode if the measurement value, taking into 
account the response delay, exceeds the limit. 

 Damage alarm: An object is in the damage alarm mode if the measurement value, taking into 
account the response delay, exceeds the limit. 
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>  

VSE > ... > Detail [Counters] > [Runtime] 
22341 

A runtime counter (also: operating hours counter) measures the period during which an analogue or 
digital input (VSE100 only) is in a certain range or condition. Based on the source the following types 
of runtime counters are distinguished: 

 Analogue runtime counter: The counter is activated by a trigger that refers to an analogue or 
external input. If the value for the corresponding input is within the working range defined in the 
trigger, the time is counted. 

  

  From hardware version "AI" (version "V0.6.0") in combination with firmware version 0.10.x, it is 
also possible to monitor an analogue value at one of the dynamic inputs. 

  

 VSE runtime counter: The counter is activated by the voltage supply of the diagnostic electronics. 
If voltage is supplied to the diagnostic electronics, the time is counted. 

 Digital runtime counter (visible only for VSE100): The counter is activated by a digital input of 
VSE100. If the input is in the corresponding state, the time is counted. 

 

>  

VSE > ... > Detail [Counters] > [Totaliser] 
22342 

Totalisers count the pulses at an analogue input of the diagnostic electronics.  

Prerequisite: 
 • an analogue input is defined as [Counter – Totaliser] 
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>  

8.2.7 VSE > [Parameter_#] > Detail [History] 
22344 

The octavis diagnostic electronic VSE has an integrated history function with real-time clock. In the 
history memory the device records the following data: 
 • object values together with their triggers and limits 
 • the current counter values 
 • time stamps on the events 

The real-time clock is battery buffered. 

History memory: 

Device hardware version Version Firmware Number of memory values 

up to < AI 1.5 up to 0.7.x 30 000 

from AI 1.6 from 0.9.0 600 000 
 

>  

VSE > ... > Detail [History] > Real-time clock 
22345 

When disconnected, the real-time clock of the diagnostic electronics is battery buffered.  

The time must be set once during commissioning by resetting the device history. This aligns the time 
of the diagnostic electronics with the "Universal Time Coordinated" (UTC, formerly "Greenwich Mean 
Time" GMT) of the computer. The "Universal Time Coordinated" is determined from the time and time 
zone set in the operating system. 
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>  

VSE > ... > Detail [History] > Recording of the measured values 
22346 

The history memory is a ring memory (FIFO, "first in first out"). If the history memory is full, a small 
portion of the oldest values is deleted to free up memory space. 

The recording of the measured values is usually determined by an interval specified in the parameters.  

 At the end of the interval, the maximum measured value that occurred during the interval is 
recorded in the history memory together with the corresponding time stamp.  

 Depending on the selected options (see chapter "Parameters"), further measurements such as the 
trigger values or the mean value of the interval measurement are written to the history memory. 

 The selectable options depend on the firmware of the diagnostic electronics (see chapter 
"Parameters" The "additional values" are stored together with the time stamp of the highest value. 
The interval for the history memory can be determined individually for each object. 

Using the additional options, the measured values can also be recorded independently of the set 
interval of the object. A description for these options is available in the parameters of the history. 
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Diagram: History of the measured values (example) 
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>  

VSE > ... > Detail [History] > Parameters 
22347 

 

  

Detail [History]: 
Using the symbol at the top right in the detail window, you can activate/deactivate the entire history 
memory. If the history memory is active, the history settings can be made for the objects configured in 
the parameter set. 
  

Switching functions: 

 
Switch: the history memory is deactivated. 
Parameters cannot be configured. 

 
Switch: the history memory is activated. 
Parameters can be configured. 

  

Objects can also be activated/deactivated individually. If an object is active, the highest value 
measured within the set interval is recorded. 

Further values can be recorded individually for each object via additional checkboxes. If a setting is 
made for the diagnostic electronics or a sensor, then the set value will automatically be adopted for all 
subordinated objects. 
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Section Dialogue element Display / Switching function Description 

Object VSE... diagnostic unit   

Sensor configured sensor   

SE01_... configured object   

Interval 
-- 0 h : 01 min ... 1092 h : 15 min 

Measurement duration: 
the highest value measured during the 
interval is recorded 

Rot. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

Rotational speed: 
additionally records the value of the 
trigger for the rotational speed at the time 
of the highest measured value 

Ref. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

Reference value / reference: 
additionally records the value of the 
trigger for the reference value at the time 
of the highest measured value 

Av. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

Average value (from firmware 0.5.19): 
records the measurement values of the 
object (including the other selected 
options) when the mean value is 
changed without taking into account the 
interval. The interval is restarted after 
changing the mean value. 

Var. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

Variant switching (from firmware 0.5.19): 
records the measurement values of the 
object (including the other selected 
options) when the variant is changed 
without taking into account the interval. 
The interval is restarted after variant 
switching. 

Dmg 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

Damage alarm [Rot.] (from firmware 
0.7.11): 
records the measurement values of the 
object (including the other selected 
options) when the object is in the state 
"Damage alarm" (measurement value 
above upper limit value, response delay 
taken into account). Subsequently, the 
interval is restarted. 

Record options 

Maximum one entry per 
second 

  Option not activated 

  Option fully activated 

Protection of the history memory chip 
The options [Variant Switching] and 
[Damage Alarm] can generate history 
entries at very short intervals (well below 
1 second) that would eventually destroy 
the memory. 

Estimated recording 
time 

-- 
maximum time period that can 
be stored in the history 

Indication of the possible recording time 
for older and current firmware versions 
If [Variant switching] or/and [Damage 
Alarm] is activated in an object, only the 
maximum time is displayed. 
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>  

8.2.8 VSE > [Parameter_#] > Detail [Alarms] 

 

VSE > [Parameter_#] > Detail [Alarms] > Overview .............................................................................122 
VSE > ... > Detail [Alarms] > Alarm types ............................................................................................123 

22353 

Alarms can be set to signal limits (warning alarm and/or damage alarm) which are exceeded during 
monitoring of the objects or counters. 
 

>  

VSE > [Parameter_#] > Detail [Alarms] > Overview 
22354 

The alarms overview page shows the alarms configured in the parameter set and their most important 
parameters. 

 

► Right-click into the white area of the detailed view to create an alarm. 

Switching functions: 

 go to the configurati→ p. of the selected alarm 

 delete the selected alarm 
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>  

VSE > ... > Detail [Alarms] > Alarm types 
22356 

Alarms are distinguished based on the source and the signal. One analogue alarm and several digital 
alarms are available.  

The sources (objects, counters and self-test) can be combined as desired. 

Each alarm requires an own output of the diagnostic electronics. If all outputs are configured / used, 
no further alarm can be configured. 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Analogue] 

 

VSE > ... > Detail [Alarms] > [Analogue] > Tab [Configuration] ...........................................................125 
VSE > ... > Detail [Alarms] > [Analogue] > Tab [Source] .....................................................................125 
VSE > ... > Detail [Alarms] > [Analogue] > Tab [Self-test] ....................................................................125 

22357 

The "Analogue alarm" is used to convert a measured value into an analogue signal.  

The measured values of the objects serve as a source.If several objects are selected as source for the 
alarm, then 
 • the units of the measured values must match 
 • only the highest measured value is converted into the corresponding analogue value. 

Only the analogue output OUT1 serves as an output channel for the analogue alarm.The output signal 
may be as follows: 
 • 4...20 mA (all diagnostic units) 
 • 0...10 V (only VES100) 

► When selecting the values, differentiate between the different units of the objects: 
 • acceleration, 
 • vibration velocity, 
 • vibration displacement, 
 • unit(s) of the upper/lower limit monitor  
and the unitless damage level (relative to the base line (teach value) or limit value). 
The selected values have a direct effect on the objects which can be selected as an alarm source 
(→ tab [Source]). 

The value selection also determines which parameters must be used for scaling: 

 For values with a unit, the signal is defined by two points:  
4 mA = x and 20 mA = y (or: 0 V = x and 10 V = y), 
x and y are values in the selected unit. 

 If the damage level is to be signalled relative to the base line (teach value), the signal will also be 
scaled via the above-mentioned points. 
Difference: the values x and y are unitless. 

 If the damage level is to be signalled relative to the limit values, the signal must be scaled using 
three points: 
 • initial analogue 
 • analogue value for warning alarm 
 • analogue value for damage alarm 
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Procedure of the diagnostic electronics when calculating the analogue value: 

> For each object selected as a source, the theoretical current output is calculated according to the 
upper chart. 

> The maximum current of all objects is provided. 

> If an analogue current signal display is selected, the minimum current can be limited to 4 mA. 
Without this option, the scaling of the signal is extended to 0…20 mA linear. 

  

► In addition, the evaluation of the self-test result can be activated for the alarm. 
 

>  

VSE > ... > Detail [Alarms] > [Analogue] > Tab [Configuration] 
22359 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

  
Type 

configured type of the selected 
output 

-- 

  Output selected analogue output only OUT1 is permissible 

Configuration 

Signal 

configured signal: 
• current 4...20 mA 
• voltage 0...10 V 
   (visible only for VSE100) 

selectable from list 

  Values configured value type selectable from list 

Scaling 
Initial value 

configured start value at damage 
level = 0 

increase / reduce value 

  
Warning alarm 

the configured value is exceeded = 
warning alarm (yellow) 

increase / reduce value 

  
Damage alarm 

the configured value is exceeded = 
damage alarm (red) 

increase / reduce value 

  • minimum = 4 mA 
• minimum = 2 V 

checkbox  (depending from 
[Configuration] > [Signal]) 

activate / deactivate 

 

>  

VSE > ... > Detail [Alarms] > [Analogue] > Tab [Source] 
22360 

► Select the objects for visualisation in this alarm.  

Depending on the selected value type for signalling, not all objects can be selected. The units must 
match. 

Section Dialogue element Display Switching function 

Alarm source 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  

VSE > ... > Detail [Alarms] > [Analogue] > Tab [Self-test] 
22361 

In case of a failed self-test at the dynamic inputs, a defined current (either 2 mA or 22 mA) can be 
provided at the analogue output A value of 2 mA is only recommended if a minimum current of 4 mA 
has been specified in the configuration. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under [Dynamic inputs]. 

Section Dialogue element Display Switching function 

Self-test 
-- 

• force current of 2 mA 
• force current of 22 mA 

option field 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Warning alarm] 
22362 

The alarm type [Warning alarm] analyses all objects with regard to the lower limit value (warning 
alarm), taking into account the response delay. 

The analysis is based on a logical OR function, so when the measured value of any object is above 
the lower limit value and the condition of the response delay is met, then the alarm will also be active. 

► In addition, the evaluation of the self-test result can be activated for the alarm. 
 

>  

VSE > ... > [Prealarm] > Tab [Configuration] 
22363 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

Type 
configured type of the selected 
output 

-- 

Output selected digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Keep signal for a 
minimum of 150 ms 
*) 

checkbox activate / deactivate 

*) for firmware versions older than V0.11.6: min. 50  ms 
 

>  

VSE > ... > [Warning alarm] > Tab [Source] 
22364 

The objects for the visualisation in this alarm are predefined: 
The warning alarms of all configured objects are linked with OR 

Section Dialogue element Display Switching function 

Alarm source - objects 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  

VSE > ... > [Warning alarm] > Tab [Self-test] 
22365 

For failed self-tests of the dynamic inputs, a flashing output signal with a frequency of 1 Hz can be 
activated as an option. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under "Dynamic inputs". 

Section Dialogue element Display Switching function 

Self-test Switch output with a 
frequency of 1 Hz 

checkbox activate / deactivate 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Damage alarm] 
22366 

The alarm type [Damage alarm] analyses all objects with regard to the upper limit value (warning 
alarm), taking into account the response delay. 

The analysis is based on a logical OR function, so when the measured value of an object exceeds the 
upper limit value and the condition of the response delay is met, then the alarm will also be active. 

► In addition, the evaluation of the self-test result can be activated for the alarm. 
 

>  

VSE > ... > [Warning alarm] > Tab [Configuration] 
22370 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

Type 
configured type of the selected 
output 

-- 

Output selected digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Keep signal for a 
minimum of 150 ms *) 

checkbox activate / deactivate 

*) for firmware versions older than V0.11.6: min. 50  ms 
 

>  

VSE > ... > [Damage alarm] > Tab [Source] 
22371 

The objects for the visualisation in this alarm are predefined:the damage alarms of  
All configured objects are linked with OR 

Section Dialogue element Display Switching function 

Alarm source - objects 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  

VSE > ... > [Damage alarm] > Tab [Self-test] 
22372 

For failed self-tests of the dynamic inputs, a flashing output signal with a frequency of 1 Hz can be 
activated as an option. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under "Dynamic inputs". 

Section Dialogue element Display Switching function 

Self-test Switch output with a 
frequency of 1 Hz 

checkbox activate / deactivate 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Custom alarm] 
22373 

The alarm type [Custom alarm] allows you to combine the alarm states (warning alarm, damage 
alarm) of different sources (objects, counters, self-test) as desired (via AND and OR logics). 
 

>  

VSE > ... > [User defined] > Tab [Configuration] 
22374 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

Type 
configured type of the selected 
output 

-- 

Output selected digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Keep signal for a 
minimum of 150 ms *) 

checkbox activate / deactivate 

*) for firmware versions older than V0.11.6: min. 50  ms 
 

>  

VSE > ... > [Custom alarm] > Tab [Source] 
22375 

Select the objects and alarm groups for the visualisation in this alarm. 

Section Dialogue element Display Switching function 

Alarm source - objects 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  

VSE > ... > [Custom alarm] > Tab [Self-test] 
22376 

For failed self-tests of the dynamic inputs, a flashing output signal with a frequency of 1 Hz can be 
activated as an option. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under "Dynamic inputs". 

Section Dialogue element Display Switching function 

Self-test Switch output with a 
frequency of 1 Hz 

checkbox activate / deactivate 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Counter] 
22377 

A counter alarm allows you to select the different alarm groups (→ chapter VSE > ... > Detail [Counter] > 
Tab [Alarming] (→ p. 116)) of the counters as a source. The analysis of the selected groups is based on 
a logical OR function, so when a limit is exceeded in one of the selected groups, the alarm will be 
active. 

In addition, the evaluation of the self-test result can be activated for the alarm. 
 

>  

VSE > ... > [Counter] > Tab [Configuration] 
22378 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

Type 
configured type of the selected 
output 

-- 

Output selected digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Keep signal for a 
minimum of 150 ms *) 

checkbox activate / deactivate 

*) for firmware versions older than V0.11.6: min. 50  ms 
 

>  

VSE > ... > [Counter] > Tab [Source] 
22379 

The source of a counter alarm is a combination of different alarm groups of the counters  
→ chapter VSE > ... > Detail [Counter] > Tab [Alarming] (→ p. 116) 
The alarm is triggered if in at least one selected alarm group a counter assigned to this group exceeds 
its limit value. 

Section Dialogue element Display Switching function 

Alarm source Alarm group # checkbox activate / deactivate 
 

>  

VSE > ... > [Counter] > Tab [Self-test] 
22380 

For failed self-tests of the dynamic inputs, a flashing output signal with a frequency of 1 Hz can be 
activated as an option. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under [Dynamic Inputs]. 

Section Dialogue element Display Switching function 

Self-test Switch output with a 
frequency of 1 Hz 

checkbox activate / deactivate 
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>  

VSE > ... > Detail [Alarms] > Alarm types > [Self-test] 
22381 

The self-test alarm signals the self-test results. A self-test is only possible for type VSAxxx sensors 
and can be executed automatically in a fixed interval. If a sensor or cable is defective, the self-test will 
fail and the alarm will be active. 

The source of the self-test alarm is not defined in the alarm itself. 
The settings for the self-test are made under "Dynamic inputs". 

From firmware version 0.11.x it is possible to define a wire-break test for VSP and IEPE sensors 
(→ chapter [Device] menu > [Actions] (→ p. 38)). 
 

>  

VSE > ... > [Self-test] > Tab [Configuration] 
22383 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

-- 

Type 
configured type of the selected 
output 

-- 

Output selected digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Keep signal for a 
minimum of 150 ms *) 

checkbox activate / deactivate 

Option Switch output with a 
frequency of 1 Hz 

checkbox activate / deactivate 

*) for firmware versions older than V0.11.6: min. 50  ms 
 



 

 

131 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Configure VSEnnn VSE > Device [VSEnnn_#] > [Parameter_#] 

>  

8.2.9 VSE > [Parameter_#] > Detail [PROFINET IO] 

 

VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Configuration] .................................................131 
VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Input]...............................................................132 
VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Output] ............................................................134 
VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Summary] .......................................................135 

22887 

  This applies only to VSE150: 
 

>  

VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Configuration] 
22890 

  

Section Dialogue element Display Switching function 

Mode • Standard mode Option field 
Select an option 

  • Expert mode Option field 

Process image 
Input 

current value: 
… elements (… bytes) 

--- 

  
Output 

current value: 
… elements (… bytes) 

--- 

  
Total 

current value: 
… elements (… bytes) 

--- 

  
Admin. data 

current value: 
… bytes 

--- 

  
Free 

current value: 
… bytes 

--- 

Export details about the process 
image 

--- ---  

Export General Station 
Description (GSD) file 

--- ---  

  

Switching functions: 

 
Export of a detailed description of the contents (data points) of the configured PROFINET IO 
process image as a PDF file 

 

Export of the certified PROFINET IO General Station Description (GSD) file for the VSE150 
diagnostic electronics into a directory to be specified 

In the expert mode: 
Create a user-defined (non-certificated) GSD file 
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>  

VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Input] 
22891 

The terms "Input" and "Output" are from the fieldbus master's point of view. 

 

► Select the "Source" in the left window (activate the checkbox). 

Add the selected element to the process image via [ ]. 

> The selected elements appear as "Content" in the right window. 
The offset address, depending on the data length (number of bytes) of the selected elements, is 
indicated in the left column. 

► If required: 

Remove the element selected in the process image from the process image via [ ]. 
  

Section Dialogue element Display Switching function 

Process image 
Input 

current value: 
… items (… bytes) 

--- 

  
Output 

current value: 
… items (… bytes) 

--- 

  
Total 

current value: 
… items (… bytes) 

--- 

  
Free 

current value: 
… items (… bytes) 

--- 

  
Approximate load 

current value: 
… messages/sec (… %) 

--- 
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Switching functions: 

 Remove the element selected in the process image from the process image via [ ]. 

 Add the element selected in the [Source] to the process image via [ ]. 

 
Optimises the process image 
The program tries to group the data packages to be transferred as 4-byte units 

 

Switching the display mode: 
 • Offset (0, 4, 5, 7, ...) | Contents 
 • Offset (0..3, 4, 5..6, 7..10, ...) | Contents 
 • contents 

 

Switching the detailed view: 
 • one line for each byte 
 • one line for each parameter 

 Removes the selected element from the process image 
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>  

VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Output] 
22892 

The terms "Input" and "Output" are from the fieldbus master's point of view. 

 

► Select the "Source" in the left window (activate the checkbox). 

Add the selected element to the process image via [ ]. 

> The selected elements appear as "Content" in the right window. 
The offset address, depending on the data length (number of bytes) of the selected elements, is 
indicated in the left column. 

► If required: 

Remove the element selected in the process image from the process image via [ ]. 
  

Section Dialogue element Display Switching function 

Process image 
Input 

current value: 
… items (… bytes) 

--- 

  
Output 

current value: 
… items (… bytes) 

--- 

  
Total 

current value: 
… items (… bytes) 

--- 

  
Free 

current value: 
… items (… bytes) 

--- 

  
Approximate load 

current value: 
… messages/sec (… %) 

--- 
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Switching functions: 

 Remove the element selected in the process image from the process image via [ ]. 

 Add the element selected in the [Quelle] to the process image via [ ]. 

 
Optimises the process image 
The program tries to group the data packages to be transferred as 4-byte units 

 

Switching the display mode: 
 • Offset (0, 4, 5, 7, ...) | Contents 
 • Offset (0..3, 4, 5..6, 7..10, ...) | Contents 
 • contents 

 

Switching the detailed view: 
 • one line for each byte 
 • one line for each parameter 

 Removes the selected element from the process image 
 

>  

VSE > [Parameter_#] > Detail [PROFINET IO] > Tab [Summary] 
22893 

The terms "Input" and "Output" are from the fieldbus master's point of view. 

Display of the parameters selected for communication with the fieldbus master: 
 • group "slot no." 
 • module name/ID/size 
 • offset (absolute) 
 • offset (relative) 
 • source type 
 • source name 
 • data point 
 • unit 
 • data type 
 • data size (number of bytes) 
 • direction of data 
  

Switching functions: 

 

Switching the detailed view: 
 • grouped according to slots, in ascending order according to the offset 
 • as above, with additional details about group and module 
 • grouped according to inputs and outputs, in ascending order according to the offset 

 
Export of a detailed description of the contents (data points) of the configured PROFINET IO 
process image as a PDF file 

 

>  
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9 Configure VNB001 

 

Establish a connection to the VNB sensor ...........................................................................................136 
VNB001 > Object [VNB001_#] > Detail [Device Settings] ....................................................................137 
VNB001 > Object [VNB001_#] > [Parameter_#] ..................................................................................142 

22184 
  

  Read the operating instructions of the vibration sensor prior to installation. 

  

This chapter describes the configuration and the monitoring of the vibration sensor VNB001 using the 
software VES004. 

Add a new device to a project (→ chapter [Device] menu > [New] (→ p. 31)). 
 

>  

9.1 Establish a connection to the VNB sensor 
22390 

Connect the device to the USB interface of the PC/laptop 

► If not yet done: Install VNB-USB driver (→ chapter Install the USB driver (→ p. 10)). 

Choose either: 

► In the tree view, right-click on [VNB001_#]  

► In the context menu: [Scan Network...] 

► In the window [Found Devices] select the desired device with a left-click 

► Use the symbol  [Update the project with the selected device] to add the selected device to the 
project 

► In the tree view, right-click on [VNB001_#] 

► In the context menu: [Connect] 

Or: 

► In the tree view, double-click on [VNB001_#] > [Settings] 

► In the detailed view [Address] > [Configuration] with symbol  [Scan Network] 

► In the window [Found Devices] select the desired device with a left-click 

► Use the symbol  [Update the project with the selected device] to add the selected device to the 
project 

► In the detailed view [Address] > [Configuration] with symbol  [Connect the device] 
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>  

9.2 VNB001 > Object [VNB001_#] > Detail [Device Settings] 

 

VNB001 > ... > [Device Settings] > Detail [Device] ..............................................................................137 
VNB001 > ... > [Device Settings] > Detail [Address] ............................................................................139 
VNB001 > ... > [Device Settings] > Detail [Actions] ..............................................................................140 

22393 

This chapter describes the functions contained in the object [VNB001_#]. 
The object [VNB001_#] can be accessed via the tree view (→ chapter Tree view (→ p. 13)). 

To open the [Settings] menu: 

► In the tree view, select the device. 

► Choose either: 
[Device] menu > [Settings] > [Open] 
Or: 
Double-click on [VNB001_#] > [Settings] 

> The detailed view shows the following information and configuration options: 
 • Device 
 • Address 
 • Actions 

 

>  

9.2.1 VNB001 > ... > [Device Settings] > Detail [Device] 
22394 

  

  The information and functions of the element [Device] are only available if a connection between 
the VNB sensor and the parameter setting software VES004 is established. 

  

► Connect VNB sensor to PC/laptop. 
(→ chapter [Device] menu > [Connect] (→ p. 32)) 
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>  

VNB001 > ... > Detail [Device] > Tab [Configuration] 
22397 

  

Section Dialogue element Display Switching function 

Vibration sensor Type configured device 

-- 

Version hardware version read in the device 

Connection 
Status of the connection between 
software and device 

Serial number serial number read in the device 

Write firmware to device Firmware version firmware version read in the device  

Assign parameter set Parameter set configured parameter set  
  

Switching functions: 

Prerequisite: 

 VES software is connected to the device via [ ] 
  

 Write firmware to device ► Activate the button. 

> A dialogue window appears. 

► Select file with new firmware and confirm with [OK]. 

> Software updates the firmware of the device. 

 Assign parameter set 

(only active if several parameter sets are 
available) 

► Activate the button. 

> A dialogue window appears. 

► Select file with new firmware and confirm with [OK]. 

> Software updates the firmware of the device. 

Optional: 

► Select [Device] > [Write to Device] to write the 
assigned parameter set to the device. 
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>  

9.2.2 VNB001 > ... > [Device Settings] > Detail [Address] 
22399 

  

  The information and functions of the element [Address] are only available if a connection between 
the VNB sensor and the parameter setting software VES004 is established. 

  

► Connect VNB sensor to PC/laptop. 
(→ chapter [Device] menu > [Connect] (→ p. 32)) 

 

 

>  

VNB001 > ... > Detail [Address] > Tab [Configuration] 
22401 

  

Section Dialogue element Display Switching function 

Connection Serial number serial number read in the device 
   

  

Switching functions: 

 
scan the USB ports for connected 
devices 

► Activate the button. 

> A dialogue window with the available devices 
appears. 

► Select the desired device. 

► Use the symbol  [Update the project with the 
selected device] to add the selected device to the 
project 

> The device is assigned to the opened project. 

> The section [Connection] displays information about 
the assigned device. 

 connect the device ► Activate the button. 

> The software connects to the assigned device. 

> The tree view shows the connection status. 

 disconnect the device ► Activate the button. 

> The software is disconnected from the device. 

> The tree view shows the connection status. 
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>  

9.2.3 VNB001 > ... > [Device Settings] > Detail [Actions] 
22407 

  

  The information and functions of the element [Actions] are only available if a connection between 
the VNS sensor and the parameter setting software VES004 is established. 

  

► Connect VNB sensor to PC/laptop. 
(→ chapter Menu [Device] > [Connect] (→ p. 32)) 

 

>  

VNB001 > ... > Detail [Actions] > Tab [Manipulate Device] 
22412 

 

  

Section Dialogue element Display Switching function 

Reboot --- ---  

Execute self-test --- ---  
  

Switching functions: 

 Reboot the device ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR 
Abort the process with [No] 

> If [Yes]: The device reboots. 

 Execute self-test in the device ► Activate the button. 

> The device carries out a self-test. 

> A message window with the result of the self-test 
appears. 

► Close the message window with [OK]. 
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>  

VNB001 > ... > Detail [Actions] > Tab [Reset Device] 
22413 

 

  

Section Dialogue element Display Switching function 

Reset history --- ---  

Reset parameters --- ---  

Restore factory settings --- ---  
   

Switching functions: 

 Reset history ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR: 
Abort the process with [No]. 

> If [Yes]: The software deletes the history of the 
device. 

 Reset parameters ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR: 
Abort the process with [No]. 

> If [Yes]: The software resets all parameters to their 
default values. 

 Restore factory settings ► Activate the button. 

> The factory settings of the device are restored. 
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>  

9.3 VNB001 > Object [VNB001_#] > [Parameter_#] 

 

VNB001 > ... > [Parameter_#] > Detail [Common Configuration] ........................................................143 
VNB001 > ... > [Parameter_#] > Detail [Inputs] ....................................................................................147 
VNB001 > ... > [Parameter_#] > Detail [Objects] .................................................................................149 
VNB001 > ... > [Parameter_#] > Detail [History] ..................................................................................151 
VNB001 > ... > [Parameter_#] > Detail [Alarms] ..................................................................................153 

22415 

The tab [Parameter_#] contains all information and configuration and monitoring options of the 
parameter set assigned to the vibration sensor. 

To open the tab [Parameter_#]: 

► In the tree view, select the desired sensor. 

► Choose either: 
[Device] menu > [Parameter] > [Open] 
Or: 
Double-click on [VNB001_#] > [Parameter_#] 

> The detailed view shows the tab [Parameter_#] 
  

  It is always the parameter set currently assigned to the device which is opened  
(→ chapter [Parameter] menu > [Device] (→ p. 43)) 

To open any parameter set: 

► In the tree view, double-click on [Parameters] > [VNB001] > [Parameter_#] 

> The detailed view shows the tab of the selected parameter set. 
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>  

9.3.1 VNB001 > ... > [Parameter_#] > Detail [Common Configuration] 

 

VNB001 > ... > [Parameter_#] > ... > Detail [Supported Devices] ........................................................143 
VNB001 > ... > [Parameter_#] > ... > Detail [Documentation] ..............................................................144 
VNB001 > ... > [Parameter_#] > ... > Detail [Device Information] ........................................................144 
VNB001 > ... > [Parameter_#] > ... > Detail [Assigned Devices] ..........................................................146 

22417 

The element [Common Configuration] contains information and documentation of the current 
parameter set about the device settings. 

► Open the tab [Parameter_#] 

► In the detailed view, select [Common Configuration] 

> The detailed view shows the following information: 

Section Dialogue element Display Possible values 

Information Created date on which the data set was 
created 

-- 

Changed date on which the data set was 
changed last 

-- 

Parameter set Name designation of the parameter set freely selectable 

Display of the device Display unit unit in which the values are 
displayed 

 metric [mm/s] 

 imperial [in/s] 

Speed values acceleration values  RMS = effective value 

 Peak = peak value 
 

>  

VNB001 > ... > [Parameter_#] > ... > Detail [Supported Devices] 
22418 

The element [Supported Devices] offers information about the devices used here. 
 

>  

VNB001 > ... > Detail [Supported Devices] > Tab [Configuration] 
22419 

  

Section Dialogue element Display Description 

Supported device types 
Type of unit configured sensor 

corresponds to the selected 
device 

Supported firmware versions Min. required firmware version indication acc. to VES004 

Max. supported firmware version indication acc. to VES004 
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Configure VNB001 VNB001 > Object [VNB001_#] > [Parameter_#] 

>  

VNB001 > ... > [Parameter_#] > ... > Detail [Documentation] 
22420 

The element [Documentation] offers information about location and parameter setting data of the 
sensor. 
 

>  

VNB001 > ... > Detail [Documentation] > Tab [Application] 
22421 

  

Section Dialogue element Display Description 

Application Company 

free text max. 100 characters 

Address 

City 

Location 

Machine 
 

>  

VNB001 > ... > Detail [Documentation] > Tab [Description] 
22422 

The description contains a creation date and the date of the last parameter change. The author of the 
parameter set and a free text description can be added. 

Section Dialogue element Display Switching function 

Description Created by: free text max. 100 characters 

Date of creation: date of creation date later / earlier 

Last change: date of the last modification automatic 

Description free text max. 100 characters 
 

>  

VNB001 > ... > [Parameter_#] > ... > Detail [Device Information] 
22423 

The element [Device Information] offers information about the configuration of the alarms and objects 
as well as about the navigation of path of the device display. 
 

>  

VNB001 > ... > Detail [Device Information] > Tab [Outputs] 
22424 

  

Section Dialogue element Display Switching function 

Outputs OUT 1 use and information about alarm 
configuration 

 
OUT 2 use and information about alarm 

configuration 
  

Switching functions: 

 
go to the configurati→ p. of the selected alarm  
(only active if at least one output is used for alarms) 
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>  

VNB001 > ... > Detail [Device Information] > Tab [Object Dependencies] 
22426 

  

Section Dialogue element Display Switching function 

Object dependencies Name name of the object 

 

Type parameter type 

Use use of the parameters 

Source name of the trigger 
  

Switching functions: 

 
configure selected object or input  
(only active if at least one object is defined) 

 

>  

VNB001 > ... > Detail [Device Information] > Tab [Device Menu] 
22428 

Visualises the menu of the target device (here: detail) 
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>  

VNB001 > ... > [Parameter_#] > ... > Detail [Assigned Devices] 
22431 

Several devices can share one parameter set. This means that you only need to maintain one 
parameter set if you have several identical machines and installations. A changed parameter set can 
be written to several devices at the same time. 

The element [Assigned Devices] contains the following sections: 
 

>  

VNB001 > ... > Detail [Assigned Devices] > Tab [Devices] 
22432 

Displays all devices assigned to the parameter set. 

Section Dialogue element Display Switching function 

Assigned devices No. consecutive number in the list 

--- 

Name configured name of the device 

Type article number of the device 

Firmware read firmware version 

Serial no. read serial number of the device 
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>  

9.3.2 VNB001 > ... > [Parameter_#] > Detail [Inputs] 
22434 

The program differentiates between the following inputs: 
 • Dynamic inputs (AC) 
 • Analogue inputs (DC) 

 

  

Section Dialogue element Display Switching function 

Dynamic inputs (AC) Name internal (fixed) 

 
(after right-click) 

Type internal sensor (fixed) 

Filter configured filter 

Analogue inputs (DC) Name IN 1 (fixed) 

 
(after right-click) 

Type analogue - current (fixed) 

Reference 4...20 mA (fixed) 

Value configured value 
  

Switching functions: 

 go to the configurati→ p. of the selected input  
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>  

VNB001 > ... > [Parameter_#] > ... > Detail [Dynamic Inputs (AC)] > [Internal] 
22436 

The configured filter is applied prior to the actual evaluation of the signal. Scaling and unit define the 
height of the measured amplitudes. 

Section Dialogue element Display Switching function 

Identification Name internal fixed 

Type internal sensor fixed 

Configuration Filter highpass 2 Hz / 10 Hz selectable from list 

Unit g fixed 

Scaling 25,00 g fixed 
 

>  

VNB001 > ... > [Parameter_#] > ... > Detail [Analogue Inputs (DC)] > [IN 1] 
22437 

The signal is defined using the two reference points as a linear function between 0 and 20 mA. 

Section Dialogue element Display Switching function 

Identification Name IN 1 fixed 

Type Analogue - Current fixed 

Configuration Unit configured unit free text 

Lower reference point configured assignment to 4 mA increase / reduce value 

Upper reference point configured assignment to 20 mA increase / reduce value 
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>  

9.3.3 VNB001 > ... > [Parameter_#] > Detail [Objects] 

 

VNB001 > ... > Detail [Objects] > [SE01_v_RMS_Time_U1] > Tab [Configuration] ............................150 
VNB001 > ... > Detail [Objects] > [SE01_v_RMS_Time_U1] > Tab [Processing] ................................150 
VNB001 > ... > Detail [Objects] > [IN1_UpperLimit_EP1] > Tab [Configuration] .................................150 
VNB001 > ... > Detail [Objects] > [IN1_UpperLimit_EP1] > Tab [Processing] .....................................150 

22438 

Displays the existing objects 

 

For the VNB001 the following objects are firmly set 

Object type Description 

v-RMS (time domain) Monitors the vibration velocity in a configurable frequency range. The frequency range is defined 
via the filter of the dynamic input and the filter of the object. 

RMS = root mean square 

Applications: 

 measurements in accordance with ISO 10816 and other applicable standards (v-RMS) 

 loose machine parts (v-RMS) 

 alignment errors (v-RMS) 

Upper limit monitor Monitors analogue signals (DC signals). 

The signal source can be an analogue input 
  

Section / column Dialogue element Display Switching function 

Name 
-- 

 SE01_v_RMS_Time_U1 

 IN1_UpperLimit_EP1 

 

Type 
-- 

 v-RMS (time domain) 

 upper limit monitor 

Input 

-- 

 internal (internal sensor) 

 IN 1 (Analogue - current, 
4...20 mA) 

  

Switching functions: 

 go to the configurati→ p. of the selected object 
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>  

VNB001 > ... > Detail [Objects] > [SE01_v_RMS_Time_U1] > Tab [Configuration] 
22439 

The configured object monitors the indicator on the basis of the current signal of the selected input. 

Section Dialogue element Display Switching function 

Identification Name SE01_v_RMS_Time_U1 fixed 

Type v-RMS (time domain) fixed 

Configuration Input Internal (internal sensor) fixed 
 

>  

VNB001 > ... > Detail [Objects] > [SE01_v_RMS_Time_U1] > Tab [Processing] 
22440 

  

Section Dialogue element Display Switching function 

Filter 
Type 

configured filter type 
→ [Inputs] > [Dynamic Input > 
[Internal] 

fixed 

From 0 Hz fixed 

To 1000 Hz fixed 

Limits Warning alarm configured value increase / reduce value 

Damage alarm configured value increase / reduce value 

Processing Averaging configured value increase / reduce value 

Measurement time 0.250 s fixed 
 

>  

VNB001 > ... > Detail [Objects] > [IN1_UpperLimit_EP1] > Tab [Configuration] 
22441 

The configured object monitors the indicator on the basis of the current signal of the selected input. 

Section Dialogue element Display Switching function 

Identification Name IN1_UpperLimit_EP1 fixed 

Type upper limit monitor fixed 

Configuration Input IN 1 (Analogue - current, 4...20mA) fixed 
 

>  

VNB001 > ... > Detail [Objects] > [IN1_UpperLimit_EP1] > Tab [Processing] 
22442 

The hysteresis is the difference between the set and the reset point of the alarm. 

Section Dialogue element Display Switching function 

Limits Warning alarm configured value increase / reduce value 

Hysteresis configured value increase / reduce value 

Damage alarm configured value increase / reduce value 

Hysteresis configured value increase / reduce value 

Processing Measurement time 0.500 s fixed 
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>  

9.3.4 VNB001 > ... > [Parameter_#] > Detail [History] 
22443 

Nothing can be configured here. 

Section Dialogue element Display / Switching function Beschreibung 

Object VNB001 sensor / input type / input fixed 

Interval 
-- 0 h : 05 min : 00 s 

measurement duration: 
the highest value measured 
during the interval is recorded 

Av. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

average value (from firmware 
0.5.19): 
stores the measured values of 
the object (incl. the other 
selected options) 

Estimated recording time 
-- 

maximum time period that can be 
stored in the history 

indication of the possible 
recording time 

  

The vibration sensor has an integrated history function with battery buffered real-time clock. In the 
history memory the device records the following data: 
 • object values and limits 
 • timestamps on the events 

The history memory comprises approx. 300,000 values. 
 

>  

VNB001 > ... > Detail [History] > Real-time clock 
22445 

When disconnected, the real-time clock of the sensor is battery buffered.  

The time must be set once during commissioning by resetting the device history. This aligns the time 
of the diagnostic electronics with the "Universal Time Coordinated" (UTC, formerly "Greenwich Mean 
Time" GMT) of the computer. The "Universal Time Coordinated" is determined from the time and time 
zone set in the operating system. 
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>  

VNB001 > ... > Detail [History] > Recording the measured values 
22446 

The history memory is a ring memory (FIFO, "first in first out"). If the history memory is full, a small 
portion of the oldest values is deleted to free up memory space. 

The recording of the measured values is usually determined by an interval specified in the parameters.  

 At the end of the interval, the maximum measured value that occurred during the interval is 
recorded in the history memory together with the corresponding time stamp.  

 Depending on the selected options (→ chapter "Parameters"), the mean value of the interval 
measurement is written to the history memory. 
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Diagram: History of the measured values (example) 
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>  

9.3.5 VNB001 > ... > [Parameter_#] > Detail [Alarms] 
22447 

Displays the existing alarms 

 

  

Switching functions: 

 go to the configurati→ p. of the selected alarm 
 

>  

VNB001 > ... > Detail [Alarms] > [OUT1_Warning] > Tab [Configuration] 
22449 

Configure the warning alarm (via the context menu), either: 

• analogue as an analogue alarm  

 

• digital as a warning alarm 

 
  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

fixed 

Type 
configured type of the selected 
output 

fixed 

Output assigned digital output fixed 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Switch-on delay configured time increase / reduce value 

Switch-off delay configured time increase / reduce value 
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>  

VNB001 > ... > Detail [Alarms] > [OUT1_Warning] > Tab [Source] 
22450 

The objects for the visualisation in this alarm are predefined: 
the warning alarms of all configured objects are linked with OR 

Section Dialogue element Display Switching function 

Alarm source - objects 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  

VNB001 > ... > Detail [Alarms] > [OUT2_Damage] > Tab [Configuration] 
22453 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

fixed 

Type 
configured type of the selected 
output 

fixed 

Output assigned digital output fixed 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Switch-on delay configured time increase / reduce value 

Switch-off delay configured time increase / reduce value 
 

>  

VNB001 > ... > Detail [Alarms] > [OUT2_Damage] > Tab [Source] 
22454 

The objects for the visualisation in this alarm are predefined: 
the warning alarms of all configured objects are linked with OR 

Section Dialogue element Display Switching function 

Alarm source - objects 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  
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10 Configure VNB211 

 

Establish a connection to the VNB sensor ...........................................................................................155 
VNB211 > Object [VNB211_#] > Detail [Device Settings] ....................................................................156 
VNB211 > Object [VNB211_#] > [Parameter_#] ..................................................................................161 

22185 
  

  Read the operating instructions of the vibration sensor prior to installation 

  

  The parameters of the vibration sensor VNB211 can be read and written with the VES004 
software.  

  

For the VNB211 the factory setting is: 
 • v-RMS 10...1000 Hz to ISO10816 
 • a-Peak 10....6000 Hz. 

Via the software a parameter set can be defined which has nothing to do with the factory setting. 

This chapter describes the configuration and the monitoring of the VNB211 vibration sensor by means 
of the VES004 software. 

Add a new device to a project: → chapter Create a new device (VNB) (→ p. 22) 
 

>  

10.1 Establish a connection to the VNB sensor 
22456 

► Connect the device to the USB interface of the PC/laptop 

► If not yet done: Install the VNB-USB driver (→ chapter Install the USB driver (→ p. 10)) 

Choose either: 

► In the tree view, right-click on [VNB211_#] 

► In the context menu: [Scan Network...] 

► In the window [Found Devices] select the desired device with a left-click 

► Use the symbol  [Update the project with the selected device] to add the selected device to the 
project 

► In the tree view, right-click on [VNB211_#] 

► In the context menu: [Connect] 

Or: 

► In the tree view, double-click on [VNB211_#] > [Settings] 

► In the detailed view [Address] > [Configuration] with symbol  [Scan Network 

► In the window [Found Devices] select the desired device with a left-click 

► Use the symbol  [Update the project with the selected device] to add the selected device to the 
project 

► In the detailed view [Address] > [Configuration] with symbol  [Connect the device] 
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Configure VNB211 VNB211 > Object [VNB211_#] > Detail [Device Settings] 

>  

10.2 VNB211 > Object [VNB211_#] > Detail [Device Settings] 

 

VNB211 > ... > [Device Settings] > Detail [Device] ..............................................................................156 
VNB211 > ... > [Device Settings] > Detail [Address] ............................................................................158 
VNB211 > ... > [Device Settings] > Detail [Actions] ..............................................................................159 

22457 

This chapter describes the functions contained in the object [VNB211_#]. 
The object [VNB211_#] can be accessed via the tree view (→ p. 13). 

To open the [Settings] menu: 

► In the tree view, select the device. 

► Choose either: 
[Device] menu > [Settings] > [Open] 
Or: 
Double-click on [VNB211_#] > [Settings] 

> The detailed view shows the following information and configuration options: 
 • Device 
 • Address 
 • Actions 

 

>  

10.2.1 VNB211 > ... > [Device Settings] > Detail [Device] 
22458 

  

  The information and functions of the element [Device] are only available if a connection between 
the VNB sensor and the parameter setting software VES004 is established. 

► Connect VNB sensor to PC/laptop  
(→ chapter Establish a connection to the VNB sensor (→ p. 155)). 
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>  

VNB211 > ... > Detail [Device] > Tab [Configuration] 
22460 

  

Section Dialogue element Display Switching function 

Vibration sensor Type configured device 

-- 
Version hardware version read in the device 

Connection 
status of the connection between 
software and device 

Serial number serial number read in the device 

Write firmware to  device Firmware version firmware version read in the device  

Assign parameter set Parameter set configured parameter set  
  

Switching functions: 

Prerequisite: 

VES software is connected to the device via [ ] 

 Write firmware to device ► Activate the button. 

> A dialogue window appears. 

► Select file with new firmware and confirm with [OK]. 

> Software updates the firmware of the device. 

 Assign parameter set 

(only active if several parameter sets are 
available) 

► Activate the button. 

> A dialogue window appears. 

► Select the desired parameter set and confirm with 
[OK] 

> The software assigns the selected parameter set to 
the device. 

Optional: 

► Select [Device] > [Write to Device] to write the 
assigned parameter set to the device. 
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>  

10.2.2 VNB211 > ... > [Device Settings] > Detail [Address] 
22461 

  

  The information and functions of the element [Address] are only available if a connection between 
the VNB sensor and the parameter setting software VES004 is established. 

► Connect VNB sensor to PC/laptop 
(→ chapter Establish a connection to the VNB sensor (→ p. 155)) 

  

 

 

>  

VNB211 > ... > Detail [Address] > Tab [Configuration] 
22462 

  

Section Dialogue element Display Switching function 

Connection Serial number serial number read in the device 
, ,  

  

Switching functions: 

 
scan the USB ports for connected 
devices 

► Activate the button. 

> A dialogue window with the available devices 
appears. 

► Select the desired device. 

► Use the symbol  [Update the project with the 
selected device] to add the selected device to the 
project 

> The device is assigned to the opened project. 

> The section [Connection] displays information about 
the assigned device 

 connect the device ► Activate the button. 

> The software connects to the assigned device. 

> The tree view shows the connection status. 

 disconnect the device ► Activate the button. 

> The software is disconnected from the device. 

> The tree view shows the connection status. 
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>  

10.2.3 VNB211 > ... > [Device Settings] > Detail [Actions] 
22463 

  

  The information and functions of the element [Actions] are only available if a connection between 
the VNS sensor and the parameter setting software VES004 is established. 

► Connect VNB sensor to PC/laptop 
(→ chapter Establish a connection to the VNB sensor (→ p. 155)). 

 
>  

VNB211 > ... > Detail [Actions] > Tab [Manipulate Device] 
22465 

 

  

Section Dialogue element Display Switching function 

Reboot --- ---  

Execute self-test --- ---  
  

Switching functions: 

 Reboot the device ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR 
Abort the process with [No] 

> If [Yes]: The device reboots. 

 Execute self-test in the device ► Activate the button. 

> The device carries out a self-test. 

> A message window with the result of the self-test 
appears. 

► Close the message window with [OK]. 
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>  

VNB211 > ... > Detail [Actions] > Tab [Reset Device] 
22467 

 

  

Section Dialogue element Display Switching function 

Reset history --- ---  

Reset parameters --- ---  

Restore factory settings --- ---  
  

Switching functions: 

 Reset history ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR: 
Abort the process with [No]. 

> If [Yes]: the software deletes the history of the 
device. 

 Reset parameters ► Activate the button. 

> The confirmation message appears. 

► Start the process with [Yes] 
OR: 
Abort the process with [No]. 

> If [Yes]: the software resets all parameters to their 
default values. 

 Restore factory settings ► Activate the button. 

> The factory settings of the device are restored. 
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>  

10.3 VNB211 > Object [VNB211_#] > [Parameter_#] 

 

VNB211 > ... > [Parameter_#] > Detail [Common Configuration] ........................................................162 
VNB211 > ... > [Parameter_#] > Detail [Inputs] ....................................................................................167 
VNB211 > ... > [Parameter_#] > Detail [Objects] .................................................................................169 
VNB211 > ... > [Parameter_#] > Detail [History] ..................................................................................174 
VNB211 > ... > [Parameter_#] > Detail [Alarms] ..................................................................................176 

22468 

The tab [Parameter_#] contains all information and configuration and monitoring options of the 
parameter set assigned to the vibration sensor. 

To open the tab [Parameters_#]: 

► In the tree view, select the desired sensor. 

► Choose either: 
[Device] menu > [Parameter] > [Open] 
Or: 
Double-click on [VNB211_#] > [Parameter_#] 

> The detailed view shows the tab [Parameter_#] 

  

  It is always the parameter set currently assigned to the device which is opened  
(→ chapter [Parameter] menu > [Device] (→ p. 43)) 

To open any parameter set: 

► In the tree view double-click on [Parameter] > [VNB211] > [Parameter_#] 

> The detailed view shows the tab of the selected parameter set. 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

10.3.1 VNB211 > ... > [Parameter_#] > Detail [Common Configuration] 

 

VNB211 > ... > [Parameter_#] > ... > Detail [Supported Devices] ........................................................162 
VNB211 > ... > [Parameter_#] > ... > Detail [Documentation] ..............................................................163 
VNB211 > ... > [Parameter_#] > ... > Detail [Device Information] ........................................................164 
VNB211 > ... > [Parameter_#] > ... > Detail [Assigned Devices] ..........................................................166 

22469 

The element [Common Configuration] contains information and documentation of the current 
parameter set about the device settings. 

► Open the tab [Parameter_#] 

► In the detailed view, select [Common Configuration] 

> The detailed view shows the following information: 

Section Dialogue element Display Possible values 

Information Created date on which the data set was 
created 

-- 

Changed date on which the data set was 
changed last 

-- 

Parameter set Name designation of the parameter set freely selectable 

Display of the device Display of the unit unit in which the values are 
displayed 

 metric [mm/s] 

 imperial [in/s] 
 

>  

VNB211 > ... > [Parameter_#] > ... > Detail [Supported Devices] 
22470 
22418 

The element [Supported Devices] offers information about the devices used here. 
 

>  

VNB211 > ... > Detail [Supported Devices] > Tab [Configuration] 
22471 
22419 

  

Section Dialogue element Display Description 

Supported device types 
Type of unit configured sensor 

corresponds to the selected 
device 

Supported firmware versions Min. required firmware version indication acc. to VES004 

Max. supported firmware version indication acc. to VES004 
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>  

VNB211 > ... > [Parameter_#] > ... > Detail [Documentation] 
22472 
22420 

The element [Documentation] offers information about location and parameter setting data of the 
sensor. 
 

>  

VNB211 > ... > Detail [Documentation] > Tab [Application] 
22473 
22421 

  

Section Dialogue element Display Description 

Application Company 

free text max. 100 characters 

Address 

City 

Location 

Machine 
 

>  

VNB211 > ... > Detail [Documentation] > Tab [Description] 
22474 
22422 

The description contains a creation date and the date of the last parameter change. The author of the 
parameter set and a free text description can be added. 

Section Dialogue element Display Switching function 

Description Created by: free text max. 100 characters 

Date of creation: date of creation date later / earlier 

Last change: date of the last modification automatic 

Description free text max. 100 characters 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > [Parameter_#] > ... > Detail [Device Information] 
22475 
22423 

The element [Device Information] offers information about the configuration of the alarms and objects 
as well as about the navigation of path of the device display. 
 

>  

VNB211 > ... > Detail [Device Information] > Tab [Outputs] 
22476 
22424 

  

Section Dialogue element Display Switching function 

Outputs OUT 1 use and information about alarm 
configuration 

 
OUT 2 use and information about alarm 

configuration 
  

Switching functions: 

 
go to the configurati→ p. of the selected alarm  
(only active if at least one output is used for alarms) 

 

>  

VNB211 > ... > Detail [Device Information] > Tab [Object Dependencies] 
22477 
22426 

  

Section Dialogue element Display Switching function 

Object dependencies Name name of the object 

 

Type parameter type 

Use use of the parameters 

Source name of the trigger 
  

Switching functions: 

 
configure selected object or input  
(only active if at least one object is defined) 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Detail [Device Information] > Tab [Device Menu] 
22478 

Visualises the menu of the target device (here: example (with factory settings)) 

    

The visualisation of the device menu depends on the ... 
• defined inputs 
• defined objects 
• defined alarms 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > [Parameter_#] > ... > Detail [Assigned Devices] 
22479 
22431 

Several devices can share one parameter set. This means that you only need to maintain one 
parameter set if you have several identical machines and installations. A changed parameter set can 
be written to several devices at the same time. 

The element [Assigned Devices] contains the following sections: 
 

>  

VNB211 > ... > Detail [Assigned Devices] > Tab [Devices] 
22480 
22432 

Displays all devices assigned to the parameter set. 

Section Dialogue element Display Switching function 

Assigned devices No. consecutive number in the list 

--- 

Name configured name of the device 

Type article number of the device 

Firmware read firmware version 

Serial no. read serial number of the device 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

10.3.2 VNB211 > ... > [Parameter_#] > Detail [Inputs] 
22481 

In an empty parameter set (factory setting) of the VNB211 no input is defined. 
The user must activate / add these inputs by himself according to their project. 

The program differentiates between the following inputs: 
 • Dynamic inputs (AC) 
 • Analogue inputs (DC) 

 

  

Section Dialogue element Display Switching function 

Dynamic inputs (AC) Name configured filter 

 
(after right-click) 

Type internal sensor (fixed) 

Filter configured filter 

Analogue inputs (DC) Name configured filter 

 
(after right-click) 

Type analogue - current (fixed) 

Reference 4...20 mA (fixed) 

Value configured value range 
  

Switching functions: 

 add new dynamic input 

 add new analogue input 

 go to the configurati→ p. of the selected input 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > [Parameter_#] > ... > Detail [Dynamic Inputs (AC)] > [Internal] 
22484 
22436 

The configured filter is applied prior to the actual evaluation of the signal. Scaling and unit define the 
height of the measured amplitudes. 

Section Dialogue element Display Switching function 

Identification Name internal fixed 

Type internal sensor fixed 

Configuration Filter highpass 2 Hz / 10 Hz selectable from list 

Unit g fixed 

Scaling 25,00 g fixed 
 

>  

VNB211 > ... > [Parameter_#] > ... > Detail [Analogue Inputs (DC)] > [IN 1] 
22485 

The signal is defined using the two reference points as a linear function between 0 and 20 mA. 

Section Dialogue element Display Switching function 

Identification Name free text -- 

Type analogue - current fixed 

Configuration Unit configured unit free text 

Lower reference point configured assignment to 4 mA increase / reduce value 

Upper reference point configured assignment to 20 mA increase / reduce value 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

10.3.3 VNB211 > ... > [Parameter_#] > Detail [Objects] 

 

VNB211 > ... > Detail [Objects] > Object types ....................................................................................170 
22486 

Displays the configured objects 

 

  

Switching functions: 

 add new object of type "a-RMS (time domain)"  

 add new object of type "v-RMS (time domain)"  

 add new object of type "a-Peak (time domain)" 

 add new object of type "Upper limit monitor" 

 add new object of type "Lower limit monitor" 

 go to the configurati→ p. of the selected object 

 delete selected object from the list 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Detail [Objects] > Object types 

 

VNB211 > ... > Object types > [a-RMS], [v-RMS] (time domain) .........................................................171 
VNB211 > ... > Object types > [a-Peak (time domain)] ........................................................................172 
VNB211 > ... > Object types > [Upper Limit Monitor], [Lower Limit Monitor]........................................172 
VNB211 > ... > Detail [Objects] > ... > Tab [Configuration] ..................................................................173 
VNB211 > ... > Detail [Objects] > ... > Tab [Processing] ......................................................................173 

22493 

Preconfigured object types for the following monitoring tasks are offered which can be configured 
using a wizard: 

Name Objekttyp Menüpunkt auf dem Gerät Hinweis 

a-RMS (time domain) U1 / U2 

max. 2 entries possible v-RMS (time domain) U1 / U2 

a-peak (time domain) U1 / U2 

Upper limit monitor EP1 / EP2 
max. 2 entries possible 

Lower limit monitor EP1 / EP2 
  

RMS = root mean square 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Object types > [a-RMS], [v-RMS] (time domain) 
22494 

 • a-RMS (time domain) monitors the acceleration, 
 • v-RMS (time domain) monitors the vibration velocity 
... in a configurable frequency range.  

The frequency range is defined via the filter of the dynamic input (→ tab [Configuration]) and the filter 
of the object. 

dt  

Legend:  dt = measurement time, measurement period  

Applications: 
 • Measurements to ISO 10816 and other applicable standards (v-RMS) 
 • Loose machine parts (v-RMS) 
 • Alignment errors (v-RMS) 
 • Chatter vibrations, resonances (a-RMS) 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Object types > [a-Peak (time domain)] 
22495 

  

  The filtering of the time signal is done by means of the filter for the dynamic input → tab 
[Configuration]) and the object. 

  

[a-peak (time domain)] measures the maximum amplitude on a dynamic input within the set 
measurement time 

Different applications are possible thanks to signal filtering. Due to the very short measurement time 
(adjustable between 1 and 1.3 s), this object type is also suited for machine protection (e.g. in crash 
situations). 

dt
 

Legend:  dt = measurement time, measurement period 

Applications: 
 • Crash (lowpass) 
 • Cavitation on a pump (highpass) 
 • Metal-on-metal friction, e.g. bearing damage (highpass) 
 

>  

VNB211 > ... > Object types > [Upper Limit Monitor], [Lower Limit Monitor] 
22496 

[Upper Limit Monitor], [Lower Limit Monitor] monitor analogue signals (DC signals) 

The signal source can only be the analogue input IN 1. 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Detail [Objects] > ... > Tab [Configuration] 
22497 

  

  Under the tab [Configuration] only the preset [Name] can be changed. All other fields are fixed. 

  

Section Dialogue element Display Switching function 

Identification 
Name 

preset name 
according to input and object type 

free text 

Type selected object type fixed 

Menu item on the 
device 

short form of the type 
(figure # results from the table 
[Object types]) 

fixed 

Configuration 

Input 

preset input: 

for a-RMS, v-RMS, a-Peak: 
internal (internal sensor) 

for upper limit, lower limit: 
IN 1 (analogue, current, 4...20 mA) 

fixed 

 

>  

VNB211 > ... > Detail [Objects] > ... > Tab [Processing] 
22498 

  

Section Dialogue element Display Switching function 

Filter 

only for a-RMS, v-RMS, a-Peak Type 
• lowpass 
• highpass 
• bandpass 

selectable from list 

From configured lower limit frequency 
depending on the filter type: 
increase / reduce value 
or: fixed 

To configured upper limit frequency 
depending on the filter type: 
increase / reduce value 
or: fixed 

Limits Warning alarm configured value increase / reduce value 

Hysteresis 

only for upper limit / 
lower limit 

configured value increase / reduce value 

Damage alarm configured value increase / reduce value 

Hysteresis 

only for upper limit / 
lower limit 

configured value increase / reduce value 

Processing 

only for a-RMS, v-RMS, a-Peak 
Averaging configured value increase / reduce value 

Processing Measurement time configured value increase / reduce value 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

10.3.4 VNB211 > ... > [Parameter_#] > Detail [History] 

 

VNB211 > ... > Detail [History] > Real-time clock .................................................................................175 
VNB211 > ... > Detail [History] > Recording of the measured values ..................................................175 

22499 

The octavis vibration sensor VNB211 has an integrated history function with battery buffered real-time 
clock. In the history memory the device records the following data: 
 • object values and limits 
 • timestamps on the events 

The history memory comprises approx. 300,000 values. 

 

Detail [History]: 
Using the symbol at the top right in the detail window, you can activate/deactivate the entire history 
memory. If the history memory is active, the history settings can be made for the objects configured in 
the parameter set. 

Switching functions: 

 
Switch: the history memory is deactivated. 
Parameters cannot be configured. 

 
Switch: the history memory is activated. 
Parameters can be configured. 

  

Objects can also be activated/deactivated individually. If an object is active, the highest value 
measured within the set interval is recorded. 

With the checkbox [Av.] which can be selected individually for each object, additional values can be 
stored optionally. If a setting is made for the diagnostic electronics or a sensor, then the set value will 
automatically be adopted for all subordinated objects. 
  

Section Dialogue element Display / Switching function Beschreibung 

Object VNB211 sensor / input type / input fixed 

Interval 
-- 0 h : 05 min : 00 s 

measurement duration: 
the highest value measured 
during the interval is recorded 

Av. 

-- 

  Option not activated 

  Option partly activated 

  Option fully activated 

mean average 
records the mean value of the 
interval measurement 

Estimated recording time 
-- 

maximum time period that can be 
stored in the history 

indication of the possible 
recording time 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Detail [History] > Real-time clock 
22500 
22445 

When disconnected, the real-time clock of the sensor is battery buffered.  

The time must be set once during commissioning by resetting the device history. This aligns the time 
of the diagnostic electronics with the "Universal Time Coordinated" (UTC, formerly "Greenwich Mean 
Time" GMT) of the computer. The "Universal Time Coordinated" is determined from the time and time 
zone set in the operating system. 
 

>  

VNB211 > ... > Detail [History] > Recording of the measured values 
22502 
22446 

The history memory is a ring memory (FIFO, "first in first out"). If the history memory is full, a small 
portion of the oldest values is deleted to free up memory space. 

The recording of the measured values is usually determined by an interval specified in the parameters.  

 At the end of the interval, the maximum measured value that occurred during the interval is 
recorded in the history memory together with the corresponding time stamp.  

 Depending on the selected options (→ chapter "Parameters"), the mean value of the interval 
measurement is written to the history memory. 
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Diagram: History of the measured values (example) 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

10.3.5 VNB211 > ... > [Parameter_#] > Detail [Alarms] 
22503 

Displays the existing alarms 

 

Maximum two of the following alarm types can be defined: 
 • analogue alarm 
 • warning alarm 
 • damage alarm 
 • user-defined alarm 

Switching functions: 

 add a new alarm of the "analogue alarm" type 

 add a new alarm of the "warning alarm" type 

 add a new alarm of the "damage alarm" type 

 add a new alarm of the "use-defined alarm" type 

 go to the configurati→ p. of the selected alarm 

 delete selected object from the list 
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Configure VNB211 VNB211 > Object [VNB211_#] > [Parameter_#] 

>  

VNB211 > ... > Detail [Alarms] > Alarm type > Tab [Configuration] 
22509 

  

Section Dialogue element Display Switching function 

Identification 
Name 

configured name of the selected 
output 

fixed 

Type 
configured type of the selected 
output 

fixed 

Output assigned digital output selectable from list 

Configuration 
Switch 

configured signal: 
• normally closed 
• normally open 

selectable from list 

Switch-on delay configured time increase / reduce value 

Switch-off delay configured time increase / reduce value 

Signalling 
(only for analogue alarm) 

Signal 
configured signal: 
• current 4...20 mA 

selectable from list 

Values configured value type selectable from list 

Scaling 
(only for analogue alarm) 

Value at 4 mA configured value increase / reduce value 

Value at 20 mA configured value increase / reduce value 
 

>  

VNB211 > ... > Detail [Alarms] > Alarm type > Tab [Source] 
22510 

Select the objects for visualisation in this alarm. 
For an analogue alarm the units must match. 

Section Dialogue element Display Switching function 

Alarm source 
Table configured objects 

  evaluate object 

  do not evaluate object 
 

>  
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Monitoring Monitoring types 

11 Monitoring 

 

Monitoring types ...................................................................................................................................178 
Record and display measured data ......................................................................................................184 
Context menu functions ........................................................................................................................195 
Characteristics ......................................................................................................................................197 

22186 

By "monitoring", we understand the detection of measured data. 
 

>  

11.1 Monitoring types 

 

Types of measurement data .................................................................................................................179 
Data monitoring ....................................................................................................................................180 
Counter monitoring ...............................................................................................................................180 
I/O monitoring .......................................................................................................................................180 
Spectrum monitoring ............................................................................................................................181 
Raw data monitoring .............................................................................................................................182 
History monitoring .................................................................................................................................183 

22542 
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Monitoring Monitoring types 

>  

11.1.1 Types of measurement data 
22511 

The diagnostic electronics and the sensors offer a number of different measurement data: 
 • the raw signal (time signal) 
 • processed data (e.g. frequency spectra or object values) 

The following monitoring types are available: 

 Data monitoring 

Show object values via different diagram types 
(→ chapter Data monitoring (→ p. 180)) 

All objects or subobjects can be selected as a source and added to the 
diagram. 

 
Counter monitoring 

(only VSE) 

Display the current states of the configured counters  
(→ chapter Counter monitoring (→ p. 180)) 

All counters configured in the diagnostic electronics can be selected as a 
source and added to the diagram. 

 I/O monitoring 

Display the current states of the inputs and outputs 
(→ chapter I/O monitoring (→ p. 180)) 

All inputs and outputs of the device can be selected as a source and added to 
the diagram. Also a DC signal on the dynamic input functions in this case. 

 
Spectrum monitoring 

(only VSE) 

Display frequency spectra (FFT / H-FFT) 
(→ chapter Spectrum monitoring (→ p. 181)) 

Only dynamic inputs of the diagnostic electronics can be selected as a source 
and added to the diagram. Only one dynamic input per diagnostic electronic can 
be selected. 

 
Raw data monitoring 

(only VSE) 

Display raw data of a dynamic input (time signal) 
(→ chapter Raw data monitoring (→ p. 182)) 

Only dynamic inputs of the diagnostic electronics can be selected as a source 
and added to the diagram. Only one dynamic input per diagnostic electronic can 
be selected. 

 History monitoring 

Read and display the history memory 
(→ chapter History monitoring (→ p. 183)) 

All objects configured in the device can be selected as a source and added to 
the diagram. The prerequisite is that the object is activated in the history and 
that there are least 2 measurement values in the history memory. 
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>  

11.1.2 Data monitoring 
22534 

In the data monitoring section, you can view the current measurement values of the objects and 
subobjects. The object values and the alarm limits provide a clear overview of the current machine 
state. The underlying vibration information is stored in the parameter set (objects) of the diagnostic 
electronics and only the current measurement result for this monitoring is shown. 

Example: 

 

  

Switching functions: 

The following special switching functions are available: 

 change to the object level view 

 change to the subobject view 
 

>  

11.1.3 Counter monitoring 
22547 

In the counter monitoring section, you can view the current state of the counters configured in the 
diagnostic electronics. It also indicates the time stamp and, provided that a limit has been defined, the 
alarm state. 

Switching functions: 

No special switching functions available. 
 

>  

11.1.4 I/O monitoring 
22548 

In the I/O monitoring section, you can view the current state of the analogue inputs and outputs. 

Parameter Display 

Digital inputs and outputs current state (on / off) 

Analogue inputs calculated value corresponding to the set scaling 

Analogue outputs analogue measured value 
  

Switching functions: 

No special switching functions available. 
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Monitoring Monitoring types 

>  

11.1.5 Spectrum monitoring 
22549 

In the spectrum monitoring section, you can view the data based on the frequency analysis. You can 
choose between the standard FFT and the H-FFT spectrum. The spectral view allows creation of a 
detailed analysis based on the occurring frequencies. The software offers tools for frequency factor, 
harmonics and sideband analysis. 
  

  The monitoring of objects is inactive during spectrum monitoring. The alarm states keep their last 
values as long as the monitoring is active. 

  

Example: 

 

  

Switching functions: 

Folgende spezielle Switching functions vorhanden: 

1. Selection field 
Resolution: 
frequency resolution for calculating the spectrum 

24,414 Hz 
... 
0,191 Hz 

2. Selection field 
Frequency band, what frequency range is to be displayed 
850 values per spectrum 
(850 • resolution = frequency range) 

  

3. Selection field Type of analysis 
FFT 
H-FFT 

4. Selection field Type of filtering for H-FFT   
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5. Selection field Unit of the y axis for FFT analysis 
mm 
mm/s 
mg 

 

>  

11.1.6 Raw data monitoring 
22551 

The monitoring of the time signal allows you to view the raw data of the dynamic input. These are the 
unfiltered data obtained directly after the analogue-digital conversion.  
  

  The monitoring of objects is inactive during time signal monitoring. The alarm states keep their 
last values as long as the monitoring is active. 

  

Example: 

 

  

Switching functions: 

The following special switching functions are available: 

1. Selection field 
Sampling rate in 1,000 samples per 
second 

20 kS/s 
... 
100 kS/s 
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Monitoring Monitoring types 

>  

11.1.7 History monitoring 
22553 

The history reads and displays the internal memory of the diagnostic electronics. Only those objects 
with a measurement value in the history memory are shown. The history helps to visualise the 
development of measurements prior to a damage message (sudden or progressive rise). 

Example: 

 

  

Switching functions: 

The following special switching functions are available: 

 
Save history 
Memory location = project tree view > [Device_#] > [Data] > [History dd.mm.yyyy hh:mm:ss] 
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Monitoring Record and display measured data 

>  

11.2 Record and display measured data 

 

Switching functions (Monitoring) ..........................................................................................................185 
Record and save measured data .........................................................................................................187 
Rename measured data recordings .....................................................................................................188 
Export measured data ..........................................................................................................................189 
Import measured data ..........................................................................................................................189 
Evaluate measured data .......................................................................................................................190 

22519 

Prerequisite: 

 VES software is connected to the device via [ ] 

There are several methods to select a monitoring type: 

 Tool bar (→ p. 13)  

 

 Menu bar (→ p. 12)  

 Context menu (→ p. 16) via right-click on the device in the tree view  
(→ also chapter Context menu functions (→ p. 195)) 

► Select the monitoring type 

> The monitoring is displayed in the Detailed view (→ p. 15). 

> The program starts the data transfer. 
 



 

 

185 

ifm Software Manual octavis VES004 V1.20.11 2017-07-28 

Monitoring Record and display measured data 

>  

11.2.1 Switching functions (Monitoring) 
22521 

The following switching functions are available for almost all monitoring types. 
 

>  

Project data monitoring 
22889 

Symbol Description Prerequisite 

 
Start project data monitoring Monitoring stopped 

 
Stop project data monitoring Monitoring in progress 

 

>  

Tool bar above the data display: 
22522 

  

 

Change to the bar graph view 

The bar graph consists of a progress bar, an axis and the displayed limit values, where applicable. The axis can be 
scaled and formatted freely. Values with the same engineering unit can be displayed on the same axis. 

 

Change to the table view 

A table can consist of several rows. Each row contains the name of the value that is displayed, the actual value together 
with the time stamp and the current alarm state, where applicable. 

 

Change to the moving data display ((y-t-graph (continuous)) 

The y-t graph consists of a time axis (x-axis) and one or several y-axes. The axes have several properties that can be 
changed in the corresponding dialogue window (e.g. scaling, colour,...). Values with the same engineering unit can be 
displayed on the same axis. 

The time axis has a fixed time span. Older measurements will therefore be outside the window and will no longer be 
displayed. 

 

Change to the unlimited data display ((y-t-graph (unlimited data)) 

The y-t graph consists of a time axis (x-axis) and one or several y-axes. The axes have several properties that can be 
changed in the corresponding dialogue window (e.g. scaling, colour,...). Values with the same engineering unit can be 
displayed on the same axis. 

The starting point of the time axis is fixed as "0 point". As a result, the data is progressively condensed by newer 
measurement values, ensuring a joint display within the same diagram. 

 
Start data recording 

Starts the recording of the current monitoring 

 
Pause data recording 

Pauses the recording of the current monitoring 

 
Stop data recording 

Stops the recording of the current monitoring 

 
Starts data monitoring 

Restarts the current monitoring. The new measurement values are displayed in the selected graph again 

 
Stops data monitoring 

Stops the current monitoring measurement; new measurement values are no longer displayed 

 Shows history and counters 

 
Reload history 

Update of the history data without having to close and reopen the history window 

 Save history 

 

Switch full screen mode [F11] 

Changes to the full screen mode (or: [F11]) or change back to the normal screen mode 
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Monitoring Record and display measured data 

>  

Switching functions within the data display: 
22533 

  

 

Selection of the data sources 

 

Display of the properties 

 

Activate the zoom mode for the x- and y-axes 

The zoom mode activates the zoom for a selected axis. 

 

Activate the zoom mode for the x-axis 

The zoom mode activates the zoom for a selected axis. 

 

Activate the zoom mode for the y-axis 

The zoom mode activates the zoom for a selected axis. 

 
Add vertical coordinate axis on the left side 

 
Add vertical coordinate axis on the right side 

 
Delete selected coordinate axis 

  

 

To undo the zoom: 

► Right-click on the data display 

► In the context menu: Click [Reset Zoom] 
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Monitoring Record and display measured data 

>  

11.2.2 Record and save measured data 
23592 

► Select the requested monitoring type, e.g. raw data monitoring, in the tool bar. 

> New window [Monitoring] opens. 

> The program starts the data transfer. 

► If the data transfer does not start automatically: 

Start data monitoring in the [Monitoring] window via [ ] on the right. 

► If necessary, adapt the representation via the monitoring switching functions. 
→ chapter Switching functions (Monitoring) (→ p. 185)  

► Start data recording via [ ]. 

> With each recording cycle, "Samples recorded" is increased by 1. 

► Wait for the recording of the required signals. 

► Stop data recording via [ ]. 

► Confirm the query "Do you wish to save this data recording?" with [Yes]. 

> The stored monitoring data sets appear in the tree view under [Data].  

 
The name of the data set results from... 
 • monitoring type 
 • recording date 
 • recording time 

> The program saves each monitoring data set as an individual *.idat file. 
23570 

 

The program automatically stores the projects as well as the corresponding parameters and 
data in the following directory: 
C:\Users\Public\Documents\VES004  

  

► Stop data monitoring display via [ ]. 
If the data recording has not yet been stopped, it continues in the background. 
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Monitoring Record and display measured data 

>  

11.2.3 Rename measured data recordings 
23593 

> The names of the data recordings are indicated in the tree view of the project under [Data]. 

► If required: Change the name of the data recording: 

► Right-click on the name to be changed. 

► Click [Rename] in the context menu. 

 

► Change the name. 

► Accept the change with [ENTER]. 

  

 

Do not change the name of the *.idat file! 

Otherwise, the program will not be able any more to find or activate the data set. 
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>  

11.2.4 Export measured data 
22895 

The measured data recorded in the project are available as a list in the tree view under [Data]. 

► Right-click on the name of the measured data recording to be exported. 

► Click on [Export...] in the context menu. 

 

> Window [Save as...] is displayed. 

► If necessary, adapt the file names and the directory location. 
Permissible data types:  
*.idat (preset) 
*.xml 

*.xlsx  

► Export the recording as selected file type with [Save]. 
 

>  

11.2.5 Import measured data 
23594 

Import the measured data exported from a project into another project as follows: 

► In the tree view, right-click on [Data] or the name of the [Data group]. 

► Click on [Import...] in the context menu. 

 

> Window [Open] is displayed. 

► Select the directory location and the file. 
Permissible data types: 
*.idat (VES004 data) (preset) 

*.ohs (VES003 history) 

*.orc (VES003 data)  

► Import the measured data into the project with [Open]. 

> The program saves the data set under its original name. 
The name assigned during the export of the data set is not relevant. 

  

 

> If an exported *.idat file is reimported into the same project, the program recognises that 

the data set is identical. 
The export file name is not relevant. 

> The program will offer the following alternatives: 

 overwrite the existing data set 
the original data set name is not affected 

 import the data set to be imported in addition to the original data set 
the original data set name is not affected 
the copy of the data set is supplemented by the counting number "(1)" 
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>  

11.2.6 Evaluate measured data 

 

Example: Bearing damage ...................................................................................................................190 
Example: Unbalance ............................................................................................................................192 

22894 
 

>  

Example: Bearing damage 
23571 

Prerequisite: 
 • sensor (e.g. VSA001) defined as [Dynamischer Eingang] 
 • trigger defined for the rotational speed range to be examined 
 • object defined for bearing monitoring, including:   
 • subobjects configured according to the bearing data 
 • appropriate limit values configured 

A detailed view is provided by the spectrum: 

 
View: Measured data bearing damage (full screen) 

  

► Select X axis zooming by clicking on [X]. 

► Right-click on the graph legend (here: BearingUnit). 

► Activate the following settings in the context menu (if necessary): 
 • [Subobjekte] > [Alle] 
 • [Suchradius] 

► Use the left mouse button to open window that is to be as small as possible 
here: about 45  Hz around the first peak after the 0 Hz mark 
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> The extract of the measured data is displayed: 

 

> The view clearly shows an imminent damage at the outer race of the bearing. 
Inner race and rolling element are free from damage. 

  

For an even quicker overview, the bar display can be used: 

 

> The lower bar shows that the bearing is close to the warning alarm. 
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>  

Example: Unbalance 
23572 

Prerequisite: 
 • sensor (e.g. VSA001) defined as [Dynamischer Eingang] 
 • trigger defined for the rotational speed range to be examined 
 • object defined for bearing monitoring; including... 
 • subobjects configured according to the bearing data 
 • appropriate limit values configured 

The peak in the spectrum only indicates that there is a damage: 
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After zooming the X axis the following view is displayed: 

 
  

The bar graph shows that the unbalance is clearly in the warning alarm range: 
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In the raw data view, the sine wave of the unbalance can be clearly seen after zooming the X axis. 
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>  

11.3 Context menu functions 

 

Context menu data sources..................................................................................................................195 
Context menu diagram area .................................................................................................................195 
Context menu diagram axes ................................................................................................................196 
Context menu of the diagram data line ................................................................................................196 

22555 
 

>  

11.3.1 Context menu data sources 
22556 

  

Function Description 

Remove bar Removes the bar of the selected object from the diagram. 

Remove line Removes the line of the selected object from the diagram. 

Remove row Removes the row of the selected object from the diagram. 

Add to new axis Adds the selected object to the diagram. A new y-axis with the unit of the object is created. 

Add to existing axis Adds the selected object to the diagram. The object is assigned to an existing y-axis with the 
corresponding unit. 

Add to existing axis Adds the selected object to the table. 
 

>  

11.3.2 Context menu diagram area 
22557 

  

Function Description 

Add axis Adds a value axis (y-axis) to the current diagram. 

Display filter Filters the data to be displayed in the diagram. Especially the time signal monitoring does not allow 
representation of all measured values. The display data can represent a mean value of x measurement 
values or ignore x values. The value x depends on the CPU load. 

Print The currently displayed diagram can be directly printed. You can choose between original (full colour), 
printer-friendly (white background) and black & white. 

Properties Opens the Properties window. 

Go to Goes to the beginning or end of the measurement values in the diagram. 

Copy The currently displayed diagram can be copied directly to the clipboard. You can choose between 
original (full colour), printer-friendly (white background) and black & white. 

Add label Adds a label. 

Show legend Shows/hides the legend. 

Undo zoom Resets the zoom so that all measurement values are displayed again. 

Remove row Removes the row of the selected object from the diagram. 

Zoom mode The zoom mode activates the zoom for a selected axis. The zoom can only be activated for x, y or both 
axes. 
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>  

11.3.3 Context menu diagram axes 
22558 

  

Function Description 

Absolute scaling The scaling of an axis can be absolute (in the engineering unit of the object) or relative (in relation to the 
base line (teach value)). 

Delete axis Removes the selected axis from the diagram. 

Characteristics Opens the Properties window. 
 

>  

11.3.4 Context menu of the diagram data line 
22559 

  

Function Description 

Characteristics Opens the Properties window. 

Go to Goes to the beginning or end of the measurement values in the diagram. 

Harmonics After activation of the harmonics, a frequency can be selected in the spectrum that will be used as a 
base frequency for the harmonics display. The selected frequency is determined from the highest 
amplitude in the indicated peak finder radius. The peak finder radius can be set in the diagram 
properties. 

Remove line Removes the line of the selected object from the diagram. 

Measurement cursor Shows a measurement cursor to facilitate reading of the measured values. When moving the mouse 
pointer, the crosshair always moves along the selected line. The position of the crosshair is shown at 
the top of the diagram. 

Measurement lines Shows two measurement lines to facilitate reading of the measured values and distance measurement. 
Drag&drop the measurement lines at the top using the mouse. The positions of the measurement lines 
and their distance on the selected line are indicated at the top of the diagram. 

Peak finder Shows a measurement line to facilitate reading of the measured values. Drag&drop the measurement 
line at the top using the mouse. The position of the measurement line is determined by the highest 
value within the indicated peak finder radius. The peak finder radius can be set in the diagram 
properties. 

Sidebands After activation of the sidebands, 2 frequencies must be determined. First the base frequency and then 
(to the right or left of the base frequency) one of the first sidebands. The respective position is 
determined by the highest value within the indicated peak finder radius. The peak finder radius can be 
set in the diagram properties. 

Subobjects Shows markers for the subobjects in the frequency spectrum. The position corresponds to the damage 
frequency determined on the basis of the current rotational speed. 

Frequency window Shows the frequency window of the subobjects when hovering over it with the mouse. 

Waterfall Several spectra are arranged staggered, one behind the other (three-dimensional diagram). 
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11.4 Characteristics 
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Axis properties ......................................................................................................................................197 
Data line properties ..............................................................................................................................198 

22560 
 

>  

11.4.1 Diagram area properties 
22561 

  

Property Description 

Display range [s] Determines the display range in the time axis (x-axis) in seconds. 

Display filter Filters the data to be displayed in the diagram. Especially the time signal monitoring does not allow 
representation of all measured values. The display data can represent a mean value of x measurement 
values or ignore x values. The value x depends on the CPU load. 

Cache size [s] Describes the buffer for the visualisation in seconds. 

Peak finder radius in 
[Hz] or [CPM] 

The width of the search zone (radius) in which the highest value is searched. The peak finder radius is 
used for the harmonics, the sidebands and the peak finder. 

y-axis amplitude Indicates whether the measurement values in the spectrum are shown as peak or RMS.  
The conversion factor for a single frequency is root(2), peak = RMS * root(2). 

 

>  

11.4.2 Axis properties 
22562 

  

Property Description 

Absolute scaling The scaling of an axis can be absolute (in the engineering unit of the object) or relative (in relation to 
the base line (teach value)). 

Auto scaling The value axis (y-axis) scales automatically based on the measurement values. 

Date-time format Determines how the date and time are displayed in the time axis (x-axis). 

Colour The colour of the axis can be modified. 

Show grid Auxiliary lines are shown as a grid in the diagram. 

Show ticks The division of the axis is shown or hidden. 

Label A label can be created for the axis. 

Upper scale End of the scale (if not scaled automatically). 

Lower scale Beginning of the scale (if not scaled automatically). 

x-axis scaling For analysis, the frequency axis (x-axis) can be converted during monitoring. In addition to the normal 
frequency unit, the x-axis can also be shown relative to a rotational speed. The speed can be taken 
from an analogue input or entered manually.  

This conversion makes it easy to detect whether peaks in the spectrum are multiples of a certain 
speed. Displaying the spectrum in relation to the rotational speed is also called frequency factor 
analysis. 
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>  

11.4.3 Data line properties 
22563 

  

Property Description 

Colour The colour of the data line can be modified. 

Notifications The measured values in spectrum monitoring can be averaged for representation purposes to avoid 
fluctuations. 

Name The name of the selected object that is shown in the legend. 

Symbol Symbols can be displayed for the data points. 

Symbol size The size of the symbols for the data points can be changed. 

Type The line type can be changed (straight, dotted, thick, thin,...). 
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12 Glossary of Terms 

A 

Address 

This is the "name" of the bus participant. All participants need a unique address so that the signals can 
be exchanged without problem. 
 

>  

Architecture 

Specific configuration of hardware and/or software elements in a system. 
 

>  

B 

Bus 

Serial data transmission of several participants on the same cable. 
 

>  

C 

CSV file 

CSV = Comma Separated Values (also: Character Separated Values) 
A CSV file is a text file for storing or exchanging simply structured data. 
The file extension is .csv. 

Example: Source table with numerical values: 

value 1.0 value 1.1 value 1.2 value 1.3 

value 2.0 value 2.1 value 2.2 value 2.3 

value 3.0 value 3.1 value 3.2 value 3.3 

This results in the following CSV file: 

value 1.0;value 1.1;value 1.2;value 1.3 
value 2.0;value 2.1;value 2.2;value 2.3 
value 3.0;value 3.1;value 3.2;value 3.3 
. 
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>  

D 

Data type 

Depending on the data type, values of different sizes can be stored. 

Data type min. value max. value size in the memory 

BOOL FALSE TRUE 8 bits = 1 byte 

BYTE 0 255 8 bits = 1 byte 

WORD 0 65 535 16 bits = 2 bytes 

DWORD 0 4 294 967 295 32 bits = 4 bytes 

SINT -128 127 8 bits = 1 byte 

USINT 0 255 8 bits = 1 byte 

INT -32 768 32 767 16 bits = 2 bytes 

UINT 0 65 535 16 bits = 2 bytes 

DINT -2 147 483 648 2 147 483 647 32 bits = 4 bytes 

UDINT 0 4 294 967 295 32 bits = 4 bytes 

REAL -3.402823466 • 1038 3.402823466 • 1038 32 bits = 4 bytes 

ULINT 0 18 446 744 073 709 551 615 64 Bit = 8 Bytes 

STRING     number of char. + 1 
 

>  

DC 

Direct Current 
 

>  

DHCP 

DHCP = Dynamic Host Configuration Protocol = protocol for the dynamic configuration by the→host. 
DHCP is a protocol that provides dynamic configuration of IP addresses and associated information. 
The protocol supports use of IP addresses which are only available in limited number by a centralised 
management of the address assignment. 
The participant logs on to a server with this service when it is switched on in a network for the first 
time. The server assigns a local free →IP address to the participant. 
 

>  

E 

EDS 

EDS = Electronic Data Sheet 
An EDS is a device description fiile in ASCII format, comparable to the GSD or the GSDML file of 
Profibus or Profinet. 
>  

Ethernet 

Ethernet is a widely used, manufacturer-independent technology which enables data transmission in 
the network at a speed of 10...10 000 million bits per second (Mbps). Ethernet belongs to the family of 
so-called "optimum data transmission" on a non exclusive transmission medium. The concept was 
developed in 1972 and specified as IEEE 802.3 in 1985.  
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>  

F 

Fieldbus 

A →bus for industrial applications: mechanically extremely robust and excellent data protection. 
 

>  

Firmware 

System software, basic program in the device, virtually the →runtime system. 
The firmware establishes the connection between the hardware of the device and the application 
program. The firmware is provided by the manufacturer of the controller as a part of the system and 
cannot be changed by the user. 
 

>  

G 

Gateway 

Gateway = access, coupler. 
Gateways enable connection of completely different systems. Gateways are used when two 
incompatible network types are to be connected by converting the protocol of one system to the 
protocol of the other system. 

Example: connection between AS-i and higher-level fieldbus systems such as Ethernet DP, 

DeviceNet, Interbus-S or other interfaces, e.g. RS-485. The device includes an AS-i master which is 

directly coupled to the host interface (e.g. Ethernet DP slave). 
 

>  

GSD 

Generic Station Description 
Describes the interface to the device to be connected to the fieldbus. 

You can find the current version of the GSD file on the ifm homepage:  
→ ifm weltweit • ifm worldwide • ifm à l’échelle internationale (→ p. 213)  
e.g. for AC1375: 

 GSD file for SmartLink AC1375 

 download the file ifm...07E5.gsd (... = version) 
 

>  

GSDML 

GSDML = Generic Station Description Markup Language. 
Description language which can describe the characteristics of a device family across several levels. 

In this XML scheme, as much as possible of the semantics of the GSD was adopted. 
 

>  

I 

Instructions 

Superordinate word for one of the following terms: 
installation instructions, data sheet, user information, operating instructions, device manual, installation 
information, online help, system manual, programming manual, etc. 
 

>  

IP address 

IP = Internet Protocol. 
The IP address is a number which is necessary to clearly identify an internet participant. For the sake 
of clarity the number is written in 4 decimal values, e.g. 127.215.205.156. 
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>  

L 

LED 

LED = Light Emitting Diode. 
Light emitting diode, also called luminescent diode, an electronic element of high coloured luminosity 
at small volume with negligible power loss. 
 

>  

Link 

A link is a cross-reference to another part in the document or to an external document. 
 

>  

M 

MAC-ID 

MAC = Manufacturer‘s Address Code  
= manufacturer's serial number. 
→ID = Identifier  
Every network card has a MAC address, a clearly defined worldwide unique numerical code, more or 
less a kind of serial number. Such a MAC address is a sequence of 6 hexadecimal numbers, e.g. 
"00-0C-6E-D0-02-3F".  
 

>  

O 

OPC 

OPC = OLE for Process Control 
Standardised software interface for manufacturer-independent communication in automation 
technology 
OPC client (e.g. device for parameter setting or programming) automatically logs on to OPC server 
(e.g. automation device) when connected and communicates with it. 
 

>  

P 

Pictogram 

Pictograms are figurative symbols which convey information by a simplified graphic representation. 
(→ chapter What do the symbols and formats mean? (→ p. 7))  
 

>  

Profinet 

PROFINET (Process Field Network) is the open Industrial Ethernet Standard of Profibus & Profinet 
International (PI) for automation. Profinet uses TCP/IP and IT standards, is real-time Ethernet 
compatible and enables the integration of fieldbus systems. 

The Profinet concept has a modular design, so that the user can choose the functionality himself. This 
is basically different as regards the type of data exchange, to meet the requirements regarding the 
speed. 
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For Profinet, there are the two perspectives Profinet-CBA and Profinet-IO: 

 Profinet-CBA (Component Based Automation) is intended for the component-based 
communication via TCP/IP and the real-time communication for real-time requirements in modular 
plant construction. Both ways of communication can be used in parallel.  

 Profinet-IO has been created for real-time (RT) and synchronous communication IRT (IRT = 
isochronous real-time) with the decentralised periphery. The designations RT and IRT only 
describe the real-time characteristics in the communication within Profinet-IO. 

  

 

→ www.profibus.com (umbrella organisation) 

 
>  

R 

RTC 

RTC = Real Time Clock  
Provides (batter-backed) the current date and time. Frequent use for the storage of error message 
protocols. 
 

>  

S 

Symbols 

Pictograms are figurative symbols which convey information by a simplified graphic representation. 
(→ chapter What do the symbols and formats mean? (→ p. 7))  
 

 

>  

T 

TCP 

The Transmission Control Protocol is part of the TCP/IP protocol family. Each TCP/IP data connection 
has a transmitter and a receiver. This principle is a connection-oriented data transmission. In the 
TCP/IP protocol family the TCP as the connection-oriented protocol assumes the task of data 
protection, data flow control and takes measures in the event of data loss. (compare: →UDP) 
 

>  

U 

UDP 

UDP (User Datagram Protocol) is a minimal connectionless network protocol which belongs to the 
transport layer of the internet protocol family. The task of UDP is to ensure that data which is 
transmitted via the internet is passed to the right application. 
At present network variables based on →CAN and UDP are implemented. The values of the variables 
are automatically exchanged on the basis of broadcast messages. In UDP they are implemented as 
broadcast messages, in CAN as →PDOs. 
According to the protocol, these services are unconfirmed data transmission: it is not checked whether 
the receiver receives the message. Exchange of network variables corresponds to a "1 to 
n connection" (1 transmitter to n receivers). 
 

 

http://www.profibus.com/
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